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Before You Begin

Intended Audience
The NCDWare User’s Guide is for users of thin client devices

(also called terminals) who have little or no experience using

NCD terminals or NCDware operating system software.

The guide provides an overview of NCD terminal operations

and what you can accomplish with NCDware.

In addition, the NCDWare User’s Guide suggests ways to get

the best performance out of your terminal when running

either of two graphical user interfaces (GUIs) that help

simplify X Window System (X) operations.

Assumptions
This guide assumes that your system administrator has

already:

❏ Assembled your terminal and attached it to the network

❏ Installed NCDware on a network host

❏ Set up an account for you on your network’s primary

host computer

❏ Prepared the startup files you need for your terminal

❏ Installed the terminal on the network

❏ Configured the terminal

Before you start reading the NCDware User’s Guide, ask your

system administrator for the following information:

❏ The name of the primary host and operating system you

are using

❏ The name of the graphical user interface or window

manager you are using

❏ Your login and password
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Note If you do not have a system administrator, refer to

the system administration guides and manuals

cited in “Additional Documents” at the end of this

section.

Contents of this Manual
This document is organized as follows:

❏ Chapter 1, NCD Terminals and NCDware—Introduces

NCD terminals and the NCDware operating system.

❏ Chapter 2, Quick Tour of an NCD Terminal—Illustrates

software features and defines some concepts and terms.

❏ Chapter 3, NCD Terminal Interface Basics—Explains

how to enter and manipulate data and manipulate

windows.

❏ Chapter 4, Starting and Ending NCDware Sessions—

Explains how to log in and out of your terminal.

❏ Chapter 5, Using the NCDware Console—Explains how

to use the Console, which provides access to many

terminal utilities.

❏ Chapter 6, Customizing Your Desktop Environment—

Explains how to use the Console’s Change User

Preferences window to change your desktop working

environment.

❏ Chapter 7, Using the NCD Terminal Emulator—Explains

how to use the NCD Terminal Emulator, which provides

an alternative way to log in to a host.

❏ Chapter 8, Using Windows Access—Explains how to use

the Windows Access utility to connect to a Windows NT

server and run Microsoft Windows applications.

❏ Chapter 9, Using the Local NCD Window Manager—

Explains how to manipulate windows using a window

manager.

❏ Chapter 10, Using the NCD Mosaic Browser—Explains

how to use the browser to view sites on the World Wide

Web (WWW) or a local intranet.
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❏ Chapter 11, Using NCD Utilities—Explains how to run

Java applets, access files on PC (PCMCIA) cards and

floppy disks, and play videos.

❏ Chapter 12, Using XRemote—Explains how to use

XRemote software over a serial connection or on the

LAN.

❏ Chapter 13, Using OpenWindows on NCD Terminals—

Explains how to use the OpenWindows GUI on NCD

terminals.

❏ Appendix A—Describes the X Window System

architecture, X software components, and the

characteristics that make the X environment unique.

❏ Appendix B—Explains how to use a touch screen

monitor and a light pen.

❏ Appendix C—Explains how to use the ncdfloppy
command to access a floppy drive.

This manual includes a glossary and an index.

Text Conventions
This document uses the following conventions:

Ctrl-Z Indicates that you should press two keys

at the same time; in this case, the Ctrl key

and Z.

<CR> Indicates that you should press the

Return key.

⇒ Indicates movement through menus. For

example, the phrase “In the Console,

select Statistics ⇒ Show Version” means

that you display the Statistics menu and

select the Show Version menu item.

bold Indicates a directory, file, or remote

configuration parameter, such as /tftpboot
or boot-automatically.
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Additional Documents
For documents describing NCD’s WinCenter software, see

the WinCenter manuals accompanying the WinCenter

software. (See the NCDware Publications Roadmap for

references to configuring NCDware for use with WinCenter.)

The following NCD manuals provide additional information

about NCD terminals:

❏ NCD terminal installation booklets—explain how to

unpack and set up NCD terminals and connect them to

the network. Each document is designed for a specific

NCD terminal or series of terminals.

❏ NCD memory installation booklets—explains how to

install memory in NCD terminals and run the

recommended memory test.

The following manuals describe NCDware. These manuals

are included with the NCDware CD-ROM.

❏ NCDware CD Insert—explains how to install NCDware

on UNIX and WinCenter hosts.

❏ Remote Configuration Parameter Quick Reference—

summarizes the remote configuration parameters in a

condensed format.

bold italic Indicates a utility or a variable, such as

Xncdxxx where xxx indicates the variable

portion.

italic Indicates emphasis or the name of a

publication, such as NCDware User’s
Guide.

courier Indicates information displayed on the

screen or text in a file.

bold courier Indicates information you should type.
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❏ NCDware System Administrator’s Guide for UNIX
Systems—explains how to customize terminals to support

the users at your site and solve problems that may occur.

❏ NCDware Publications Roadmap—provides a high-level

index of major topics in NCD manuals, pointing you to

the documents or chapters in which the topics are

addressed.

❏ Using the 3270 Terminal Emulator—explains how to use

and customize NCD’s local 3270 terminal emulator.

❏ Release Notes—describes new NCDware features in this

release, known problems, and problems that have been

fixed in this release.

The NCDware Reference Manual provides details about many

aspects of NCDware and alternatives to some of the

procedures in the System Administrator’s Guide. It also

includes topics not covered in the System Administrator’s
Guide. The NCDware Reference Manual is available online

from the NCD Web site (www.ncd.com) or from the NCD FTP

site. Printed copies of this manual can be ordered from NCD.

Using a PC Card in Your NCD Thin Client Device explains how

to get terminals up and running quickly using NCDware on

PC cards. This manual is included with the Quick Start PC

card.

Comments on Manuals
You can send comments, suggestions, or questions about

NCD manuals to the NCD Technical Publications Department

by e-mail. Write to techpubs@ncd.com.
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1 NCD Terminals and NCDware

The NCD terminal is based on a network computing model

that supports access to multiple applications running

anywhere on the network. Using an NCD terminal, you can

run applications residing on host computers and display the

output of those applications in windows on your terminal.

This chapter describes the NCD terminal and introduces

NCDware, the terminal’s operating system.

Terminals—Access to All Platforms
NCD terminal design emphasizes information access across

platforms, regardless of architecture.

Terminals put processing power, applications, and

information wherever they are needed on the network and

give each user the power of any or all of the processors on the

network (Figure 1-1).

Using an NCD terminal and NCDware, you can run

applications written for the X Window System, legacy

applications designed for ASCII terminals, applications

written for IBM 3270-series terminals, and Windows NT

applications.

NCD’s WinCenter software (sold separately from NCDware),

also allows you to run Windows applications on your

terminal. In addition, WinCenter allows you to run Java,

Video, and UNIX applications on the Windows NT desktop.

Besides running applications from many different types of

host systems, terminal users can use networked devices such

as printers and plotters. In addition, devices attached directly

to a terminal (such as a printer or a floppy drive), can be

accessed by users on other terminals.
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Terminals—Access to All Platforms
NCD terminals include:

❏ A monitor—receives the output from most applications

and makes it visible to the user. Some customers choose

to provide their own monitors.

❏ The base—contains the processors that run NCDware.

❏ A keyboard and mouse—the input devices for your

terminal. Most applications take their input from the

keyboard and mouse.

Figure 1-1  Network Computing Model
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NCDware
NCDware
NCDware consists of the operating system that runs on your

NCD terminal (the basic X server plus loadable modules) and

numerous host-based utilities and support files, such as fonts.

This section describes the NCD X server, client software, and

networking software.

The X Server
NCD X servers consist of a basic server program that handles

input and output and network communications, and a

number of smaller modules. Normally, the modules are not

loaded by the terminal until you start a program requiring

that module. For example, the DPS (Display PostScript)

module is not loaded unless you start an application that uses

Display PostScript.

NCD User Services
NCD User Services is a set of commands and configuration

and management tools accessed through the Console (Figure

1-2). The Console appears on the terminal screen when you

press the Setup key.

Some NCD keyboards do not have a Setup key. Table 5-1 on

page 5-2 lists the equivalent key combinations for displaying

the Console.

Other methods of accessing NCD User Services are described

in the NCDware System Administrator’s Guide. Your system

administrator may set up some of these alternatives for you.

Figure 1-2  The Console
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NCDware
The Console provides access to a variety of NCD utilities that

allow you and your system administrator to manage your X

session, network access, and terminal environment, including:

❏ Customizing your environment

❏ Logging in and logging out

❏ Rebooting the terminal

❏ Connecting to hosts and running applications

❏ Running NCD utility programs, including the local

window managers

❏ Examining statistics that describe the performance of

your terminal and the network

NCD User Services includes local applications that run on the

NCD terminal.

Local Window Managers and Companion Software
The NCD window managers provide the window frames used

to change the size and location of windows. The local window

managers look and function like the OSF/Motif window

manager, but, unlike the Motif window manager, they run on

the terminal’s processor instead of on a host computer on the

network. (The NCD Window Manager can also run as a host-

based client.)

Note Using the local Motif Window Manager

requires a license.

A major benefit of a local window manager is that it responds

more quickly than host-based window managers to window

operation requests. In addition, it allows you to use the

terminal in non-X environments.

Keymap Editor
The NCD Keymap Editor provides an easy-to-use interface for

reassigning keyboard keys for the local terminal emulators.

Font Utilities
NCD terminals are configured to download fonts from a host

by default. NCDware includes utilities for converting fonts to

formats that NCD terminals can use.
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Network Connectivity
See “Font Options” on page 6-7 for information about adding

fonts to and deleting fonts from your terminal’s font path.

The NCD Font Server centralizes font management. It runs on

a network host and provides scalable fonts so that the bitmaps

for every font size do not need to be stored on the host.

System Administration Utilities
NCDware includes host-based utilities that simplify network

administration through centralized management. These

facilities are normally used by the system administrator.

System administration software is described in the NCDware
System Administrator’s Guide.

Network Connectivity
NCD terminals provide multi-vendor connectivity via their

Ethernet, Token-Ring, and serial communications interfaces.

LAN Connection
Local area network (LAN) connections for terminals vary,

depending on the model and the interface board installed in

the terminal.

HMX Terminals
For the HMX family of terminals, the network connections

depend on the type of interface board installed in the terminal:

❏ If you have an ESP (Ethernet/Serial/PC) board, your

HMX terminal has an Ethernet port, a parallel port, and

up to three serial ports.

❏ If you have a TRP (Token-Ring/PC) board, your HMX

terminal has a serial port, a parallel port, a shielded

Token-Ring connector, and an unshielded Token-Ring

connector.

❏ If you have a PEP (Parallel/Ethernet/PC) board, your

HMX terminal has a serial port, two parallel ports, a

twisted-pair Ethernet connector, and a thin Ethernet

connector.
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Network Connectivity
❏ If you have a NIM (Network Interface Module) board, the

terminal has a serial port, a parallel port, and either a thin

or twisted-pair Ethernet connector.

Communication Methods
NCD terminals can communicate over a LAN or serial

connection in various ways:

❏ Over Ethernet using TCP/IP or DECnet/NCDnet

protocols. TCP/IP and DECnet can be used concurrently.

❏ Over Ethernet using the LAT protocol, typically

supported by Digital hosts.

❏ Over Token-Ring using TCP/IP.

❏ Over a serial connection (or a LAN) using NCD’s

XRemote software.

Serial Connection
NCD terminals can have up to three serial ports with RS-232 C

connectors. The ports are used for:

❏ Local or remote serial connections.

❏ XRemote, the NCD software for running X over a serial

connection. For information about XRemote, see Chapter

12, Using XRemote.

❏ A printer or any serial input/output device

Parallel Connection
HMX, Explora, Explora Pro, Explora 400/450 series, and

Explora 700 terminals and interface boards include an

industry-standard Centronics-compatible parallel port. The

parallel port supports output devices only. You can attach a

printer or floppy disk drive to the parallel port.
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2 Quick Tour of an NCD Terminal

This chapter is a short introduction to NCDware.

Tip
A network might also include PCs. To
access PCs from NCD terminals, the
PCs must be running NCD’s
WinCenter software or Citrix
WinFrame or MetaFrame software.

In the example provided in this chapter (writing a memo), the

terminal is on a network with computers that provide data

storage and run user software, such as word processors.

Note Your software setup may be different from

that used in the example, so it may function

somewhat differently.

If you have questions about how your particular system

differs from the examples included in this guide, refer to these

sources for more information:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

For further information about each of the functions

introduced in this chapter, see “For More Information” at the

end of each section.
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Power On, Booting, and Logging In
Power On, Booting, and Logging In
Tip
Most users keep their terminals
powered on. They log out when they
leave their terminals for an extended
period and log back in to start another
session. To save electricity, users
who do not have ENERGY STAR-
compliant monitors can turn their
monitor off when not logged in.

When you power on your NCD terminal to start a session, it

automatically starts the boot process.

The boot process tests the terminal’s memory and then loads

the system software. You can tell that the terminal is booting

by the appearance of test results and other information that

scrolls by on the display. It takes approximately 20 seconds to

boot.

When the boot process is complete, the Console and Login

Chooser appear on the display (Figure 2-1).

About the Console
The Console provides a way of:

❏ Connecting to host computers and applications

❏ Customizing your working environment

Figure 2-1  Screen Display Immediately After Booting
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Power On, Booting, and Logging In
Logging In
By default, the Login Chooser displays after booting;

however, system administrators can choose to set up an

entirely different login method. These different login methods

are described in later chapters.

The Login Chooser lets you select a login host and start a

session on that host. You select a login host by:

❏ Moving the mouse pointer to a hostname in the Default
Hosts  list

❏ Clicking the left mouse button to highlight the hostname

❏ Clicking the OK button to confirm the selection

If your login host is not listed in the Login Chooser, contact

your system administrator. You may need to enter the name

of a host in the Host:  field.

Once you select a login host, the Console and Login Chooser

close and a login banner appears (Figure 2-3).

The login banner contains prompts that show you where to

enter your login name and password.

To log in, enter your login name and password in the login

banner.

TCP - xdm host
TCP - xdm host
NCDnet - DECnet host

shark
orca

OTTER

octopus

Figure 2-2  The Login Chooser
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Power On, Booting, and Logging In
For More Information
For more information on powering on, booting, and logging

in, see the User’s Guide sections listed in Table 2-1.

Figure 2-3  A Login Banner

Welcome to Octopus

Login:

Password:

Table 2-1 Powering On, Booting, and Logging In

For Information On Look In

Booting “Booting” on page 4-2

Logging in “Logging In” on page 4-2

Logging into a remote host Chapter 12, Using XRemote

“Using the NCD Terminal Emulator” on page 7-1

X software and hardware Appendix A, The X Window System and NCD Terminals

Console Chapter 5, Using the NCDware Console

Logging in to a Microsoft

Windows NT host

Chapter 8, Using Windows Access
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Starting Applications
Starting Applications
After you enter your login name and password, the

applications configured to start automatically are displayed.

Figure 2-4 shows a display on which a clock and a terminal

emulator started automatically. These programs are called

clients. A client is a software application that is written

especially to run with the X Window System. Unless there’s an

important reason to distinguish between an application

written for X and one that is not, this guide uses the term

application instead of client.

A terminal emulator is an application that provides a

connection to a host for using programs written for ASCII

terminals or other legacy applications. One of the most

frequently used terminal emulators is xterm, which runs from

a host and mimics the behavior of a VT102 terminal.

Figure 2-4  A Display After Login
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Starting Applications
Another application, called a window manager, also started

automatically. The window manager controls aspects of the

appearance and function of the windows in which the other

applications appear. For example, the window manager

provides the outside borders of a window. Refer to “Using

Windows” on page 2-8 for details on how to use a window

manager.

Starting Applications from Root Menus
One way of starting applications is to display a root menu. An

example menu is shown in Figure 2-5.

A root menu is a menu that appears when you place the

mouse pointer on the root window (the background upon

which the other windows appear), and click a mouse button.

Often, root menus are set up by the system administrator to

list the most frequently used applications.

Root menus may be cascading; for example, when you click the

Applications  item in the root menu, a submenu appears

(Figure 2-6).

Figure 2-5  A Root Menu

xterm ->
Applications ->
Utilities ->
Games ->
Log Off ->

-Apps-
Calculator
Clock
Text Editor
FrameMaker

Figure 2-6  A Submenu

xterm
Applications ->
Utilities ->
Games ->
Log Off ->
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Starting Applications
When you select an application from the submenu, the menu

close, and the application opens in its own window.

For More Information
For more information on connecting to hosts and starting

applications, refer to the sections in this manual listed in

Table 2-2.

Table 2-2 Starting Applications

For Information On Look In

X applications Appendix A, The X Window System and NCD Terminals

Starting applications

automatically

“Startup File” on page 4-5

Terminal emulators Chapter 7, Using the NCD Terminal Emulator

Starting applications manually “Starting Applications” on page 9-4

Root window and root menu “Starting Applications” on page 9-4

Microsoft Windows applications Chapter 8, Using Windows Access
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Using Windows
Using Windows
As an example of how to manipulate windows, assume you

are copying some information from an old memo into the

report you are writing. The report is in a file you created using

the FrameMaker application (Figure 2-7).

Tip
The active window is the window that
accepts keyboard and mouse input.

To read the old memo, you must make one of the terminal

emulator windows the active window.

Making a Window Active
You make a window active by placing the mouse pointer on

the window and clicking the left mouse button.

The frame of the active window is different from the other

windows. In the example shown in Figure 2-7, the frame on

the active terminal emulator window is darker than the frame

around the other windows.

You use the terminal emulator just as you would a terminal

connected to the host. In this introduction, we assume the host

Active window

Figure 2-7  Starting an Application
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Using Windows
is running the UNIX operating system, so you can use the

UNIX vi editor to display the memo.

Next, you open the FrameMaker file that contains your report.

Resizing a Window
The part of the report displayed in the FrameMaker window

is too small for your purpose, so you use the window frame to

make the window larger. First you click with the left mouse

button in the FrameMaker window to make it the active

window. Then you place the pointer on the resize handle in

the corner of the window frame. You drag the mouse while

pressing the left mouse button (Figure 2-8).

Figure 2-8  Enlarging a Window

Resize handle

Report accessed through
desktop publishing application

Old memo accessed
through terminal emulator

645 x 852

Window size indicator
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Using Windows
As you drag the mouse, an outline of the window appears and

changes size in proportion to the mouse’s movement. A small

box in the center of the display indicates the size of the

outlined window in a unit of measurement set by the

application (typically pixels or rows by columns).

When the window outline is the size you want, release the

mouse button. The window immediately changes to the size of

the outline and more of the report shows in the window.

You then decide you want to compare the old memo against

another one. You need another terminal emulator to look at

the second memo, so you display the root menu again and

select xterm . This starts another terminal emulator (Figure

2-9).

Figure 2-9  Adding Another Terminal Emulator
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Using Windows
You use the vi editor again to view the file containing the

second memo. The second terminal emulator window

overlaps the window containing the first memo, so you need

to move the windows to compare the two.

Moving a Window
To move a window, place the pointer on the title bar running

across the top of the window frame, press the left mouse

button, and drag the mouse. An outline of the window

appears, moving in proportion to the movement of the mouse

(Figure 2-10).

Figure 2-10  Moving a Window

(122, 547)

Memo accessed
through second
terminal emulator

Window location
indicator

Window outline
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Using Windows
A small box in the center of the display indicates the location

of the upper-left corner of the outline.

When the outline is where you want the window, release the

mouse button. The window immediately moves to the spot

where the outline appeared.

After studying the windows, you decide you don’t need the

information in the first memo after all, so you exit the vi editor

and close the terminal emulator by double clicking the

Window menu button in the upper-left corner of the window

frame (Figure 2-11). The window closes.

Cut and Paste Between Windows
Next, you want to copy a portion of the memo and paste it into

the report. To do so, you:

1. Press and drag the left mouse button to highlight some

text in the memo.

2. Click in the window containing the report to make it the

active window.

3. Place the cursor where you want the text to appear.

4. Click the middle mouse button to place the highlighted

text into the report at the position of the pointer.

Figure 2-11  Using the Window Menu Button

Double click
to close
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Locking the Screen
For More Information
For more information on using window managers, refer to the

sections in this manual listed in Table 2-3.

Locking the Screen
Tip
On keyboards without a Setup key,
pressing a combination of keys
displays the Console. See Table 5-1
on page 5-2

After saving and printing the report, you intend to leave your

terminal for a while. You don’t want to leave your terminal

available for other users, yet you don’t want to have to log in

all over again when you return.

To secure the terminal, press the Setup key to display the

Console (if it’s not already on the screen) and select Lock
Screen from the Utilities menu (Figure 2-12).

Table 2-3 Using NCDware

For Information On Look In

NCD Window Manager Chapter 9, Using the Local NCD Window Manager

Active window “Focus Policy—Directing Input to a Window” on

page 3-6

Changing window size “Changing Window Size” on page 9-13

Window manager resize handles “NCD Window Manager Windows” on page 9-6

Moving windows “Moving Windows” on page 9-12

Figure 2-12  The Console’s Utilities Menu
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Logging Out
The Lock Screen utility blanks the screen except for a popup

window that prompts you to enter a password (Figure 2-13).

As you type the password, asterisks appear instead of the

characters you type. After you type the password, the box

reappears prompting for the password again.

Until you retype the same password in the dialog box, the

terminal display is locked and accepts no input.

For more information, see “Locking the Screen” on page 4-5.

Logging Out
Before logging out, quit all applications to prevent losing data

or leaving incomplete processes running on the host:

Tip
On keyboards without a Setup key,
pressing a combination of keys
displays the Console. See Table 5-1
on page 5-2.

1. Press the Setup key to display the Console if it’s not

already on the screen.

2. Select the Login menu and click the Logout  item. A

popup window appears asking you to confirm that you

want to log out.

3. Click Yes. The popup window closes, as do any

applications that are still running, and in a moment the

Console and Login Chooser redisplay so that you can

begin another session when ready.

For more information, see “Logging Out” on page 4-7.

Figure 2-13  The Lock Screen Utility
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3 NCD Terminal Interface Basics

This chapter describes the following input devices and

user interface operations familiar to most terminal users:

❏ The mouse pointer

❏ The keyboard

❏ Window management tools

❏ Motif-style graphical tools

If you want to know more about your system’s input

devices and user interface, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Using the Pointer
Pointer movement corresponds to movement of the

mouse, and indicates where you direct your input.

The appearance of the pointer varies with the type of

window manager you are using and the location of the

pointer on the screen. For example, when using the NCD

Window Manager to perform certain operations, the

pointer has an arrow shape. However, when you place the

pointer on the root window, it has the shape of an X.

For more information about the different kinds of

pointers, see “NCD Window Manager Pointers” on page

9-9 and “Components of the OpenWindows GUI” on page

13-3.
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Using the Pointer

NCD
Controlling Pointer Motion
The Change User Preferences utility (accessed from the

Console’s Setup menu) includes a setting for adjusting the

mouse pointer’s speed relative to the movement of the

mouse. This is especially useful for moving the pointer

over a large area of the screen. For more information about

changing mouse tracking speed, see “Pointing Device

Options” on page 6-12.

Mouse-Button Mapping
The standard mapping of a three-button mouse, with the

cord pointing away from you, is:

❏ Left button (also called physical button 1) as logical

button 1

❏ Middle button (also called physical button 2) as

logical button 2

❏ Right button (also called physical button 3) as logical

button 3

See “Pointing Device Options” on
page 6-12 for more information about
changing mouse-button mapping.

The standard mapping is preferred by right-handed

people.

All references to mouse buttons in this document assume

that the default (right-handed, three-button) mouse

mapping is in effect.

Left-handed mapping is the reverse of the default: the left

button is logical button 3, the middle button is logical

button 2, and the right button is logical button 1.
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Using the Keyboard
Using the Keyboard
The keyboard is used to provide instructions and data to

applications.

Keyboard Setup
NCD offers six types (called groups) of keyboards:

❏ 97-key UNIX-style—N-97/N-Kana keyboards in

English and Japanese Kana

❏ 101-key IBM PS/2 style—N-101/N-102-key

keyboards in English, European, and Japanese Kana

languages; Windows 95 keyboards

❏ 107-key Sun Type 4 compatible style—N-107

keyboards in English

❏ 108-key DEC compatible (VT220) style—

N-108/N-108LK keyboards in English and European

languages

❏ 122-key 3270 compatible style—N-122 keyboards in

English

❏ 123-key Sun Type 5 compatible style—N-123

keyboards in English

Within each keyboard group, there may be many different

models; for example, keyboards for languages other than

US English. When you boot your terminal, it automatically

recognizes the group to which your keyboard belongs but

does not automatically recognize the keyboard model

unless you are using the default model, which is US

English. If you are using either a non-US model or a model

that is not PS/2-compatible, your system administrator

can configure the terminal so it can recognize the

keyboard.

You can reassign some key functions and keyboard LED

functions, or assign your own functions to function keys.

See “Keyboard Options” on page 6-8 for more

information.
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Using the Keyboard

NCD
Keyboard Input Keys
A keyboard consists of several distinct groups of keys:

❏ The main area contains the alphanumeric keys,

punctuation keys, and keys that control special

functions like Shift or Enter.

❏ Across the top, above the main area, a series of

function keys may appear.

❏ In addition there may be a numeric/application

keypad, cursor (arrow) keys, and edit keys.

In general, if you type a key, the input is the character that

appears on the key’s legend (the symbol printed on the

keycap).

Most keycaps have just one alphabetic character on them.

Pressing it produces a lowercase character; pressing it

with the Shift key produces the uppercase character.

Some keycaps have two legends per key. Pressing the key

by itself results in the character shown in the bottom

legend; pressing it with the Shift key results in the

character shown in the upper legend.

Tip
On the N-107 Sun Type 4-compatible
keyboard, you can access the third
and fourth legends by pressing
Alt/Graph + key and Alt/Graph + Shift
+ key , respectively.

Some keyboards include keys with three legends per key.

The third character is produced using the combination of

Alt/Graph and the key. (Alt/Graph is the label on the

right Alt key on some European-style keyboards.)

The Keymap Editor allows you to change the default

functions assigned to the keys on your keyboard. Talk to

your system administrator, or read the NCDware System
Administrator’s Guide if you would like to learn more about

this feature.

Using the Setup Key
Most NCD keyboards have a Setup key that you use to

access the Console. However, for the keyboards that do

not have a key labelled Setup, see Table 3-1 for equivalent

key combinations.
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Using Window Management Tools
Using Window Management Tools
Windows are areas of the display screen to which a

specific application’s input and output are directed.

Windows are defined by frames, usually rectangular.

The background display on which windows appear is

called the root window, or the background window.

When the pointer is on the root window, it has the shape

of an X.

Windows that display on the root window are called

children of the root window. When you start an

application a new child window opens enabling input and

displaying output for the application.

Using the Window Manager
See Chapter 9, Using the Local NCD
Window Manager or Chapter 13,
Using OpenWindows on NCD
Terminals, for detailed descriptions of
how to use the window manager.

This section is a general description of the functions of

window managers.

The basic components of window managers are the

window frame tools used for:

❏ Directing input to applications

❏ Starting and stopping applications

❏ Changing the size of windows

❏ Changing the location of windows

Table 3-1 Setup Key Equivalents

Keyboard Setup Key

N-107 Sun Type 4-compatible Alt/Graph and Help/Setup simultaneously.

N-108 DEC-compatible (VT220-style) Compose and F3 simultaneously.

N-108LK Alt and F3 simultaneously.

N-122 3270-compatible Alt and Alt-ExSel simultaneously.

Windows 95-compatible Pause.
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Using Window Management Tools

NCD
Many window managers also provide menu and

keyboard equivalents and shortcuts for accomplishing the

same operations as the window frame tools.

Focus Policy—Directing Input to a Window
Window managers provide a mechanism for selecting a

window for input. When you direct focus to a window, it

becomes the active window. Figure 3-1 shows how the

active window is indicated by a darker window frame.

The last window opened is automatically the active

window.

The basic types of focus policy are:

❏ Click-to-focus—(the default policy) Place the pointer

on the window to which you want your input

directed, then click a mouse button to focus the input

there. If you open a new window, it automatically

becomes the active window.

❏ Explicit focus—Just like click-to-focus, except that a

newly opened window is not automatically the

active window.

Active
Window

Figure 3-1  Window Manager Indicating the Active Window
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Using Window Management Tools
❏ Pointer focus—You shift focus from one window to

another simply by moving the pointer (without

clicking) to the desired window. However, to bring

the window to the front, you must click on the

window border.

Like the NCD Window Manager, most window managers

allow you to choose a focus method.

Iconifying and Deiconifying
When you open a window, a small, rectangular

representation of it (called an icon) also appears. Icons are

stacked in a special window called an icon box

(Figure 3-2).

Tip
See “Iconifying Windows and the Icon
Box” on page 9-14 and “Deiconifying
Windows” on page 9-16 for ways to
iconify and deiconify windows.

Window managers allow you to remove a window (or

application) from the root window without closing it, a

process called iconifying. When a window is iconified, the

application does not stop, but you cannot direct input or

view output.

Window managers also provides a mechanism for

restoring an iconified window to its larger, deiconified

form (Figure 3-2). Like the NCD Window Manager, most

window managers allow you to restore the window by

double-clicking on the icon.

Figure 3-2  Iconified and Deiconified Windows

Icon box

A deiconified window—
usable

An iconified window—
not usable until it is
deiconified
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Using Motif-Style Graphical Tools

NCD
Closing a Window
When you close a window, the application exits unless it

is running in more than one window. To close a window,

most window managers allow you to either:

❏ Double click a window frame button, or

❏ Select the Close item from a window menu.

Using Motif-Style Graphical Tools
This section describes the graphical tools that appear in

applications written to follow OSF/Motif style and usage.

The Console, the NCD utility for access to NCD User

Services, uses OSF/Motif-style graphical tools. This

section uses the Console to illustrate the tools.

Menu Bar Tools
Motif-style menu bar tools are illustrated by the Console

features in Figure 3-3.

Figure 3-3  Menu Bar and Related Tools

Menu
buttons
on the
menu bar

Pulldown
menu
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Using Motif-Style Graphical Tools
Table 3-2 summarizes the use of the Motif menu bar tools

shown in Figure 3-3.

Table 3-2 Using Menu Bar Tools

Graphical Tool Description Usage

Menu bar The strip across the top of the

window that contains menu

buttons.

Click a button on the menu bar to

access the application’s main

menus.

Menu button A menu name that appears on a

menu bar.

Display a menu by clicking on the

menu button.

Menu or

pulldown menu

A list of items that appears when

you click a menu button or an

option button (see Table 3-4).

If an ellipsis (. . .) appears to the

right of a menu item, selecting it

displays a popup window.

Select an item from the list by

clicking on it or by dragging to it

and releasing.

Close a menu without selecting

an item by moving the pointer off

the menu and clicking.

Popup window A window that appears on the

display screen when you click a

menu item that has an ellipsis

following it.

Read the information displayed

in the popup window or enter

information in the text entry

fields.
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Using Motif-Style Graphical Tools

NCD
Button Tools
Figure 3-4 shows button-type graphical tools; Table 3-3

describes them.

Figure 3-4  Motif-Style Buttons in Popup Windows

Hide
buttons
(open)

Hide
buttons
(closed)

Toggle
button (on)

Radio
buttons

Buttons

Option
button
 Terminal Interface Basics 3-10



Using Motif-Style Graphical Tools
Table 3-3 summarizes the purpose and use of Motif-style

buttons.

Table 3-3 Use of Motif-Style Buttons

Graphical Tool Description Usage

Button A rectangular box. Click to invoke the action specified on the

button.

Toggle button A square box to the left

of descriptive text.

Click the toggle button to enable the

item—the button turns solid.

Click the toggle button to disable the

item—the button becomes an outline.

Hide button A toggle button used to

open or close a hide box;

for example, in the User

Preferences window.

Click the hide button to display the

contents of a hide box—the button turns

solid and the contents are displayed.

Click the hide button to hide the contents

of a hide box—the button becomes an

outline and the contents are hidden.

Radio buttons Diamond-shaped

buttons next to text

describing choices.

Click radio buttons to select a limited

number of choices among a larger number

of options.

If you exceed the permitted number of

selections, buttons previously selected are

deactivated.

Option button A rectangular button,

labeled with its purpose,

with a small dash on the

right of the label

Click the option button to display a

pulldown menu.

On

Off

Open

Closed

Selected

Deselected
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Using Motif-Style Graphical Tools

NCD
Slider and Text Tools
Sliders allow you to specify numerical quantities, and text

fields display text or allow you to enter text. Figure 3-5

shows the slider and text tools; Table 3-4 summarizes their

purpose and use.

List

Figure 3-5  Slider and Text Tools

Hide
box
(open)

Sliders

Text
entry

Scroll
bar

Stepper
arrow

Text
display

Scroll
bar

Labels
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Using Motif-Style Graphical Tools
Table 3-4 summarizes the purpose and usage of the slider

and text tools.

Table 3-4 Use of Sliders and Text Tools

Tool Description Usage

Label A line of text in a proportionally

spaced font.

Identifies input or output information.

Slider A control device with a

numerical value to its left and a

slider bar that you can move

horizontally.

Drag the slider bar to change the value.

Click one end of the slider to increase or

decrease the value by one.

Scroll bar A bar along the side or bottom of

a list or text display area.

Between the arrows is a slider.

Click the left mouse button on the stepper

arrows of a side scroll bar to scroll through

text one line at a time.

Press and hold the left mouse button on the

stepper arrows to scroll continuously

through the text one line at a time.

Click the left mouse button above or below

the slider bar to scroll forward or backward

one page at a time.

Click the slider bar and drag the slider to

scroll through the text.

Use the scroll bars along the bottom of the

text to see portions of text that are hidden.

Text entry Editable text in a monospaced

font.

Click in the text entry field, and enter text.

Text display Computer output text in a

monospaced font.

Read the computer output for information.

Hide box A rectangular box with a line of

text in the upper-left corner and

a hide button to open and close

it.

Click a hide button to reveal the hide box

contents—the button turns solid and the

contents are revealed.

Click the hide button to hide the hide box

contents—the button becomes an outline and

the contents are hidden.

List Text lines in a proportionally

spaced font.

Click a text line in a list to highlight the text.
NCD Terminal Interface Basics 3-13



Using Motif-Style Graphical Tools

NCD
 Terminal Interface Basics 3-14



4 Starting and Ending NCDware Sessions

This chapter explains how to log in, log out, and suspend

an NCDware session. It also tells how to reboot (restart) an

NCD terminal.

If you want to know more about your particular system

setup, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Assumptions
This chapter assumes you are familiar with the operating

system of the login host.

The procedures described in this chapter assume you are

using the X Display Manager (XDM).

Turning on the Terminal
The power switch is in different locations on different

terminal models. Ask your system administrator or see the

terminal installation booklet if you do not know where

your terminal’s power switch is located.

If your NCD terminal is properly set up, it automatically

loads and executes the terminal software when you turn

the power on. This process is called booting.
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Booting

Sta
Booting
Booting is the process of running power-on diagnostic

tests, and loading and executing the terminal software.

When the boot process starts, memory test results and

other messages appear. If the tests pass, the terminal

software is loaded into memory from a host on the

network.

The boot process takes approximately 20 to 30 seconds,

depending on how your system is set up.

Logging In
When the boot process is completed, an X-shaped cursor

appears on the display screen until it is replaced by a

small, watch-shaped cursor. Then the Console and Login

Chooser appear (Figure 4-1).

Your system administrator may have configured a

different initial display. For example, you may see a login

banner or a terminal emulator window instead of a Login

Chooser.

The Console
The Console is the primary way of connecting to host

computers and applications, and accessing NCD User

Services. “Basic Console Usage” on page 5-1 describes the

Console in detail.
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Logging In
Using the Login Chooser
Tip
If the Login Chooser does not appear
automatically when the terminal
boots, display it manually by:
1. Clicking the Login menu button in
the Console.
2. Clicking the Login New X Session
item.

The Login Chooser allows you to select a login host from

a list of available hosts.

To log in and choose a host:

1. From the Hosts  list, select the name of the host you

want.

— The list is scrollable; if the host you want is not

visible, click the left mouse button on the scroll

bar’s stepper arrow to display more host

options.

— When you select a host in the Hosts list, its name

appears in the Host  text entry box. The values

for the Protocol and Type pulldown menus are

also automatically selected.

— You can also request a host by typing its name in

the Host text entry box and selecting its protocol

and type.

TCP - tcp host
TCP - xdm host
TCP - xdm host
TCP - xdm host
TCP - xdm host
NCDnet - DECnet host

anemone
mermaid
octopus
shark
orca

OTTER

Figure 4-1  The Terminal Display After Booting

Scroll arrow

Console

Login chooser

Text entry box

Messages hide box
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Logging In

Sta
2. To establish the connection, click the OKbutton at the

bottom of the Login Chooser window. The terminal

software connects to the host you selected. For most

systems, XDM displays a login banner (Figure 4-2).

If the host you selected is not available, a message

appears in the Messages  hide box. You have the

following options:

— To cancel the request, click the Quit  button.

— To recheck which hosts are available, click the

Rebroadcast  button.

— To cancel the login process and close the Login

Chooser, click the Cancel  button.

Login Banner
Logging into the host is similar to logging into any other

kind of terminal. By logging in, you identify yourself to

XDM. The host can then verify that you are an authorized

user.

Login procedures vary, depending on how your system

administrator has customized the software. Usually, a

login banner (Figure 4-2) appears. To log in:

1. Type your username (also called a login name) and

press the Return key.

2. Type your password and press the Return key. Your

password may appear as a series of asterisks.

Figure 4-2  An XDM Login Banner

Welcome to Octopus

Login:

Password:
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Locking the Screen
Startup File
After you log in, XDM reads a startup file in your home

directory. This file lists applications that start

automatically each time you begin a session.

After reading the startup file, XDM starts the window

manager and the listed applications. For example, these

might include the NCD Window Manager, a terminal

emulator, and clock as shown in Figure 4-3.

The terminal is now ready for you to start applications.

 Locking the Screen
On occasion, you may want to lock the display screen

without ending your session.

To lock the screen:

1. If necessary, display the Console by pressing the

Setup key. If your keyboard doesn’t have a Setup key,

see Table 5-1 on page 5-2 for the equivalent key

combination.

2. From the Console, select Utilities ⇒ Lock Screen.

Figure 4-3  Typical Display After Login

Terminal
Emulator
Window
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Locking the Screen

Sta
3. The screen goes blank, and the Lock Screen dialog

box appears (Figure 4-4).

4. Type a password in the Password text entry box. This

can be any password.

5. Press the Return key or click OK.

6. When prompted, type the password again.

7. Click OK; the screen displays Screen Locked .

To unlock the screen and resume your session:

1. Type the same password in the Password  text entry

box.

2. Press the Return key or click OK.

Setting Automatic Lock Screen
You can set your terminal to lock the screen automatically

if you leave it idle for a specified period.

To set the screen to lock automatically:

Tip
Unless you ask your system
administrator to save the changes you
make in Change User Preferences,
they are reset to the default settings
when you reboot the terminal. (See
“Saving Preferences for Later
Sessions” on page 6-3.)

1. From the Console, select Change User Preferences ⇒
Console and Utilities. In the Automatic Lock
Screen After (minutes) text entry box, enter how

much time must pass for the screen to lock

automatically.

2. In the Lock Screen Default Password  text entry

box, enter the password you want to use to unlock

the screen after the screen automatically locks.

3. Click the Apply  button. The Lock Screen Default
Password  text entry box changes to 15 asterisks to

disguise the length of your password.

Figure 4-4  The Lock Screen Dialog Box
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Logging Out
When you leave the terminal idle for the specified number

of minutes, a popup dialog box appears so you can unlock

the screen.

To unlock the screen and resume your session:

1. Type the password into the Password  text entry box.

2. Press the Return key or click OK.

Logging Out
As in the procedures for logging in, logout procedures

depend on the software running on your system and how

your system administrator has customized your

environment. You can log out one of three ways:

❏ From the Console’s Login menu

❏ From a root window menu

❏ By setting automatic logout

Logging Out from the Console’s Login Menu
To use the Console Login menu to log out:

1. Select the Login  menu.

2. Click Logout .

Tip
Your system administrator may set up
your terminal so that the popup
window does not display and you are
logged out immediately.

3. A popup window appears asking you to confirm that

you want to end the session (Figure 4-5).

— Click Yes to log out. The session ends, and the

Console and Login Chooser redisplay. You can

start another session by choosing a host and

logging in again.

— Click No to stop the logout process. The current

session resumes.

— Click Show to display the Show Connections
popup window, which lists the current X

connections (local and host-based applications).
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Sta
Logging Out from the Root Menu
Tip
See “Using Window Management
Tools” on page 3-5 for more
information about the root menu.

Your system administrator might configure a root menu

for you to use for accessing hosts and applications and for

logging out. You can display the root menu by clicking a

mouse button while the X cursor is on the root

(background) window. Your system administrator

determines which root menu appears when you click each

mouse button.

To log out from a root menu:

1. Click a mouse button. (Your system administrator

determines which mouse button provides the root

menu.)

2. Select Logout .

When you log out, a cautionary popup dialog box asks

you to confirm that you wish to log out. After you click

Yes, your session ends. The Console and Login Chooser

then reappear, and you can begin another session.

Setting Automatic Logout
To configure your terminal to log out automatically after a

specified period of inactivity:

1. From the Console window, select Setup ⇒  Change

User Preferences ⇒ Console and Utilities.

2. In the Automatic Logout After (minutes)  text

entry box, enter how much time must pass for the

session to end automatically.

Figure 4-5  Confirming Logging Out
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3. In the Automatic Logout Cancel Delay
(seconds)  text entry box, enter the number of

seconds of delay to allow you to cancel the logout

after the popup dialog box appears.

Tip
Unless you ask your system
administrator to save your changes,
they are reset to the default settings
when you log out or boot the terminal.
(See “Saving Preferences for Later
Sessions” on page 6-3.)

4. Click Apply .

When you leave the terminal idle for the specified

amount of time, a popup dialog box appears so you

can confirm or cancel the logout.

— Click No to stop the logout.

— Click Yes to confirm the logout.

Rebooting
To apply changes to your user preferences or setup

parameters, you may need to reboot your terminal.

To reboot your terminal:

1. From the Console window, select Console ⇒ Reboot.

A popup window appears, prompting you to

confirm that you want to boot the terminal.

— Click OKto reboot. The screen goes black, and the

boot process begins shutting down all of the

applications.

— To stop the reboot, click Cancel . The current

session resumes.

2. The reboot process takes 20 to 30 seconds. When

booting is complete, the Console and Login Chooser

appear.
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5 Using the NCDware Console

The NCDware Console is a local application that provides

access to NCD User Services. The services are a set of

utilities and local applications that help optimize NCD

terminal use and management.

Note
A local application is an application
that runs on the NCD terminal’s
processor instead of a host’s
processor.

This chapter introduces the NCD User Services accessible

through the Console and describes how to start and run

them. Subsequent chapters include detailed instructions

on some of the applications.

Caution

Changes made to system settings and parameters may have
unexpected and undesirable results! We recommend that only
system administrators change settings or parameters
accessible through the Console, especially those that are not
described in this guide.

 Basic Console Usage
The Console window (Figure 5-1) provides access to NCD

User Services.

Figure 5-1  The Console
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Displaying and Hiding the Console
By default, your terminal displays the Console

automatically after booting.

If the Console does not open when the terminal boots, you

can display it by pressing the Setup key or using an

equivalent key combination if your keyboard has no Setup

key (Table 5-1).

To hide the Console, press the Setup key or key

combination again.

Accessing Console Menus
Click the Console’s menu bar buttons to display menus.

The menus accessible through the Console’s menu bar

invoke applications, utilities, and configuration

parameters. Table 5-2 summarizes the commands and

utilities available through each menu.

Your system administrator can control the items that are

available from your Console menus. For example, if you

do not perform system maintenance, you do not need

access to system administration utilities.

Most users have access to the menus described in this

section. You may also have access to menu items that are

not described in this section. Menu items that you cannot

access may be grayed out.

Table 5-1 Setup Key Combinations

Keyboard Setup Key

N-107 Sun Type 4-compatible Alt/Graph and Help/Setup simultaneously (These

keys have blue letters.)

N-108 DEC-compatible (VT220-style) Compose and F3 simultaneously

N-108LK Alt and F3 simultaneously

N-122 3270-compatible Alt and Alt/ExSel simultaneously

Windows 95-compatible Pause
g the NCDware Console 5-2



Basic Console Usage
Starting Local Applications from the Console
To start applications from the Console:

1. Click the menu button of the main menu from which

you access the application (Table 5-2).

For example, to start a window manager, click the

WindowMgr  menu button.

2. Click or drag to the item representing the application

you want to start.

For example, to start the local NCD Window

Manager, click the NCD Window Manager  toggle

button. The NCD Window Manager starts and the

characteristic frames appear around the windows on

the display.

Table 5-2 Console Pulldown Menus

Menu Item Description

Console Clear Messages Deletes all output from the Messages area.

Rescan Messages Recalls messages that were cleared from the

Messages area.

Abort Waiting Fonts Cancels persistent font requests to the NCD font

server (if the terminal is using the font server).

Abort Ringing Bell Stops the bell ringing.

Abort Serial Line

Abort Parallel Port

Cancels a serial or parallel connection.

Reboot ... Reboots the terminal (loads and executes terminal

software).

Close Closes (hides) the Console.

Login Login New Session ... Displays the Login Chooser, allowing you to start a

session.

Logout ... Logs you out and displays the Login Chooser.
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Terminals New Terminal ... Starts a terminal emulator or chooser for host

connection.

New 3270 ... Starts a 3270 local terminal emulator. 1

New 3179G ... Starts a 3179G local terminal emulator for use with

3270 IBM mainframe graphics. 1

Keymap Editor ... Starts the local Keymap Editor.

New Telnet ...

New LAT ...

New CTerm ...

New Serial ...

Starts a terminal emulator host connection.

If an NCDnet address is not assigned to the

terminal, the New CTerm item is grayed out.

New Dialer ... Starts the dialer for XRemote.

WindowMgr NCD Window Manager Starts and stops the local NCD Window Manager.

Motif Window Manager Starts and stops the local Motif Window Manager. 1

Utilities Refresh Screen Redraws the screen.

Blank Screen Starts the screen saver.

Lock Screen ... Locks the screen to prevent unauthorized usage.

Rescan Font Path Rescans the font path.

Free DPS Memory Releases terminal memory used by Display

PostScript applications.2

Test Network ... Tests the terminal’s network connection.

Table 5-2 Console Pulldown Menus  (Continued)

Menu Item Description
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1 Requires a license for use.

2 Does not appear on some terminal models.

Utilities Start Local Command... Starts a local application.

Start NCD Mosaic

Browser...

Starts the NCD Mosaic Browser.1

Start Java Applet... Starts a specified Java applet.1

Video Player ... Starts the Video Player and associated programs.2

Windows Access ... Allows connections to Windows NT hosts.

Setup Change Quick Setup...

Change Setup

Parameters...

Change User

Preferences...

Provides access to terminal and network parameter

settings. Except for Change User Preferences

settings, these are primarily for advanced users and

system administrators.

Statistics Show Version ... Provides information about the terminal hardware

and software.

Show Memory ... Shows the amount of free memory.

Show X Connections ... Lists active applications and terminal resources

used by each.

Show Statistics ... Provides detailed network statistics.

Show Wireless... Provides detailed wireless network statistics.2

Table 5-2 Console Pulldown Menus  (Continued)

Menu Item Description
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Displaying Terminal Messages
A process in the terminal monitors its activities and issues

messages. The messages are collected and displayed in the

Console’s Messages  hide box.

Console Messages Hide Box
Below the Console menu bar is the Messages hide box. To

see the messages, click the hide box’s toggle button.

Once you’ve opened the Messages hide box, the message

area remains open—even if you remove the Console from

the display and then redisplay it—until you click the hide

box again to close it.

❏ Click the Messages  hide box to open the Console’s

message area.

❏ Resize the Console to display as much message area

as you need.

❏ Adjust the Console message area’s scroll bars to

redisplay output that has scrolled by and no longer

fits in the message area.

❏ Click the Messages  hide box again to close the

Console’s message area.

Message Categories
The Console’s message area displays four categories of

terminal messages. Table 5-3 shows an example of each

type of message.

Table 5-3 Types of Messages

Category Sample Message

Informational %CONFIGD-I-IPADDR, IP address for this unit: 192.43.154.123

Warning %CONFIGD-W-BADPASSWD, incorrect password entered

Error %CONFIGD-E-GATEWAYBADNET, gateway 89.0.0.1 is not on local net

Fatal %CONFIGD-F-INITUI, unable to initialize user interface
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Getting Information from the Console
This section describes how to use the Console’s Statistics

menu to get information about the terminal, its software,

and the network.

Show Version
The Show Version  item displays a popup window

containing information about the terminal and its software

and hardware.

Tip
On a Token-Ring network, two fields
are different: Built in Token Ring
instead of Built in Ethernet and
Current Token Ring instead of Current
Ethernet.

You can select text in this window to copy into another

window.

❏ To select an entire row of text, click the left mouse

button on the desired row.

❏ To select all of the text in the window, click the right

mouse button on the text.

Figure 5-2  The Statistics Menu

192.43.152.138
mar335.mar.com

octopus.mar.com
anemone.mar.com

V2.8.2

HMX

8-bit color

8.0 Mb
Audio NFS-server

Figure 5-3  The Show Version Popup Window

V5.1.123 hmx
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Table 5-4 explains the information displayed in the Show
Version  popup window.

Table 5-4 Contents of the Show Version Window

Field
Information
Displayed

Field Information Displayed

Model Terminal model Built in Ethernet
or
Built in Token Ring

Default physical Ethernet

or Token-Ring network

address

NCDware Software version and

X server name

Current Ethernet
or
Current Token Ring

Current physical

Ethernet or Token-Ring

address

Boot
Monitor

Boot Monitor version TCP/IP Name Domain name (terminal’s

hostname for Internet

communications)

Screen Display type TCP/IP Address Terminal’s address for

Internet communications

Resolution Display resolution and

dots per inch

TCP/IP Netmask Subnet mask (address

used in routing)

Keyboard Group name of

keyboard

NCDnet Name Node name for DECnet

Memory Amount of memory

installed

NCDnet Address Node address for

DECnet

Bundled
Features

Terminal software

features that you may

use without an

additional license

Booted From Boot host (host from

which terminal was

booted)

Licensed
Features

Currently licensed

terminal software

features

X Session Host Login host
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Show Memory
The Show Memory item displays a popup window

containing a histogram representation of the amount of

available memory.

Below the histogram, the window includes the:

❏ Amount of total installed memory

❏ Amount of free memory

❏ Size of the largest free memory block

The Update  button adds to the histogram by showing an

updated reading of free memory.

The Restart  button starts the histogram again with an

updated reading of free memory.

Figure 5-4  The Show Memory Window
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Show X Connections
The Show X Connections item displays a popup window

that lists all active X connections and the terminal

resources used by these connections.

Table 5-5 describes the information displayed for each

application.

Figure 5-5  The Show X Connections Window

octopus.mar.com

mermaid.mar.com

anemone.mar.com
octopus.mar.com

octopus.mar.com

xterm

Table 5-5 Contents of the Show X Connections Window

Field Information Displayed Field Information Displayed

Name Application’s name GCs Graphics context information

Host Host on which the application is

running

Fonts Number of fonts in use

Auth Type of authorization used Cursors Cursors created by the

application

XID Window identification number Cells Color cells allocated by the

application

Windows Windows created by the

application

Colormaps Colormaps allocated by the

application

Pixmaps Off-screen drawing areas used by the application
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Show Statistics
The Show Statistics  item displays a detailed

description of system and network statistics that are

primarily useful to system administrators and advanced

users.

Show Wireless
Note
The Show Wireless command only
appears if you are using an NCD
Explora 400/450 series terminal.

The Show Wireless  item displays a detailed description

of the network statistics for an NCD wireless terminal.

Figure 5-6  The Show Wireless Window
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Table 5-5 describes the information displayed for each

NCD wireless terminal.

Table 5-6 Contents of the Show Wireless Window

Field Information Displayed

Signal Strength Strength of the last packet received

Access Point Name Host name

Access Point Node IP address

Channel Current channel

Subchannel Current subchannel

In Sync Count Number of times the terminal was able to

synchronize to a Master station

Roam Alarm Count Number of roaming alarm packets received;

indicates weak signal strength
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6 Customizing Your Desktop Environment

This chapter explains how to use the Console’s User

Preferences utility to customize your work environment.

If you want to know more about your particular system

setup, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Setting User Preferences
This section explains how to access the User Preferences

window (Figure 6-1) and use it to make temporary or

permanent changes to your desktop environment.

Caution

Changes made to system settings and parameters may have
unexpected and undesirable results! We recommend that only
system administrators change settings or parameters
accessible through the Console, especially those that are not
described in this guide.

Displaying the User Preferences Window
You can specify desktop preferences in the User

Preferences window. To display the User Preferences

window:

1. Press the Setup key or key combination (see Table 5-1

on page 5-2) to display the Console.
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2. Select Change User Preferences from the Console’s

Setup menu item.

3. The User Preferences window (Figure 6-1) appears.

Components of the User Preferences Window
The User Preferences window consists of:

❏ A series of hide boxes that you open by clicking the

toggle button next to the hide-box title. Each hide box

contains a set of graphical tools for specifying your

preference relating to an aspect of your desktop

environment.

Figure 6-1  User Preferences Window

Clicking a hide button
reveals options that you can
set to customize your work
environment
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❏ Menus accessible from the menu bar include:

— File menu, for specifying that changes should be

saved to a file or read from a file

— Section menu, for opening a specific sub-

window without using the toggle button

❏ Messages area, for the terminal to report when

changes take effect and other information about the

process of changing preferences setting

❏ Buttons for applying or cancelling preferences that

you specify in the User Preferences hide boxes

Specifying Your Preferences
To specify your preferences:

1. Click a hide box to display the options.

For example, click the Bell  hide box to display the

bell options available.

2. Use the graphical tools in the hide box to specify

your preferences.

For example, in the Bell  hide box, drag the Bell
Base Volume  slider to adjust the volume; drag the

Bell Duration  slider to adjust how long the bell

sounds.

Applying Your Preferences to the Current Session
To apply your preferences to the current session, click the

Apply  button at the bottom-left corner of the User

Preferences window.

Saving Preferences for Later Sessions
User preference settings (and any other parameters set

through the Console) can be specified by your system

administrator using remote configuration.

You can also save the preferences that you specify in the

User Preferences window and make them available for

later sessions:
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1. Ask your system administrator for the name of the

file to use for saving preferences.

2. From the Console, select Change User Preferences ⇒
File ⇒ Save to File.

3. In the popup window, type the name of the file on

the host system where you want the preferences

saved. Include the complete pathname (usually your

login directory).

4. Each time you log in, the preferences you specified

are automatically loaded into the terminal.

Note If you change your user preferences and

log out without saving them, they revert to

their default settings.

Restoring Default Preferences
If you change options in User Preferences and decide that

you’d rather keep the settings that were in effect when you

booted the terminal, you can click the Defaults button at

the bottom of the User Preferences window. The settings

loaded from the remote configuration file at boot time are

applied to the current session.

Cancelling Changes
If you change options in User Preferences and decide that

you want to cancel the changes, click the Cancel button at

the bottom of the User Preferences window. The changes

are cancelled and the User Preferences window

disappears.

Closing the User Preferences Window
To close the User Preferences window, select File ⇒ Close.
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Options in the User Preferences Window
This section describes the options that you can modify in

Change User Preferences.

Audio Option
Click the Audio  hide button in the User Preferences

window to display the Maximum Gain  option, which

defines the maximum volume for audio applications.

Bell Options
Click the Bell  hide box to display bell options.

The bell audibly announces events (such as the arrival of

new mail) or problems (such as an attempt to scroll past

the end of a document).

Enable or disable the bell by clicking the Enable Bell
toggle button, which is enabled by default.

You can change the following bell features from the Bell
hide box. When you change the bell values, it beeps to let

you know what the new value sounds like.

❏ Bell volume: drag the Bell Base Volume  slider to

adjust the percentage of the default bell volume.

❏ Bell pitch: drag the Bell Pitch  slider to choose a

pitch of between 0 Hz and 3,000 Hz.

❏ Bell duration: drag the Bell Duration  slider to

adjust how long the bell sounds, from 0 msec. to

1,800 msec.

❏ Ring Bell: click the Ring Bell  button to test the bell

sound without changing any values.

Compatibility Options
Click the Compatibility  hide button to display the

Compatibility options. The compatibility settings control

software features that can affect the performance of

applications on your NCD terminal.

Click the toggle buttons to enable or disable these features.
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❏ Permit Old X Bugs : If enabled (the default), allows

transmissions from applications that do not comply

with the current X standard.

❏ Be Compatible with Old DECwindows Vendor
String : If enabled, controls the vendor string

returned by the X server to X applications that

request it.

❏ Be Compatible with Old DECwindows Keyboards :

If enabled, changes the presentation of modifier keys

to applications to accommodate DECwindows

modifier key interpretation.

❏ Be Compatible with Old DECwindows Images : If

enabled, allows DECwindows applications to display

images using the correct byte ordering.

Console and Utilities Options
The Console and Utilities hide box options control the

Console access key sequence, automatic  logout, screen

saver, and time stamps in the Console’s message area.

Click the Console and Utilities  hide button to display

the Console and Utilities options.

❏ Console Key Sequence  specifies an alternative key

sequence for accessing the Console. To use this

feature, type in ModifierList-Key, where ModifierList is

any number of modifiers (such as Ctrl, Shift, or Alt)

separated by hyphens, and Key is one alphanumeric

or function key (such as F4, Y, or 9).

 Some valid examples are:

— Shift-F9

— Ctrl-Alt-Shift-A

❏ Automatic Logout After (minutes) , Automatic
Logout Cancel Delay (seconds) , and Automatic
Lock Screen After (minutes)  specify how the

automatic logout feature functions. See “Setting

Automatic Lock Screen” on page 4-6 and “Setting
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Automatic Logout” on page 4-8 for information

about settings for automatic logout and screen lock.

❏ Delay When Blanking Screen specifies how long a

delay you want from the time you select the Blank
Screen  utility until the screen actually blanks. Type

the delay in milliseconds in the text entry box.

❏ Show Console Message Timestamps  specifies that

you want diagnostic messages to be printed with

time stamps in the Console. Your system

administrator might use the time stamp information

to diagnose problems.

Environment Option
The Environment Variables  hide box allows you to

specify environment variables for Java and the NCD

Mosaic Browser (for example, specifying your home

directory). For more information about these variables, see

the NCDware System Administrator’s Guide.

Font Options
Click the Fonts  hide button to display font options.

You can change the current font path using the Font Path
Entry  list and text entry field. The font path includes the

font directories available for your current session.

Tip
Be careful when setting the font path
for your terminal. The number of font
directories and the order in which they
appear affects terminal software
performance, memory consumption,
and the appearance of applications.

❏ To delete a font directory:

a. Click the directory you want to delete in the Font
Path Entry  list.

b. Click the Delete  button, then the Apply  button.

c. Select Console ⇒ Utilities ⇒ Rescan Font Path for

the new path to take effect.

❏ To add a font directory or font server:

a. In the Font Path Entry  list, determine where the
new font directory should appear, and click the
current directory below that. The Font Path
Entry  field appears.
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b. Click the New button. A nil  line appears in the

Font Path Entry  list, above the directory you

highlighted in Step a.

c. Delete the word nil  by backspacing through the

word.

d. Type the name of the font directory or font server

that you wish to add to the font path and press the

Return key. The new directory appears in the Font
Path Entry  list in place of the nil  entry.

e. Click the Apply  button.

f. Select Console ⇒ Utilities ⇒ Rescan Font Path for

the new path to take effect.

❏ To save your changes to the font path for future

sessions, ask your system administrator to save the

settings in an appropriate configuration file.

Tip
Do not display extended font
diagnostics unless you are trying to
solve font problems. The output is
extensive and might obscure
important messages.

❏ To see extensive diagnostic information about font

access (such as notices of fonts being opened and

Font Server activity), turn on the Show Extended
Font Diagnostics  toggle button. The diagnostic

output appears in the Console’s message area.

Keyboard Options
Click the Keyboard  hide button to display the following

keyboard options:

❏ Function key mapping is either UNIX-style or VMS-

style. VMS is not supported in this release.

❏ Keyboard autorepeat is a keyboard feature that

causes continued repetition of a keystroke when you

hold the key down.

— Enable or disable keyboard autorepeat by

clicking the Enable Keyboard Autorepeat
toggle button.

— Drag the Autorepeat Begin After  slider to

specify how long (from 0 milliseconds [msec.] to

1,000 msecs.) a key must be held down before
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the autorepeat function takes effect. The value in

milliseconds is displayed to the left of the slider.

— Drag the Autorepeat Rate  slider to specify the

rate of keystroke repetition (from 2 repetitions

per second to 30 repetitions per second).

❏ Keyclick volume is the volume of the sound that

occurs when you press a keyboard key. You specify

Keyclick Volume  as a percentage of the default

volume.

Drag the Keyclick Volume  slider to change the

percentage value.

❏ Most NCD keyboards have LEDs. You can change the

LED usage using the LED radio button matrix.

The LED functions are listed in Table 6-1.

Table 6-1 Keyboard LED Functions

Function
Name

Purpose

X1, X2, X3, X4 The LED is controlled by applications.

Net Lights the specified LED when the terminal receives network traffic.

Warn Lights the specified LED when the terminal begins to run low on memory.

Ctrl Lights the specified LED when the keyboard Ctrl key is pressed.

Shift Lights the specified LED when the keyboard Shift key is pressed.

Caps Lights the specified LED when the keyboard Caps Lock key is toggled on.

Num Lights the specified LED when the keyboard Num Lock key is toggled on.

Mod1, Mod2,

Mod3, Mod4,

Mod5

User-defined. Lights the specified LED when the keyboard Modn
(Modifier) key is pressed. Mod keys are usually assigned to Alt, Ctrl, Shift,

Caps Lock, and Option keys.
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OpenGL
Tip
The OpenGL graphics extension does
not provide support for GL
applications, which are designed
expressly for Silicon Graphics, Inc.
(SGI) workstations. If you try to run a
GL application with output to an NCD
terminal, error messages such as the
following result:
dgl error (protocol): remote
machine not DGL capable -
tjfhtx:0
dgl error (default init):
default dglopen(tjfhtx:0,4)
returned -13
For more information about the
differences between OpenGL and GL,
see the NCD FTP site or Web site.

The OpenGL graphics extension included in NCDware

provides support for running OpenGL-based graphics

programs on HMX and Explora 700 terminals.

The OpenGL hide box options, which control how

applications that use OpenGL process graphics, are:

❏ Allow Dithering : Enables color dithering

operations to improve color resolution when

rendering to a visual with few color bitplanes.

Dithering is performed on 24-bit visuals. When

disabled, dithering is not controllable by the

application.

❏ Allow Blending : Enables color blending operations

that combine incoming pixel color and alpha values

with those of the pixel already at that location. The

blending operations are available only with RGBA

visuals. When disabled, the operation is not

controllable by the application.

❏ Allow Depth Test : Enables Z-buffering operations,

used for hidden surface elimination. When disabled,

the operation is not controllable by the application.

❏ Allow Alpha Test : When enabled, the application

accepts pixels for rendering based on their alpha

values. The alpha test is available only with RGBA

visuals. When disabled, the operation is not

controllable by the application.

❏ Allow Scissor Test : Enables scissor test operations

to mask a rectangular region of the screen to prevent

drawing outside of it. When disabled, the operations

are not controllable by the application.

❏ Allow Stencil Test : Enables stenciling operations

used to prevent drawing to an irregularly shaped

region of the screen. When disabled, the operations

are not controllable by the application. Disabling this

option saves memory.
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❏ Allow Polygon Stipple : Enables stippling

operations used to fill polygons with a non-solid,

application-defined, 32-bit x 32-bit window-aligned

pattern. When disabled, the operations are not

controllable by the application.

❏ Allow Logical Operations : Enables bitwise logical

operations that combine incoming pixel values with

already drawn pixels. This is available only with

color-index visuals. When disabled, the operations

are not controllable by the application.

❏ Fast Perspective Rendering : Enables fast

perspective rendering of primitives in perspective

viewing situations. Enabling this option reduces the

quality of texture-mapping with large polygons that

have small textures rendered in a perspective view.

❏ Activate Alpha Buffer for RGBA Visuals :

Enables built-in, 8-bit alpha buffers. RGBA visuals are

predefined in pairs, one pair with an 8-bit-deep alpha

buffer and the other, a zero-bit-deep alpha buffer.

This option allows use of the 8-bit alpha buffers.

Disabling it causes visuals with 8-bit-deep alpha

buffers not to be advertised to applications and also

saves memory. This option does not affect color-

index visuals. It takes effect the next time the

OpenGL extension is loaded.

❏ Enable 8-bit color-index double buffered
Visual : Advertises the 8-bit color-index double-

buffered visual type to applications, taking effect the

next time the OpenGL extension is loaded.

❏ Enable 8-bit color-index single buffered
visual : Advertises the 8-bit color-index single-

buffered visual type to applications, taking effect the

next time the OpenGL extension is loaded.

❏ Enable 8-bit RGBA double buffered Visual :

Advertises the 8-bit RGBA double-buffered visual

type to applications, taking effect the next time the

OpenGL extension is loaded.
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❏ Enable 8-bit RGBA single buffered Visual :

Advertises the 8-bit RGBA single-buffered visual type

to applications, taking effect the next time the

OpenGL extension is loaded.

❏ Enable 24 bit RGBA double buffered Visual :

Advertises the 24-bit RGBA double-buffered visual

type to applications, taking effect the next time the

OpenGL extension is loaded.

❏ Enable 24 bit RGBA single buffered Visual :

Advertises the 24-bit RGBA single-buffered visual

type to applications, taking effect the next time the

OpenGL extension is loaded.

Pointing Device Options
See Appendix B, Using Alternate
Input Devices, for more information
about touch screen and light pens.

Click the Pointing Devices  hide button to display

options for adjusting a mouse, a trackball, or a touch

screen monitor.

❏ Current Pointing Device  controls whether you

are using the mouse or other device (or both) as the

pointing device.

❏ Threshold Distance (pixels) . Setting the

acceleration ratio higher than the default sometimes

makes it difficult to accomplish fine movements with

the mouse or trackball because the pointer moves too

quickly across the display screen.

To alleviate this problem, drag the Threshold
Distance slider to a new value (from 1 pixel to 20

pixels). Threshold Distance is the number of pixels

over which the pointer moves at the default speed

before the Acceleration  value comes into effect.

For example, if you want to move the pointer at

8-pixel increments, you could set threshold at 12.

Then while you move the pointer the 8 or so pixels

for fine positioning, it moves at the slower default

pace, allowing you to position the pointer carefully.

When you move it more than 12 pixels, however, the

Acceleration Ratio value takes effect and moves it
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across the screen 3 times more quickly than your

hand’s motion.

❏ Acceleration Ratio (percent)  controls how

quickly the pointer moves across the screen relative

to the motion of your hand. The value used is a

percentage that multiplies pointer motion. Increasing

pointer speed is useful if you are using a large

display screen and need to move the pointer across

large portions of it quickly.

For example, if you set acceleration to 300 percent,

then the pointer moves across 3 times the number of

pixels that your pointing device covers in any

motion.

To change the acceleration from the system default,

drag the Acceleration Ratio  slider to a new value.

An example of a standard setting is Threshold  at 1

and Acceleration  at 300. These are the default

values.

❏ Button Arrangement : choose right-handed or left-

handed mapping by clicking the preferred setting in

the Button Arrangement  option button.

❏ Button Press Threshold  and Button Release
Threshold : set the finger pressure levels that trigger

button actions and presses on touch screen monitors.

Power Management Options
Click the Power Management hide button to display the

Power Management options (Figure 6-2).

Figure 6-2  Power Management Preferences
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Warning

Power management should only be enabled on
monitors that are VESA- (Video Electronics Standards
Association) compliant. Using this feature on
non-VESA-compliant equipment subjects the user to
the serious risk of personal injury or permanent
damage to the equipment. VESA-compliant
equipment is clearly labeled. If you are unsure
whether your equipment is VESA-compliant, do not
use this feature until you have consulted your
monitor documentation.

The US Environmental Protection Agency has instituted

the ENERGY STAR Computers program, which promotes

the use of energy-efficient equipment. Desktop

computers, monitors, and printers purchased by the

federal government must comply with the guidelines set

forth in this program.

To meet the EPA’s ENERGY STAR requirements, computer

equipment must enter a low-power state when inactive. In

the low-power state, the equipment must consume no

more than 30 watts of power. To bring the equipment back

to full power, the user presses a keyboard key or moves

the mouse.

You can change the following power management

features from the Power Management hide box:

❏ Enable VESA Monitor Power Management : click

the toggle button to enable or disable (default is

disabled) the power management feature.

❏ Standby After : drag the slider to specify how long

(from 0 to 240 minutes, default 20) the terminal

remains idle before the transition to the standby

state.

❏ Suspend After : drag the slider to specify how long

(from 0 to 240 minutes, default 40) the terminal
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remains idle before the transition to the suspend

state.

❏ Powerdown After : drag the slider to specify how

long (from 0 to 240 minutes, default 60) the terminal

remains idle before the transition to the powerdown

state.

Screen Background Options
The screen backgrounds available to you depend on the

type of terminal you are using and the software installed.

Click the Screen Background  hide button to display the

Screen Background options.

❏ To get a gray mesh pattern, click the Default  setting

in the Screen Background Type  option box.

❏ To display in solid color, click the Solid Color
setting in the Screen Background Type  option box.

Type the name of the color you want in the Solid
Color  text entry field. The color must be specified as

one of the predefined list of colors in the

/usr/lib/X11/ncd/rgb.txt file.

You can also specify RGB levels directly using the

hexadecimal #rrggbb notation.

❏ To display the contents of a bitmap file, click the

Bitmap  setting in the Screen Background Type
option box.

Type the full pathname of the file in the Bitmap File
text entry field. If the file is not found, ask your

system administrator to mount the directory that

contains the file.

Choose bitmap background and foreground colors

by specifying the colors as in the predefined list of

colors in /usr/lib/X11/ncd/rgb.txt.

Type the background and foreground color

specifications in the Bitmap Foreground Color and

Bitmap Background Color  text entry fields.
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Screen Saver Options
The screen saver utility displays a random pattern after a

specified number of seconds of screen inactivity. Screen

savers prevent the burn-in effect that can occur if the same

image remains on the screen for a very long time.

Click the Screen Saver hide button to display the Screen

Saver options.

❏ Enable Screen Saver : click the toggle button to

enable or disable the screen saver.

❏ Allow Exposures After Screen Saver : click the

toggle button to enable or disable this feature. If

enabled, the terminal software discards the window

contents while the screen saver is activated. The

window contents must then be redrawn by the

application when the display becomes active again.

❏ Save Screen After : drag the slider to specify a

period of time (from 0 seconds to 3,000 seconds) that

the display can remain inactive before the screen

saver begins.

❏ Change Screen Saver After : drag the slider to

specify a period of time (from 0 seconds to 3,000

seconds) before the screen saver changes the pattern

to avoid burn-in.

❏ Screen Saver Style : specify the background to use

by clicking the preferred setting in the Screen Saver
Style  option box.

— Blank  displays a scattering of stars.

— X Logo  displays an X-pattern that moves across

the display.

— Bitmap  displays a bitmap file. Type the name of

the bitmap file into the Screen Saver Bitmap
File  text entry field.
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X, Graphics, and SIE
The X , Graphics, and SIE (Simple Imaging Extension)

settings allow you to specify X settings related to use of

graphics applications with X.

You can change the following features from the X,
Graphics and SIE hide button:

❏ Enable Benchmark Optimizations : click this

toggle to enable or disable this feature. When

enabled, some graphics operations are optimized for

benchmarks.

❏ Enable Graphics Optimizations : click this toggle

to enable or disable this feature. When enabled, some

graphics operations are optimized for speed with a

possible loss in accuracy.

❏ Screen Resolution : drag the slider to specify a

resolution in dots per inch (from 1 to 512; 100 is

default).

❏ Use Backing Store : if enabled, an off-screen image

of a concealed window (or portion of a window) is

stored in local memory to reduce the time it takes to

redraw concealed windows when they are exposed.

If disabled, anything concealed by another window

is discarded and the application must redraw it.

Use of backing store can involve a trade-off between

performance and memory usage. Choose one of

these three settings by clicking the preferred setting

in the Use Backing Store  option box:

— When Mapped : the terminal software can use

backing store for all mapped (displayed)

windows, even if the client has not requested the

feature.

— By Request : the terminal software can honor

requests for backing store from clients

requesting this feature. By Request is the default.

— Disabled : the terminal software does not honor

any requests for backing store from clients.
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The following parameters affect SIE support, which is

included in the X server but no longer supported by NCD:

❏ SIE Sampling Method : specifies the sampling

method to use when scaling. An option box includes

four settings:

— Nearest Neighbor  (default): uses a scaling

algorithm in which each destination pixel is

reverse-mapped into the source image space, and

the source pixel nearest that point is used to

determine whether the resultant pixel is on or off.

— Any Neighbor : looks at the four closest pixels and

turns on the destination pixel if any one of those

four is on.

— Bilinear Interp : performs a weighted average

of the four closest pixels, and turns on the

destination pixel if the result is above an assigned

contrast threshold. A slider allows you to set the

contrast threshold value.

— 4x4 Area : looks at the sixteen closest pixels, and

turns on the destination pixel if the sum of those

pixel values is above an assigned contrast

threshold. A slider allows you to set the contrast

threshold value.

❏ SIE Contrast Threshold : for the Bilinear Interp

and 4x4 Area sampling methods, specifies the

contrast value (percentage) used when scaling. 50 is

the default.
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7 Using the NCD Terminal Emulator

This chapter explains how to use the NCD Terminal

Emulator (VT320 emulation) to connect to a host. It also

explains how to use and customize the NCD Terminal

Emulator window.

If you want to know more about your particular system

setup, refer to:

❏ NCDware System Administrator’s Guide
❏ Your system administrator

Local Terminal Emulators
Terminal emulators are applications that allow you to

connect to a host and run non-X programs.

A local terminal emulator runs on the terminal’s

processor, instead of a host computer, reducing host

processing and memory usage.

NCD Terminal Emulator
The local NCD Terminal Emulator (VT320 emulation)

connects to a host using the protocols listed in Table 7-1

You can have multiple local terminal emulator windows

open on your terminal, depending on available memory.
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NCD 3270 Terminal Emulator
The local NCD 3270 Terminal Emulator allows you to run

applications developed for IBM 3270 terminals. Refer to

the manual Using the 3270 Terminal Emulator for detailed

information about this terminal emulator. A license is

required to run the 3270 terminal emulator.

Connecting to a Host
This section describes how to use the Console to start a

terminal emulator and log in to a host. You can display

multiple terminal emulator windows simultaneously.

The Serial or Dialer connection is used primarily for

connecting to a host via a modem. For information about

using a modem with your terminal, see Chapter 12, Using

XRemote.

Table 7-1 Protocols for Connecting to Hosts Using the VT320 Terminal Emulator

Protocol Description

TELNET A TELNET connection to various hosts. TELNET is a simple terminal

emulation protocol.

LAT A Local Area Transport (LAT) connection to a host providing LAT services.

LAT is a Digital Equipment Corporation communications protocol.

CTERM A Command Terminal Protocol (CTerm) connection to a host using

DECnet/NCDnet. (An NCD terminal requires a license and an NCDnet

address to participate on a DECnet network.)

Serial A local or remote serial connection from the serial port. NCD terminals have

up to three serial ports, so up to three local serial terminal emulators (or

dialers) can be open at once.
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Starting a Terminal Emulator Connection
To log into a host through a TELNET, LAT, CTerm, or serial

connection, use the following procedure:

1. From the Console menu bar, select Terminals . The

Terminals menu appears.

Tip
The Terminal Host Chooser lists local
services called Config, Diag, and File
(Figure 7-1) that are used primarily by
system administration.

2. Click an item in the Terminals menu:

— To display all possible host connections (Telnet,

LAT, CTerm, and serial) select New Terminal .

A Terminal Host Chooser window appears with

a list of the default host connections that are

available on your network (Figure 7-1).

Tip
CTerm requires an NCDnet license
and address.

— To display only a certain kind of host connection,

select one of the other items—New Telnet, New
LAT, New CTerm, New Serial, or New
Dialer .

Another way to display the Terminal Host Chooser is to

select Start Terminal  from the default NCD Window

Manager root menu.

Figure 7-1  The Terminal Host Chooser Window

anemone
mermaid
octopus
MV3100
OTTER

1
Config
Diag
File

TCP - Solbourne
TCP - Solbourne
Telnet - Sun
LAT (80) - Welcome to UNIX
LAT (83) - Welcome to UNIX
Serial - Port 1
Local - Connect to the local configuration manager
Local - Connect to the local diagnostic manager
Local - Connect to the local file manager
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Selecting New LAT
When you select New LAT or New Terminal , only one line

appears in the Terminal Host Chooser for each LAT

service, even if the service is available on more than one

host. The host connection represented by that line is

selected to balance the current load on the hosts offering

the service.

However, you can display all hosts offering a particular

service by selecting that service and then clicking the Show
Node List  button.

Selecting New Serial or New Dialer
When you select New Serial  or New Dialer  and your

terminal has only one serial port, a serial terminal

emulator window appears.

If the serial port is not configured for terminal emulation,

and you select New Serial  or New Dialer , an error

message appears in the Console Messages  hide box, and

no connection is made. Ask your system administrator to

help you.

Selecting a Host From the Terminal Host Chooser
To connect to a host from the Terminal Host Chooser:

1. Select a host:

— If the host you want appears in the Default
Hosts  list, click on its name.

— If the host is not in the Default Hosts  list, type

the hostname or address of the host you want

into the Service  text entry field. You can type

more than one hostname, separated by + signs,

and the first available host is selected.

— To update the list of available network hosts,

click the Update  button.

— To sort the Default Hosts  list by name or by

network, use the Sort menu on the Terminal

Host Chooser’s menu bar.
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— To select the types of connections to display, use

the View menu.

2. For LAT service, use one of the following methods:

— Allow LAT to select a default LAT host node

offering the service you want. Click a LAT item

in the Terminal Host Chooser. The words Node
(optional) and Port (optional)  appear

under Service:  as reminders that you can

specify the node and port as well as the service

name.

— Specify a particular LAT host node offering the

service you want. Click a LAT service in the

Terminal Host Chooser, and click Show Node
List to see a list of all hosts offering that service.

Click a host. The Host:  field changes to

Service: and the words Node (optional) and

Port (optional) appear under the field as

reminders that you can specify the node and

port as well as the service name. Click OK. Click

Show Node List again to return to the listing of

available LAT services.

3. Verify that the correct network appears on the Net
option button.

a. If the wrong network appears on the Net  option
button, click the button to display your options.

b. Select the network you want to use.

4. If a Password text entry field appears on the Terminal

Host Chooser, click in the field and type your

password.

5. Click OK to connect.

— The Terminal Host Chooser disappears.

— The terminal emulator window appears. (See the

example Telnet window in Figure 7-2.)

— A host login prompt appears.
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Logging Into a Host
Log into your selected host by typing your login name and

your password as you are prompted by the host.

Starting Applications
To start applications from the terminal emulator window,

you may need to set the DISPLAY variable to correctly

direct output to your terminal. If an application fails to

start and instead displays the message Can’t Open
display , set the DISPLAY variable as explained below.

In the following commands, display is the IP address or

hostname (such as 192.43.154.205 or mar335) of the

terminal.

Type one of the following commands to set the DISPLAY
variable for the current session:

          % setenv DISPLAY display: 0 (for C shell)
          $ DISPLAY=display:0; export DISPLAY (for Bourne shell or K shell)

If you do not know the terminal’s IP address or hostname,

see Console ⇒ Statistics ⇒ Show Version.

Figure 7-2  A TELNET Terminal Emulator Window

Connecting to host "octopus" ..... success.

SunOS UNIX (octopus)

login:marina
Password:
Last login: Thu Feb 24 11:39:49 from mar335.ncd.com
SunOS Release 4.1.3. (octopus) #7: Mon Aug 9 12:42:21 PDT 1993
%
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Tip
On hosts that don’t require standard
UNIX login and password security,
your system administrator can set up
your terminal to start a TELNET
connection to the host using the
ncdrunterm  utility. For more
information, see the System
Administrator’s Guide.

This section describes the VT320 terminal emulator

features accessible from an NCD Terminal Emulator

window.

The NCD Terminal Emulator, including command-line

options and resource usage, is described in detail in the

ncdterm man page.

Once you’ve logged into a host as described in

“Connecting to a Host” on page 7-2, the terminal emulator

displays the VT320 terminal emulator window (Figure

7-3).

The NCD Terminal Emulator offers the same features as

traditional terminals plus additional features. Like a

traditional terminal, you can display 24 or 25 lines of text

in 80 or 132 columns, but you can also resize the window

to display fewer or more rows (by changing the height) or

columns (by changing the width).

Some of the terminal emulator features not found on

traditional terminals are described in the following

paragraphs.

Figure 7-3  An NCD Terminal Emulator Window
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Rectangular Cut and Paste
You can select, cut, and paste arbitrary rectangular

sections of text in a terminal emulator window. This is

useful if you want to copy a column of listed information.

1. To start the rectangular selection, press Shift and the

left mouse button. The cursor changes to a plus sign

(+).

2. To extend the selection, press the right mouse button

(without the Shift key). The cursor again changes to a

plus sign in the corner of the selection nearest the

cursor, allowing you to extend the selection.

3. To paste the selection, place the pointer where you

want the text, and press the middle mouse button.

Ask your system administrator if you need to change the

way each line in a rectangular selection ends. The default

method inserts an extra line.

Scroll Bar
Use the scroll bar on the side of the terminal emulator

window to review information that has passed out of

viewing range during your terminal emulator session. The

Motif-style scroll bar is described in Table 3-4 on page

3-13.

Printing Services
To print the contents of the current terminal window to

the default printer, select Print Screen  from the File

menu in the Terminal Emulator window.

 You can change the default printer or select a different

printer for a specific print job.

To change printers:

1. Choose Select Printer... from the File menu. The

Select Printer window appears (Figure 7-4).
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2.

3. Select the printer you want to use.

All printers connected to a parallel port or serial port

are listed. Available remote printers are also listed.

The default printer is the first printer on the list.

4.  Click OK to accept the selected printer. The selected

printer becomes the default printer.

5. To print the contents of the current screen to the

selected printer, select Print Screen  from the File

menu in the Terminal Emulator window.

Menus
Several menus are accessible from the terminal emulator’s

menu bar: File, Options, Fonts, Cursors, and Keys. The

Dialer includes an additional Communications menu.

A solid toggle button indicates that an option is turned on.

An outlined toggle button indicates that an option is

turned off.

The following paragraphs describe the items in each

menu.

Figure 7-4  Select Printer Window

ncdu01.abc.com
ncdu01.abc.com
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File Menu
Table 7-2 summarizes the items in the File menu.

Table 7-2 NCD Terminal Emulator File Menu

Menu Item Action

Redraw Redraws the contents of the display window.

Soft Reset Resets the terminal to the default state.

Hard Reset Does a soft reset, deletes all content, clears all selections.

Close Connection Closes the current session. In addition, for a serial session resets

the serial connection to terminal mode.

Start Debugging Log Writes the contents of the session to a log file. This function

requires special set up to execute correctly. For more

information, see the ncdterm man page.

Select Printer Defines where a job will be printed. Lists available serial,

parallel, and remote printers.

Print Screen Prints the contents of the current Terminal Emulator window.

Print Log Buffer Prints the entire contents of the log buffer (the window contents

you can see by scrolling).

Print Selection Prints the contents of a selection in any terminal emulator

window.

Send Break Breaks the connection. Some modems require this before they

can release the connection.

Exit Ends the session. For the Dialer and Serial terminal emulator

only, this item leaves the connection in its current state.
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Options Menu
The Options menu offers a variety of terminal mode

settings. Table 7-3 summarizes the Options menu modes.

Table 7-3 NCD Terminal Emulator Options Menu

Menu Item Action

Menu Bar Removes the terminal emulator menu bar.

Jump Scroll Enables the terminal emulator to add lines to the screen

quickly.

Reverse Video Reverses the display’s foreground and background

characteristics (for example, if your terminal emulator is

displaying dark characters on a light background, reverse

video displays light characters on a dark background).

Visual Bell Specifies that flashing is used instead of an audible bell.

Auto Wraparound Specifies that the character typed after the cursor reaches the

right border of the page automatically appears on the next

line. By default, autowrap is enabled. If autowrap is disabled,

that character replaces the character at the end of the line.

Reverse Wraparound Allows the cursor to wrap from the leftmost column on the

line to the rightmost column of the previous line, thereby

allowing you to backspace to the previous line.

Auto Linefeed Generates a linefeed automatically. For use with programs that

generate carriage returns without dropping down a line on the

screen.

Application Cursor Mode Generates ANSI escape sequences rather than standard cursor

movements when you use arrow keys.

Application Keypad Mode Generates control functions rather than numeric characters

when you use the keypad.

Local Flow Control Provides quicker response to flow control characters (such as

Control-S). If disabled, flow control characters are passed to

the host.
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Allow 80/132 Switching Permits (by default) or does not permit the application

running in the terminal emulator window to display in the

132-column format as needed.

80/132 Font Switching Permits (by default) or does not permit the application

running in the terminal emulator window to display output in

a condensed font when the 132-column format is in use.

Clear Screen with Blanks Clears the screen by inserting a screenful of blank lines. Saves

the previous display but uses more of the scrolling buffer. If

disabled, clears the screen by erasing what is visible in the

window.

Curses Emulation Emulates a bug in the UNIX curses screen-handling package.

Margin Bell Rings a bell when the cursor reaches the margin.

Strip Parity Strips parity bit from any data sent by the host so that the

terminal emulator looks only at 7-bit bytes. The default is false

for all but the Dialer, which defaults to true.

Grab Keyboard Input Directs all keyboard input to the terminal emulator window.

Prevents another user from intercepting your input.

ISO Latin 1 Font Enables use of the ISO Latin Alphabet supplemental character

set, which includes letters with accents and diacritical marks

required in many European languages.

Blink Cursor Specifies whether the cursor blinks.

Visible Status Line Displays a 25th line at the bottom of the window, used by

applications to display status information.

Log Output To File Logs output to the file opened from the File menu. If no file is

available for output logging, the item is grayed out in the

Options menu.

Table 7-3 NCD Terminal Emulator Options Menu  (Continued)

Menu Item Action
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Fonts Menu
You can use the Fonts menu to change the terminal

emulator’s display font. The choices are:

❏ Default (14 point)

❏ Small (10.5 point)

❏ Large (14 point)

❏ Jumbo (18 point)

The font you choose for a terminal emulator window is

important. It controls the size of the characters you see as

well as whether certain terminal emulation features

appear to work. As a rule, if you do not know which font

to choose, use the default font.

Tip
Changing the font size results in a
resized window, but changing the
window size through the window
manager does not result in a change
of font size.

To change the font size:

1. Click the Fonts menu in the terminal emulator

window.

2. Click the toggle button of the size you prefer. The

window size changes automatically to accommodate

the new font size.

Cursors Menu
You can use the Cursors menu to change the terminal

emulator’s cursor by selecting one of the descriptions in

the menu. The choices are:

❏ Solid Block

❏ Hollow Block

❏ Underline

❏ Bright Underline

❏ Hatched

❏ Bright Hatched

❏ Diagonal Lines

❏ Framed

❏ Invisible
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Keys Menu
You can use the Keys menu to start the Keymap Editor.

The Keymap Editor displays a layout of a keyboard that

has keys labelled with their keycaps and the functions

assigned to them and provides a simple way to change the

assigned functions. For information about using the

Keymap Editor, see the NCDware System Administrator’s
Guide.

Communications Menu
The Communications menu appears only in the Dialer

(used for XRemote) as a convenience in converting the

connection to SLIP mode and in stopping PPP/SLIP.

The Communications menu includes the following list of

items. Select only one at a time.

❏ PPP—Point-to-Point Protocol

❏ SLIP—Serial Line Internet Protocol

❏ XRemote—NCD’s software for connecting a remote

terminal over a serial connection to a host

❏ Serial—regular terminal mode

For more information about using the Dialer and

XRemote, see Chapter 12, Using XRemote.
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8 Using Windows Access

This chapter shows how to use the Windows Access utility to

connect to multi-user Microsoft Windows NT servers and run

Windows applications.

When you connect to a Windows NT server, the server’s

desktop is displayed in a window on the terminal screen. You

can use the icons and other objects on the desktop and run

applications just as you would if you were seated at a PC

running Windows NT 3.51 or 4.0.

Note Your system administrator may have

configured other ways for you to connect to

Windows NT servers.

If you want to know more about connecting to Windows NT

servers, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Connecting to a Windows NT Server
To connect to a Windows NT server or published Windows

application:

1. Open the Windows Access chooser in the Console

(Utilities ⇒ Windows Access). The example chooser in

Figure 8-1 contains two servers and one published

application.

A published application is a Microsoft Windows

application that has been configured to be shared over

the network by multiple users.
 Using Windows Access1



Connecting to a Windows NT Server
Note If there are no entries in the chooser, you must

add at least one before you can use Windows

Access to connect to a Windows NT server; see

“Adding a Connection” on page 8-3.

2. Click the server or application you want, and then click

Connect .

— If you selected a server, the server’s desktop appears
in a window on the terminal.

— If you selected an application, only the application
appears in a window on the terminal.

3. The Windows NT logon dialog box may appear. Enter

your username and password. If necessary, select the

correct NT domain from the drop-down list. Click OK.

4. The Windows Access chooser usually remains on the

terminal screen, and you can connect to additional

servers or applications if desired.

Figure 8-1  The Windows Access Chooser
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Adding a Connection
5. When you’ve finished with a session:

— If you connected to a desktop, close all applications
and log off the Windows NT server.

— If you connected to an application, quitting the
application logs you off.

Adding a Connection
If the Windows Access chooser does not display any servers

or applications, you must add at least one connection before

you can use the chooser to connect to a Windows NT server.

To add a server or published application:

1. Open the Windows Access chooser (Utilities ⇒
Windows Access).

2. Click New. The Windows Access connection properties

dialog box appears (Figure 8-2).

3. Fill in the Description  field with a description of your

choice.

Figure 8-2  Windows Access Properties Dialog Box
 Using Windows Access3



Copying Connections
4. Select ICA/TCP or WinCenter from the Connection Type
drop-down menu.

5. If you selected ICA/TCP  connection type:

a. Select Server  or Published Application .

b. Click the down arrow to display a list of available

servers (or applications) and click on the server you

want.

c. If the server or published application is not listed and

you know its name, you can type the name in the

entry field.

6. If you selected WinCenter  connection type, enter the

name of the Windows NT server in the server entry field.

7. Only the Description  and Server/Published
Applications fields must be filled in, but you can set

other options, if desired. For information about all of the

options, see “Connection Properties” on page 8-5.

8. When you’ve finished configuring the connection, click

OK.

9. The Windows Access chooser appears. Click the

connection you added and then click Connect .

Connections added to the Windows Access chooser also

appear in the Login Chooser the next time you log in.

Copying Connections
You can add a new connection by copying an existing one. To

copy a connection:

1. Click on the connection in the Windows Access chooser

and click Copy. The properties dialog box opens with all

of the properties of the connection filled in.

2. Enter a new description in the Description  field.

3. Edit any other fields you want to change and click OK.
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Editing Connections
Editing Connections
To edit an existing connection:

1. Click on the connection in the Windows Access chooser

and click Properties . The properties dialog box

appears.

2. Make the desired changes in the properties dialog box

and click OK.

3. When the Duplicate Connection dialog box appears,

click Yes.

Edits cannot be undone after you click Yes.

Deleting Connections
To delete an existing connection, click on the connection in the

Windows Access chooser and click Delete .

Deletions cannot be undone after you click Delete .

Connection Properties
Table 8-1 explains all of the options in the Windows Access

properties dialog box. Some options are valid for only one of

the connection types, and some options have different choices,

depending on the connection type.
 Using Windows Access5



Connection Properties
Table 8-1 Windows Access Properties

Field Name Description

Description A description of the connection. Each description must be unique.

Server
or

Hostname

Select Server  if the connection is to a Windows NT server. When

you connect, the server’s desktop appears in a window on the user’s

terminal.

WinCenter: Type the name or IP address of a WinCenter server in the

Hostname  field.

ICA/TCP: Type the name or IP address of a WinCenter, WinFrame, or

MetaFrame server or select a server from the drop-down list of

servers.

Published Application

(ICA/TCP only)

Select Published Application if the connection is to a published

application. When you connect to a published application, you first

log on to the server. Then, a window containing the application

appears on the terminal.

Type the name of a published application or select an application

from the drop-down list of applications.

Connection Type Select a protocol from the drop-down list:

ICA/TCP—connection uses the ICA protocol

WinCenter—connection uses the X protocol and WinCenter

Cache Size (KB)

(ICA/TCP only)

Select a cache size from the drop-down list. This cache is used by

ICA for video display, and a larger cache increases the speed of the

video display. Depending on the number of simultaneous

connections the user may have and the amount of free memory in

the terminal, you may want to increase or decrease the default value

of 2048K. Reduce the cache size if the terminal is running out of

memory.

Network Type

(WinCenter only)

LAN—Use this option for connections to servers on the local

network.

WAN—Use this option for servers outside your building or servers

accessed via a lower-bandwidth connection such as an ISDN line.
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Connection Properties
Window Colors Select the number of colors from the drop-down list:

16 colors

256 colors

High Color (16-bit) (WinCenter only)

True Color (24-bit) (WinCenter only)

Window Size Select a window size or Custom Size from the drop-down list.

For Custom Size, enter a custom window size (in pixels) using the

format widthxheight; do not use spaces.

ICA/TCP: The maximum window size permitted is 1280x1024.

WinCenter: The maximum window size is 1600x1200.

User Name
Password

Your username and password on the Windows NT server. If you

include these values, you don’t have to log on to the server.

Including the password may compromise network security.

For a published application, you log on to the server where the

application resides.

Domain The Windows NT domain in which the password and user name are

valid.

Initial Program The name of an initial program to be started automatically when the

you log on to the NT server. This field does not apply if the

connection is to a published application.

Working Directory The path to your working directory on the NT server. If you specify a

path, applications use the working directory for retrieving and

saving files. This field does not apply if the connection is to a

published application.

Table 8-1 Windows Access Properties  (Continued)

Field Name Description
 Using Windows Access7
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9 Using the Local NCD Window Manager

Note
The usage instructions for the NCD
Window Manager in this section also
apply to the Motif Window Manager,
NCD’s local version of the OSF/Motif
1.2.2 window manager. Differences
between the two window managers
are described as necessary. Where
they are identical, only the NCD
Window Manager is mentioned.

This chapter explains how to use the local NCD Window

Manager, and how to start the host-based OSF/Motif

window manager.

If you are using the OpenWindows window manager,

refer to Chapter 13, Using OpenWindows on NCD

Terminals.

If you want to know more about your particular system

setup, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Introduction
A window manager is an application that allows you to

move, resize, circulate and iconify (minimize) windows.

The local NCD Window Manager is similar in style,

function, and usage to the OSF/Motif window manager

(mwm). NCDware includes a local version of mwm., which

requires a license.

The NCD Window Manager provides unlicensed OPEN

LOOK support and a subset of the standard OSF/Motif

1.2.2 functionality with less memory usage and does not

require a license. To provide these advantages, the NCD

Window Manager modifies or excludes some mwm
features (Table 9-1).
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Running the NCD Window Manager
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The NCD Window Manager runs in either of these ways:

❏ As a host-based application (as conventional window

managers do)

❏ As a local application on the NCD terminal processor

As a local application, NCD Window Manager manages

window activities for other local applications as well as for

host-based applications.

ncdrunwm, the companion program to the NCD Window

Manager, is responsible for starting the applications listed

in NCD Window Manager’s root menu. ncdrunwm executes

on the host processor.

Running the NCD Window Manager
You can start and stop the NCD Window Manager in

several ways, all of which are explained in the following

sections.

The usage instructions for the NCD Window Manager in

the following sections also apply to the Motif Window

Manager, except where noted.

Table 9-1 Differences between the NCD Window Manager and mwm

The NCD Window Manager provides... mwm  provides...

❏ Partial traversal ability via the Alt/Tab

key combination

❏ Full keyboard traversal

❏ A small set of most frequently used

resources

❏ Full Motif resource configurability

❏ Non-modifiable key accelerators ❏ Modifiable key accelerators

❏ International text support (for example,

non-European)
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Running the NCD Window Manager
Starting the NCD Window Manager
Tip
When no window manager is running,
the hierarchy, location, size, and
focus of a window are not changeable.
In addition, all windows are
deiconified, the icon box does not
appear, windows do not have title
bars, and window frames are thin lines
with no built-in tools.

Ideally, your system administrator has set up your startup

files to start the local window manager automatically

when you log in. If the window manager starts

automatically, all window frames are Motif-style.

You can start the NCD Window Manager from the Console

as follows:

1. Click on the Console’s WindowMgr menu button.

2. Click on the NCD Window Manager toggle button (for

Motif Window Manager, use the Motif Window
Manager toggle button). The NCD Window Manager

starts and the characteristic frames appear around all

windows.

Tip
To start the Motif Window Manager
using the commands described here,
use the -mwm  argument.

There are two other methods for starting the NCD

Window Manager:

❏ From a host running the UNIX operating system, in a

terminal emulator window, type ncdrunwm -d
displayname:0 , where displayname is the TCP/IP

address or hostname of the NCD terminal on which

the window manager should be started.

❏ By using remote configuration

If you start the NCD Window Manager from the Console

or by using one of the other methods, the window frames

of the applications that are already running change to

NCD Window Manager frames. Any subsequent

applications you start appear with NCD Window Manager

frames.

Restarting the NCD Window Manager
To restart the NCD Window Manager while it is running,

press the Enter key on the keypad while holding down the

Ctrl and Alt keys. For other methods of restarting the NCD

Window Manager, see your system administrator.
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Running the NCD Window Manager
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Stopping the NCD Window Manager
To stop the NCD Window Manager while it is running,

click on the NCD Window Manager  toggle button in the

Console’s WindowMgr menu. For other methods of

stopping the NCD Window Manager, see your system

administrator.

Starting Applications
To start applications by using the NCD Window Manager,

you can use the root menu. (You can also use the NCD

Terminal Emulator to start applications. See “Starting

Applications” on page 7-6.)

Starting Local Applications—Default Root Menu

Tip
By default, any mouse button displays
the default root menu. Your system
administrator may have customized
your terminal to display other root
menus.

The default root menu contains commands for starting

local applications.

To start applications from the default root menu:

1. Place the pointer anywhere on the root window.

2. Click a mouse button. The menu appears on the root

window and remains there until you select one of the

menu items or click a mouse button on the root

window.

Starting Applications—Customized Root Menu
System administrators can customize root menus to

include commands for connecting to hosts and starting

host-based applications, as well as starting local

applications.

The commands in customized root menus depend on how

your system administrator has configured your terminal

and the network. For example, the root menu may have

commands for contacting network hosts, starting

applications, and logging off. There may be up to three

root menus.
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Running the NCD Window Manager
To start applications from a customized root menu:

1. Place the pointer anywhere on the root window.

2. Click a mouse button. A menu appears on the root

window and remains there until you select an item or

click a mouse button on the root window.

Once you select an item from the root menu or a submenu,

the menu (and submenu, if any) disappears and the

command you selected executes.

The Active Window
When you start an application, the NCD Window Manager

places a new window on top of those already running,

leaving a portion of the lower windows in view. By

default, the active window is the newest window or the

window on top.

The frame of the active window in Figure 9-1 (the window

called anemone) is a different shade from the others.

Active
window

Figure 9-1  Adding Windows
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NCD Window Manager Windows
This section explains how to use the NCD Window

Manager to manage windows.

When the NCD Window Manager is running, each

window is surrounded by an NCD Window Manager

frame (Figure 9-2).

The % symbol inside the window in Figure 9-2 is a UNIX

prompt, an example of output from a process displaying

in the window. When you provide input by typing or

using the mouse in a window, the input appears in the

window, too.

The top bar of the window frame is called the title bar. It

contains a title area in the center, which usually contains

the name of the application or host. In Figure 9-2, the name

of the host, octopus, is in the title area.

Window menu button Title area

Figure 9-2  An NCD Window Manager Window

Maximize
button
Minimize
button

Title bar

Frame
edge

Resize
handle
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Running the NCD Window Manager
Use the tools in the window frame to perform window

manager functions. Tools are shown in Figure 9-2 and

summarized in Table 9-2.

“Using NCD Window Manager Windows” on page 9-10

describes in detail how to use the tools listed in Table 9-2.

An NCD Window Manager frame has four sides and four

corners. The sides and corners are called resize handles.

Each resize handle can be used to change the size of the

window (Figure 9-3). “Using NCD Window Manager

Windows” on page 9-10 describes how to use resize

handles to change window size.

Table 9-2 Window Manager Tools

Tool Action Results

Window menu

button

Click Displays a menu of window operations (Figure 9-4).

Double click Closes the window; in some cases, it stops the

application.

Title bar Click Raises the window above or below other windows.

Drag Moves the window.

Minimize button Click Iconifies the window.

Maximize button Click Enlarges the window to a full screen or restores it to its

original size if it has been enlarged.

Resize handles Drag Changes window size.
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NCD Window Manager Focus Policy—the Active Window
This section describes how to direct mouse and keyboard

input to a window, making it the active window.

The default NCD Window Manager focus policy is click-

to-focus. Click-to-focus means that to make a window

active, you position the pointer on it and click the left

mouse button. If you open a new window, however, the

new window automatically becomes the active window.

You can tell which window is the active window by the

color or shading of the frame. The frame of the active

window is a different shade from the others.

The NCD Window Manager also supports pointer focus

and explicit focus. With pointer focus, the window under

the pointer tip automatically becomes the active window,

regardless of whether you click, even if it is not on the top.

Explicit focus is just like click-to-focus, except that a newly

opened window is not automatically the active window.

For information about changing the default focus policy,

see your system administrator.

Figure 9-3  Resize Handles and Pointer Appearance

Terminal 3
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Running the NCD Window Manager
NCD Window Manager Pointers
The mouse pointer takes on a different appearance,

depending on the operation the NCD Window Manager is

performing, as summarized in Table 9-3.

Table 9-3 NCD Window Manager Pointers

Pointer Name Description

Arrow pointer The usual appearance when the pointer is on a

window.

Root pointer Appears when the pointer is on the root window.

Pressing a mouse button displays the root menu.

Crossed-arrow pointer Appears when a window is being moved.

Resizing arrow (two

views)

Appears when a window’s size is being altered.

Watch pointer Appears when terminal software is connecting to a

host or performing a similar function. Wait for

another pointer to appear before using the mouse.
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Using NCD Window Manager Windows
Note
All descriptions of NCD Window
Manager usage assume that the
default click-to-focus policy is in
effect. If you are using pointer focus or
explicit focus, some of the window
manager features work differently
than described in the following
sections.

The NCD Window Manager provides three ways for you

to use frame and keyboard tools: the Window menu,

keystroke combinations, and the mouse.

If you are an experienced user, you might be more

comfortable using the Window menu or keystroke

combinations described in Table 9-4. If you rely on the

mouse when using applications, you might prefer the

mouse-driven manipulation discussed in the sections

from page 9-12 to page 9-17.

Using the Window Menu or Keystroke Combinations to
Manipulate Windows

The Window menu (Figure 9-4) lists mouse-selectable

action items and equivalent keystroke combinations.

For the equivalent keystrokes to take effect, you must first

click the window or icon that you want to manipulate.

Figure 9-4  Window Menu
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Using NCD Window Manager Windows
Table 9-4 summarizes the items in the Window menu.

Table 9-4 Window Menu Items

Window
Menu Item

Keyboard
Equivalent

Results

Restore Alt + Ctrl + F5 Undoes your last manipulation (moving, resizing, or

deiconifying) of the window.

Move Alt + Ctrl + F7 The window follows the mouse pointer. Click a mouse

button to release the window where you want it.

Size Alt + Ctrl + F8 Move the pointer over the frame border or corner that

you want to adjust.

Move the resizing arrow until the window outline is

the right size.

Click a mouse button to keep the window in its resized

shape or press Escape to abort the action.

Minimize Alt + Ctrl + F9 The window disappears from the screen, and the icon

representing it in the icon box changes from a flat

appearance to three-dimensional.

Maximize Alt + Ctrl + F10 The icon changes to a flat appearance as the window

appears on the screen.

Lower Alt + Ctrl + F3

(Not available with

a 108-key

keyboard.)

The window goes to the lowest position on the root

window, and input is focused to it.

Close Alt + Ctrl + F4 The window and its icon (or the iconified window)

disappear from the screen and the application exits

(unless it is running in another window or icon).

Pack Icons

(for icon

box only)

Shift + Alt + F7 Rearranges the icons in the icon box to remove empty

spaces.
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Using the Mouse to Manipulate Windows
The following sections describe mouse-driven methods of

using the same options listed in the Window menu.

Moving Windows
You can move windows around on the screen using the

mouse and title bar (Table 9-5).

Changing a Window’s Hierarchical Position
You can change the hierarchical position of all windows

except for the root window. The root window always

remains the lowest, the background upon which the NCD

Window Manager displays the others.

The NCD Window Manager allows you to change a

window’s hierarchy by:

❏ Using the mouse (Table 9-6)

❏ Using the Ctrl + Alt keys and mouse (Table 9-7)

Table 9-5 Moving Windows: Use the Mouse and Title Bar

Action Result

1. Place the pointer on the title bar of the window.

2. Press the left mouse button. The pointer becomes a crossed-arrow.

3. Hold down the left mouse button and drag to

where you want the window to appear.

The window outline appears and

moves with the pointer.

4. When the window outline is in the position you

want, release the mouse button.

The outline disappears and the window

appears in its new position.
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Using NCD Window Manager Windows
Changing Window Size
You can change the size of a window using the following

methods. (Also see the next section, “Iconifying Windows

and the Icon Box” on page 9-14.)

❏ Use the mouse and window frame (Table 9-8)

❏ Use the Maximize button (Table 9-9)

Table 9-6 Raising or Lowering a Window: Use the Mouse

Action Result

1. Place the pointer on the window frame of the

window. Do not put the pointer on buttons,

menus, or resize handles.

The window is selected.

2. Click the left mouse button to raise a window,

or click the right mouse button to lower it.

The window goes to the top or bottom

position, and input is focused to it.

Table 9-7 Lowering a Window: Use the Alt Key and Mouse

Action Result

This method changes windows’ hierarchical

position without changing the input focus that

existed before the change.

1. Position the pointer in the window you want

to place beneath the others.

The window is selected.

2. Hold down the Ctrl + Alt keys and click the

right mouse button.

The window goes to the bottom, but input

remains focused where it was before the

position change.
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Iconifying Windows and the Icon Box
An icon is a small representation of a window. You can set

a window manager resource to have icons appear in a

special window called an icon box. When you open a

window, an icon representing it appears in the icon box on

the side of the display screen. Icons of windows that are

visible on the screen appear flat; those representing

iconified windows appear three-dimensional (Figure 9-5).

The process running in a window continues when it is

iconified, but you cannot direct input to an iconified

window.

Table 9-8 Changing Window Size: Use the Window Frame

Action Result

1. Place the pointer on one of the eight resize

handles on the window frame.

The pointer becomes a resizing arrow.

2. Press the left mouse button and drag. A small box appears indicating the total

size of the window. An outline of the

window appears.

3. Release the mouse button when the outline is

the size you want the window to be.

The outline and small box disappear, and

the window size changes to the size you

specified.

Table 9-9 Changing Window Size: Use the Maximize Button

Action Result

1. Click on the Maximize button (Figure 9-5).

The Maximize button is the large button in the

upper right corner of the window frame.

The Maximize button looks indented. The

window expands to its maximum size,

usually the entire display area.

2. Click again on the Maximize button. The window shrinks to its original size.
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The icon box window differs in the following ways from

other NCD Window Manager windows:

❏ As you add and delete icons during a session, spaces

may remain in the icon box where icons have been

deleted. Pack Icons—a Window menu item available

only for the icon box—reshuffles the icons to remove

empty spaces.

❏ The icon box has a scroll bar across the bottom and

along the right side to allow you to scroll through the

icons when there are too many to be seen in the

window at once.

You can iconify windows by

❏ Using the Minimize button (Table 9-10)

❏ Using the Alt key and mouse (Table 9-11)

Figure 9-5  Icons in the Icon Box

Three-
dimensional
appearance
of iconified
window

Flat
appearance
of deiconified
window

Maximize
button

Table 9-10 Iconifying a Window: Using the Minimize Button

Action Result

Click on the Minimize button, the small

button in the upper right corner of the

window frame.

The window disappears, and the icon

representing it in the icon box looks three-

dimensional.
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Deiconifying Windows
The NCD Window Manager allows you to restore an

iconified window to the display screen (deiconify a

window) using the mouse (Table 9-12).

Table 9-11 Iconifying a Window: Using the Alt Key and Mouse

Action Result

1. Place the pointer on the window you want

to iconify.

2. While pressing Alt, click the middle mouse

button.

The window disappears from the screen,

and the icon representing it in the icon box

looks three-dimensional.

Table 9-12 Deiconifying a Window: Using the Mouse

Action Result

1. Place the pointer on the icon you want to

restore to a window.

2. Double click with the left mouse button or

click with the middle mouse button.

The window appears in the same size and

position as before it was iconified.
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Closing Windows and Icons
When you close a window and its icon, you remove it from

the display screen and icon box. If an application is

running in only one window, closing that window also

closes the application. The NCD Window Manager allows

you to close windows using the Window menu button

(Table 9-13).

Customizing the NCD Window Manager
When you become a more experienced user, you may

want to modify the Window Manager’s behavior or the

appearance of its windows. The NCD Window Manager

provides many opportunities for customization via X

resources, which are used for passing default settings to

applications.

For more information about resource settings, see the X

guides cited in the bibliography at the end of this manual.

For information about the resources used by the NCD

Window Manager, see the ncdwm man page.

Table 9-13 Closing Windows: Using the Window Menu Button

Action Result

1. Place the pointer on the dash-shaped

Window menu button of the window

that you want to close.

2. Double click with the left mouse button. The window and its icon disappear from the

screen and the application exits (unless it is

running in another window or icon).
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Using the Host-Based OSF/Motif Window Manager
The OSF/Motif window manager (mwm) provides a

popular user environment developed by the Open

Software Foundation.

NCDware includes a local version of mwm, which provides

standard mwm functionality. The local Motif Window

Manager requires a license.

This section explains how to start the host-based

OSF/Motif window manager and the local Motif window

manager.

The usage instructions in this chapter for the NCD

Window Manager apply to the Motif window managers

as well.

Changing to mwm  from the NCD Window Manager
If your terminal starts up with the NCD Window Manager,

you can change to host-based mwm as follows:

1. In a terminal emulator window, set the DISPLAY
environmental variable. In the following commands,

display is the IP address or hostname of the terminal.

% setenv DISPLAY display:0

(for C shell users)

or
$ DISPLAY= display:0; export DISPLAY

(for Bourne shell users)

2. Invoke mwm as a background process:

% mwm &

Starting the Local Motif Window Manager
To start the local Motif Window Manager, select

WindowMgr ⇒ Motif Window Manager from the

Console.
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10 Using the NCD Mosaic Browser

This chapter explains how to use the NCD Mosaic Browser

to view sites on the World Wide Web (Web) or use your

organization’s intranet. The browser runs on the NCD

terminal, not the host computer.

If you want to know more about your particular system

setup, refer to:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Overview
The NCD Mosaic Browser is based on Version 3.2 of

Spyglass Mosaic. The browser requires a license that you

obtain from NCD.

The browser supports Web browsing, Java applets, and

JavaScript Version 1.1 You can print from the browser to a

local printer attached to your terminal as well as to remote

printers.

Supported File Formats
The NCD Mosaic Browser supports the following file

formats:

❏ HyperText Markup Language (HTML)

❏ Graphics Interchange Format (GIF) and Joint

Photographic Experts Group (JPEG)

❏ Moving Pictures Experts Group (MPEG)
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Video file formats are supported by some NCD models.

See “Using Video on NCD Terminals” on page 11-9 for

more information about video.

Browser Limitations
The browser has the following limitations:

❏ Some of the HTML 3.2 optional tags are not

supported.

❏ The only available helpers are the MPEG video player

and the AU audio player.

❏ Plug-ins are not supported.

❏ If you log out from the Console menu, files are not

updated.

❏ For full browser functionality, you should use

Network File Service (NFS) for file access.

❏ If you use Trivial File Transfer Protocol (TFTP), the

following features are not available:

— You cannot view HTML source files.

— The browser cannot download a file and pass the

entire file to the helper applications (the audio

and MPEG players).

— The Save As and Open Local menu items cannot

list either files in a directory or directories in a

directory. As a result, you cannot navigate

through a directory tree by clicking on directory

names.

— You cannot use helper applications because TFTP

cannot create the temporary files they need.

— The browser cannot read or write to preference

files unless the files already exist and are world-

readable and writable.

— Background audio is not supported.

❏ The NCD Mosaic Browser does not support 16-bit

color depth. You can use 8-bit or 24-bit color only. For

more information about color depth support, see the

NCDware System Administrator’s Guide.
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Internet Terminology
If you are new to browsing the Internet, it might help to

understand the following terms.

Internet—the collection of networks and gateways that use

the TCP/IP protocol family and function as a single

cooperative network, connecting many businesses,

universities, and government facilities.

Protocol—a set of rules for transferring data over a

network.

Internet Protocol (IP)—a protocol used to route files in an

Internet environment.

Web—a global network of interconnected documents or

files.

Hypertext Markup Language (HTML)—the language used

to write Web documents.

Hypertext link—a connection between one piece of

information on the Web and another. The browser

displays a document when you click its hypertext link.

Uniform resource locator (URL)—a unique address for each

Web document or site. For example, the URL for the NCD

Web site is

http://www.ncd.com/contact.html

where:

http:// indicates the protocol used to transfer the file. In this

example, the protocol is hypertext transfer protocol. Other

protocols include File Transfer Protocol (FTP), Simple Mail

Transport Protocol (SMTP), and gopher.

www.ncd.com is the name of the Web server where the file

is stored.

contact.html is the name of a file.
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Starting the NCD Mosaic Browser
The NCD Mosaic Browser runs on the terminal’s

processor. You can start the browser through the

Console’s Utilities ⇒ Start NCD Mosaic Browser item.

The NCD Mosaic Browser Document Window
The NCD Mosaic Browser document window provides

access to the browser toolbar, menu bar, and other

browser elements (Figure 10-1). See Table 10-1 for

descriptions of the document window elements.

Figure 10-1  NCD Mosaic Browser Main Document Window
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Table 10-1 lists the elements in the NCD Mosaic Browser

Main Document Window.

Customizing the NCD Mosaic Browser
This section explains how you can customize the browser

display and set system preferences. For more information

about setting preferences in the browser, see the NCDware
System Administrator’s Guide.

To display the Preferences window (Figure 10-2) and set

preferences:

1. From the NCD Mosaic Browser’s Main Document

Window, select Edit ⇒ User Preferences.

2. Click buttons at the top of the window to select types

of preferences to set.

Table 10-1 NCD Mosaic Browser Document Window Elements

Element Description

Title bar Displays the title of the currently loaded document.

Menu bar Contains menu buttons.

Menu button A menu name (such as File, Edit, Navigate, Window, and Help)

that appears on a menu bar.

Toolbar Displays icons in the toolbar. Place the pointer on a button to

display a description of its function in the status message area.

Backward and

forward buttons

Returns you to a previous document or to the document first

displayed.

URL field Displays the URL of the current document.

Status message area Displays messages while a document is loading. Also displays

information about a window element such as a menu button or

hypertext link when the mouse is placed on the item.
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3. When you finish setting preferences, click OK.

4. Your changes are applied to the browser.

Normally, the browser also saves any preferences that you

specify in the .nmosaic-prefs file in your home directory. If

your system administrator has set your configuration so

you cannot modify this file, you can set preferences for the

current session only. When you end your browser session,

the preference selections revert to those specified by the

system administrator.

Customizing the NCD Mosaic Browser Display
You can select preferences to customize the appearance of

your browser display. The preferences that you can

specify are:

❏ Language—Click the Miscellaneous category in the

Preferences window to select a language.

❏ Fonts—Click the Fonts  category in the Preferences

window to modify font preferences.

Figure 10-2  The Preferences Window

Select a category of
preferences to set
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Table 10-2 explains the fonts you can specify.

❏ Color—Click Colors  in the Preferences window to

modify color preferences.

Table 10-3 explains the color elements you can

specify.

Setting System Preferences
You can specify the following system preferences:

❏ Load Images Automatically

❏ Enable Java

❏ Enable JSCRIPT

To specify a system preference, click Miscellaneous  in

the Preferences window (Figure 10-2).

Loading Images Automatically
Loading documents without images improves browser

performance. Images that are not loaded are shown by text

enclosed in a box. After loading a document, you can load

one or all of the missing images.

Table 10-2 Browser Font Preferences

Element Description

Normal text font Font used for most text

Header font Font used for headings

Monospace text font Font used for fixed-width text

Table 10-3 Browser Color Preferences

Element Description

Text color Color of normal text

Background color Color of document window

background

Link color Color of hypertext links

Visited link color Color of recently visited

hypertext links
Using the NCD Mosaic Browser 10-7



Opening a Web Document

Usin
Unless modified by your system administrator, the Load
Images Automatically  option is enabled. To prevent

automatic image loading, click the Load Images
Automatically  option to diable it.

Enabling Java

Tip
If you encounter a Java applet in a
Web document that causes problems,
you may want to disable Java to
bypass the problem.

The NCD Mosaic Browser automatically runs any Java

applets encountered in Web documents. Use the Enable
Java option to control whether applets are executed

when you load a Web document.

Unless modified by your system administrator, the

Enable Java option is enabled. To prevent running Java

applets, click the Enable Java  to disable it.

Enabling JavaScript
JavaScript (or JSCRIPT) is a language developed by

Netscape for creating dynamic Web pages. It is not the

same as Java, although some of its capabilities are similar.

Use Enable JSCRIPT  to control whether JavaScript

routines are executed when a Web document is loaded.

Unless modified by your system administrator, the

Enable JSCRIPT option is enabled. To prevent executing

JavaScript routines, click the Enable JSCRIPT  option to

disable it.

Opening a Web Document
You can open a Web document using any of the methods

described in the following sections.

❏ Entering a URL

❏ Selecting a Document from the Hotlist

❏ Selecting a Document from the History List
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Entering a URL
Tip
You can enter a URL directly in the
URL field in the Main Document
Window (Figure 10-1).

To open a Web document using a URL, follow these steps:

1. From the NCD Mosaic Browser’s Main Document

Window, select File ⇒ Open URL... or click the Open
URL button on the toolbar.

2. Type the URL of the document you want to open.

URLs are case sensitive and must not begin with a

space.

3. Click OK.

Selecting a Document from the Hotlist
The hotlist is a list that you create containing the titles and

URLs of frequently accessed documents. Refer to

“Creating a Hotlist” on page 10-10 for information on

adding document URLs to your hotlist.

To open a Web document from your hotlist, follow these

steps:

1. From the NCD Mosaic Browser’s main document

window, select Navigate ⇒ Hotlist.

2. Double click the document you want to open, or

select it and click Go To .

Selecting a Document from the History List
The history list contains the titles and URLs of recently

opened Web documents. The NCD Mosaic Browser

automatically creates your history list.

To open a Web document from your history list, follow

these steps:

1. From the NCD Mosaic Browser’s Main Document

window, select Navigate ⇒ History.

2. Double click the document you want to open, or

select it and click Go To .
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Creating a Hotlist
Tip
You can add a Web document URL to
your hotlist by clicking on the Add
Current to Hotlist button on the
toolbar.

With the NCD Mosaic Browser, you can create a hotlist to

save the URL of a Web document so that you can access the

document at a later time. The NCD Mosaic Browser saves

only the document’s title and URL in the hotlist.

To add a Web document to your hotlist, follow these steps:

1. Open the document.

2. From the NCD Mosaic Browser’s Main Document

window, select Navigate ⇒ Add Current to Hotlist.

To remove a Web document from your hotlist, follow

these steps:

1. From the NCD Mosaic Browser’s Main Document

window, select Navigate ⇒ Hotlist.

2. Select the document title that you want to remove

and click the Delete  button.

To save your hotlist as an HTML file, follow these steps:

1. From the NCD Mosaic Browser’s Main Document

Window, select Navigate ⇒ Hotlist.

2. Click the Export  button.

3. Enter the name that you want to give to your hotlist.

Be sure to use .html or .htm as the filename extension.
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Searching a Web Document
You can search a Web document for a specific word or

phrase. To search a document, follow these steps:

1. From the NCD Mosaic Browser’s Main Document

window, select Edit ⇒ Find or click the Find  button

on the toolbar.

2. Type the word or phrase that you want to find in the

Text to Find field.

To find text with specific capitalization, click the

Match Case  check box. To start searching from the

top of the document, click the Start From Top check

box.

3. Click OK.

The browser highlights text that is found.

4. To find the next occurrence, select Edit ⇒ Find Again

or click the Find Again  button on the toolbar.

Saving a Web Document
You can save a Web document retrieved by the NCD

Mosaic Browser. You must save text and graphics

separately.

To save a text document, follow these steps:

1. From the NCD Mosaic Browser’s main document

window, select File ⇒ Save As... or click the Save As
button on the toolbar.

2. Enter the name that you want to give the document.

3. Select a file format. The formats available depend on

the type of file you are saving.

4. Click OK.

To save a graphic, press and hold the right mouse button

over the image. From the popup menu, click Download
Image to Disk .
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Printing a Web Document
You can print Web documents on a local printer attached

to the terminal, or on remote printers if your system

administrator makes remote printers available to you.

Remote printing uses the LPD protocol, and the terminal

always sends a Postscript data stream. Note that local

printing may be slow and remote printing uses terminal

memory.

To print a Web document:

1. From the NCD Mosaic Browser’s Main Document

Window, select File ⇒ Print.... The Print Setup

window appears.

2. Click Printers . Select a printer from the list

displayed in the Printers popup window. Printers are

placed in this list by the system administrator.

3. Specify whether you want to print the entire

document (default) or a range of pages, and the

number of copies to be printed (default is 1 copy).

4. Click OK.

Figure 10-3  NCD Mosaic Browser Print Setup Window
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11 Using NCD Utilities

This chapter explains how to use NCDware utilities for:

❏ Running and printing Java applets

❏ Using files stored on local file systems (on a PC card

or a floppy disk)

❏ Playing videos (Explora 700 and HMX terminals

only)

The following utilities are described elsewhere in this

manual:

❏ The NCD Mosaic Browser is described in Chapter 10.

❏ The Windows Access chooser is described in

Chapter 8.

❏ The other utilities in the Console’s Utilities menu are

described in Chapter 5.

The Utilities Menu
The Console’s Utilities menu (Figure 11-1) provides access

to some of the utilities described in this chapter. Other

utilities are started from the command line or from other

Console menus.

Note Explora 700 and HMX terminals have an

additional item in the Utilities menu for

starting the Video Player.
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Running Java Applets
This section describes how to start Java applets from

NCDware and how to print Java applets. A Java applet is a

small Java application that can be embedded in another

application, such as an applet viewer or Web document.

Starting Java Applets
With the Java applets utility, called Start Java Applet, you

can start applets that reside on the local network or the

World Wide Web (Web). Although the Java utility allows

you to run an applet that is embedded in a Web document,

the utility does not display any of the surrounding HTML

text.

You start the Java applets utility from the Console’s

Utilities menu (Utilities ⇒ Start Java Applet). Enter the

applet’s Uniform Resource Locator (URL), then click OK.

Printing from Java Applets or Applications
After you start an applet, you can print it to local printer (a

printer attached to the terminal), remote printer, or file. If

you are using Java applications other than Start Java

Applet, you may be able to print from those applications

as well.

Figure 11-1  The Utilities Menu
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When you select Print from a Java application, the

following Print Dialog box appears (Figure 11-2).

Printing to a Local or Remote Printer

Note The Print Command Options  field in the

Print Dialog box is grayed out when you print

to a printer.

To print to a printer:

1. Type the number of copies you want to print in the

Copies  field.

This option is only available if you print to a remote

printer. You cannot print multiple copies when you

print to local printers.

2. Select Printer , then type the printer name in the

Printer field. You may need to get the printer name

from your system administrator.

Figure 11-2  Printing from a Java Application
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The default printer name, PARALLEL1, sends the print

job to a printer attached to the terminal’s parallel

port.

You may have a different default printer, such as a

remote printer.

3. Type a banner page title in the Banner Page Title
field. This title is used on the banner page of the

remote print server.

Banner pages are only available on remote printers.

They are not available for local printers.

4. Select the paper size.

5. Select the orientation.

6. Click Print .

Printing to a File

Note The following fields in the Print Dialog box are

grayed out when you print to a file: Copies ,

Banner Page Title , and Print Command
Options .

When you print to a file, the resulting file contains

PostScript data. To print to a Postscript file:

1. Select File ; then type the file name to which the

print job is to be saved. You must type an absolute

file name, starting at the root file system.

For example, for a user “george,” with a home

directory of /usr/george and a file called printout.ps in

the home directory, the correct entry would be

/usr/george/printout.ps.

2. You do not need to select paper size or page

orientation when you print to a file.

3. Click Print .
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Using a Local File System
This section tells how to access and manage a file system

on either a PC card installed in your terminal or a floppy

disk in a drive attached to your terminal.

Sometimes, PC cards are also used to boot terminals, either

on a local area network or with XRemote. For more

information about PC card booting, see the NCDware
System Administrator’s Guide.

Tip
Besides the commands described in
this section, you can also use the
hostside ncdfloppy  utility for
accessing and managing the file
system on a floppy disk. For more
information, see Appendix C.

You can use a floppy disk drive attached to your terminal

to copy files between the UNIX system and DOS-

compatible 720K or 1.44M floppy disks.

Note If your file systems are on floppy disks, the

terminal must be configured to use the Local

File Manager. Ask your system administrator

to enable floppy file system use, or see the

NCDware System Administrator’s Guide.

The Local File System Interface
The NCDware interface to a PC card or floppy drive is a

hierarchical local file system. On a PC card, you specify

the local file system using /local. On a floppy disk, you

specify the local file system using /xfloppy.

Managing Files on a Local File System
The Local File Manager is a utility for managing a local file

system, and includes commands for:

❏ Formatting and verifying the local file system

❏ Making and removing directories, changing the

current working directory, and listing directory

content recursively

❏ Copying, deleting, listing, renaming, and comparing

files

❏ Displaying information about the local file system

and the current directory
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❏ Listing Local File Manager commands

Starting the Local File Manager
Ask your system administrator whether you need a

password to start the Local File Manager.

Tip
You can also access a remote
terminal’s local file system. Type the
hostname or IP address of the remote
terminal and the port number (default
is 5996). When requested, type the
password for the remote terminal’s
Local File Manager.

To start the Local File Manager:

1. From the Console, select Terminals ⇒ New Terminal

to start a Terminal Host Chooser.

2. Select File  from the Terminal Host Chooser.

Alternatively, you can type the hostname or IP

address of the terminal, followed by the port number,

in the Service field. The default port number is 5996.

3. Click OK or press Return.

4. If a password is required, the Local File Manager

password prompt appears:

Trying 192.43.116.50 . . .
Connected to ncdu7.
Escape character is ‘^]’.
***NCD Local File Manager ***
Password:

Tip
If the Local File Manager disconnects
instead of displaying a prompt (>),
make sure that a password has been
defined and that you know the correct
password. For more information about
the File Manager password, see your
system administrator or the NCDware
System Administrator’s Guide.

Type the Local File Manager password and press

Return.

5. The Local File Manager starts immediately, and

displays the following. You can enter Local File

Manager commands at the > prompt.

Connecting to the host “filed_telnet”
...... success
***NCD X Terminal Local File Manager***
>

6. To issue a Local File Manager command, type the

command (Table 11-1) at the prompt and press

Return.
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Local File Manager Commands
Table 11-1 lists and describes Local File Manager

commands. The Local File Manager does not recognize

wildcard characters.

Table 11-1 Local File Manager Command Summary

Command Description

cd directory Changes the current working directory to directory.

compare file1 file2 or

cmp file1 file2
Compares the contents of two files and displays a message stating

whether the files are equivalent.

copy sourcefile destfile
or

cp sourcefile destfile

Copies sourcefile to destfile. Copying files may take a long time

and affect response time while it is going on.

Before you can copy files to the local file system from a remote file

system:

❏ On a PC card, if you have deleted files from the local file

system recently, use the reclaim command to ensure that all

available space is accessible.

❏ Make sure that the terminal’s file service table 1 includes an

entry for the remote location.

Before you can copy files from the local file system to a remote file

system:

❏ If you are using TFTP 2 to copy files from the local file system

to a remote location, an empty file must exist on the remote file

system.

❏ Write access must be enabled for the file on the remote file

system.

❏ The terminal’s file service table 1 must include an entry for the

remote location.

cwd or pwd Displays the current working directory.

delete file(s), del file(s),
remove file(s), or rm
file(s)

Deletes files from the local file system. On a PC card, after using

the delete command, use the reclaim command to re-pack

previously used file space for subsequent use.
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1 The file service table is an internal table used by the terminal for all file access when the X server is

running. For more information, see your system administrator or the NCDware System Administrator’s
Guide.

2 TFTP (Trivial File Transfer Protocol) is one of the file transfer protocols used by the terminal for file

access. The other protocol for file transfer is NFS (Network File System).

format [filesystem]

The optional arguments
-q and -720 are for use
with a floppy drive only.

Formats (creates) a local file system. The variable filesystem must

be either /local or /xfloppy. The default is /local. Formatting a file
system destroys any data that is already on the PC card or floppy.
On a floppy drive, the -q option creates a file system faster, but

should be used only if the disk has already been completely

formatted and you are sure that it contains no bad sectors.

The -720 option formats a 720K floppy disk.

On a PC card, formatting requires about two minutes per

megabyte.

help Displays a list of Local File Manager commands.

info or df [filesystem] Lists the total size in bytes of the local file system and the total

number of free bytes available.

list [directory], ls
[directory], or dir [-R]

[directory]

Displays a list of the files stored in the local file system. The -R
option lists subdirectory contents recursively.

mkdir dir_name Makes a directory in the local file system.

quit Disconnects from the Local File Manager.

reclaim
(PC card use only.)

Reclaims previously used file system space. This command may

take several minutes, so use it after you have finished other

operations on the local file system.

rename file1 file2 Changes the name of a file from file1 to file2 without altering its

contents.

rmdir dir_name Removes a directory from the local file system.

verify
(PC card use only.)

Confirms that the local file system structure is valid.

Table 11-1 Local File Manager Command Summary (Continued)

Command Description
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Using Video on NCD Terminals
The NCD Video Player decodes, displays, and controls

MPEG-1 video data.

Video support is available on the Explora 700 and the

HMX family of terminals.

Preparing to Play a Video
Before playing a video, you must:

❏ Make sure your video input file is in a format that the

video software can read

❏ Specify the video decoder you want to use

❏ Specify how to deliver the video input data

This section explains format requirements, decoder

options, and video data delivery methods.

Video Format
NCD’s video software reads MPEG-1 format video files.

Decoder Selection

Note
The Berkeley decoder is adapted from
code that is copyright 1992 by the
Regents of the University of
California.

NCD video software includes either the CompCore fast

MPEG decoder, which requires a license that you must

obtain from NCD, or the Berkeley decoder, which does not

require a license, but is slower than the CompCore

decoder and does not decode audio.

The Berkeley decoder is used by default.

To specify that you want to use the CompCore decoder

instead:

❏ Make sure that the license requirement has been

fulfilled (ask your system administrator or see the

NCDware System Administrator’s Guide).

❏ In the Console, select Change Setup Parameters ⇒
Video ⇒ Video ⇒ Fast MPEG decoder (requires a

license).
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Note The fast MPEG decoder plays video at the

correct speeds; the Berkeley decoder does not.

Data Delivery
You can transfer video data to the Video Player using NFS,

TFTP, the hostside program ncdsendvideo(1), or the

Starlight Networks’ StarWorks data server running on a

network host.

Tip
By default, NCD terminals use TFTP
for file transfer. Contact your system
administrator if you need to use NFS
instead.

NCD recommends using NFS rather than TFTP to transfer

video files. Video clips played using TFTP play straight

through from beginning to end; the Video Player’s pause,

seek, and single step controls are disabled. Performance

and synchronization using TFTP are also poor compared

to when using NFS transport.

The ncdsendvideo command reads a video file on the host,

starts the Video Player on the terminal, and then sends

video data to the terminal. ncdsendvideo is especially useful

for sending video clips to the terminal from applications

such as Netscape. (See “Starting the Video Player from a

Host” on page 11-15.)

The Video Player can receive video data from the Starlight

Networks’ StarWorks video data server running on a

network host. The StarWorks host must be on the same

subnet as your terminal. StarWorks software must be

purchased from a StarWorks vendor and must be installed

and configured as described in the StarWorks

documentation. NCDware’s StarWorks software support

requires a license for use.

Playing a Video
Tip
To play MPEG interleaved audio and
video streams, you have to use the
CompCore video fast MPEG decoder.
The default decoder does not play
MPEG interleaved audio and video
streams.

There are several ways to display videos on a terminal:

❏ From a terminal using the Console’s Utilities ⇒
Video Player item

❏ From a terminal using a remote shell command with

vp or video

❏ From a host using the hostside ncdsendvideo utility
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❏ From a host using StarWorks software (requires a

license on the terminal and purchase and installation

of StarWorks software).

Using the Console
To start the Video Player from the Console:

1. Select Utilities ⇒ Video Player.

2. From the Video Player, select File ⇒ Open File...

3. The Video Player dialog box appears; type the name

of the video input file you want to play in the text

entry space.

4. Click OK to start the video.

The Video Player window appears on the terminal,

its image size defined in the video file. The video

starts playing.

5. To play the video, click the Play  button (Figure 11-3

on page 11-16).

Using Remote Shell Commands
When you start the Video Player using a remote shell

command, you can use either the vp command to start the

Video Player interface or the video command to run the

decoding software without the Video Player interface.

Using the vp (1) Command

Tip
You can also use the remsh  remote
shell command.

To use the vp (1) command to run the Video Player, use the

command-line syntax:

rsh hostname vp  [ - options] [ videofilename]

where:

hostname Is the name or IP address of the terminal

where vp is running.

options Are options to the vp command. Table

11-2 lists frequently used options; see the

vp(1) man page for more options.
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To play the video, click the Play  button (Figure 11-3 on

page 11-16).

Table 11-2 lists the command-line options for the vp
command. You can use X resources to set most these

options; see the vp(1) man page.

videofilename Is the name of the video file (optional). If

you supply a name, the Video Player

starts immediately and pauses at frame 1

in the video file. Otherwise, a dialog box

appears and you must enter the name of

the video and click the OK button.

Table 11-2 vp (1) Command-Line Options

Option Action, Values, and Default

-display display Specifies the name (host name or IP address) of the terminal

running the Video Player. For the vp command, the default

display is the terminal on which you started the terminal

emulator used for issuing the vp command.

-dither dither_alg Specifies the dithering algorithm. The default for color monitors

is “ordered2.” The default for grayscale monitors is “gray.”

-dxhost hostname Specifies the decoder host to which the Video Player should

connect. The default is the current display.

-geometry geometry Specifies the location and size of the Video Player window. The

default depends on the terminal. Specify -geometry  using the

standard geometry string (widthxheight+/-xoff+/-yoff).

-hifi Enables high fidelity decoding of the audio portion of the video.

NCD does not recommend use of this option because it

significantly slows the MPEG decoding.

-loop Replays the video when it reaches the end (loop mode). The

default is to stop at the end of the video (one-time through).

-mute Turns off the sound.
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Using the video  (1) Command

Tip
You can also use the remsh  remote
shell command.

The video command displays the video without displaying

the Video Player user interface. The command-line syntax

is:

rsh hostname video  [ - options]

where:

-name name Specifies the class name that vp uses to find X resources. The

default is videoPlayer. (See the vp (1) man page for more

information about X resources.)

-play Starts the Video Player in play mode instead of paused at

frame 1, which is the default.

-playonce Starts the Video Player in play mode and exits at the end of the

video clip.

-starfilter pattern Specifies the StarWorks filter to use in the Video Player browser.

The default is *.*.

-starvolume vol_name Specifies the StarWorks volume to use in the Video Player

browser. No default.

-separateVideoWindow Specifies that the decoded video should be in a separate window

from the Video Player. This is required when running the Video

Player and decoder on different displays.

-title title Specifies the title of the video application window. The default is

Video.

-vol level Sets the volume level in a range of 0 to 255. The default is 100.

Table 11-2 vp (1) Command-Line Options (Continued)

Option Action, Values, and Default

hostname Is the name or IP address of the terminal

where video is running.

options Table 11-3 lists frequently used options of

video. A complete list of options is included

in the video (1) man page.
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For example:

%rsh hawk video -file speaker.mpg -play <CR>

If you do not specify a video data file using either the -file
or -star option, no video plays.

One video process at a time can run on a terminal.

Table 11-3 lists the command-line options for the video
command. The Video Player does not support X resources.

Table 11-3 Command-Line Options for the video  Command

Option Action, Values, and Default

-title title Specifies the title for the application window. The default is

“NCDvideo.”

-icon_title icon_title Specifies the icon title for the application window. The default is

“video.”

-dither dither_alg Specifies the dithering algorithm used. The default is “color8” for

8-bit color default visuals, “gray8” for 8-bit grayscale default

visuals, and “color24” for 24-bit true-color default visuals. An

additional dithering mode, “2x2color8,” gives double-size 8-bit

color images.

-play Start in play mode. By default, the video starts paused at the first

frame.

-exit_on_end Exit at the end of the video clip. By default the video pauses at the

end.

-loop Replays the video when it reaches the end (loop mode). By default

the video pauses at the end.

-vol volume Sets the volume for audio playback, in the range of 0 (mute) to 255

(full volume). The default is 128.

-star starlight_movie Specifies the name of a StarWorks movie to play, in the format

volume:movie:0. The 0 represents track; always specify the track

field as 0. No default.
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Starting the Video Player from a Host

Tip
The Video Player does not support X
resources.

To start the Video Player from a host, use the

ncdsendvideo(1) command.

The command-line syntax of ncdsendvideo is:

ncdsendvideo  [ -h hostname][ videofilename][-- - vp_options]

For example, the following command uses ncdsendvideo to

start a Video Player entitled “Demonstration Video”:

            % ncdsendvideo demovideo.mpg -- -title "Demonstration Video"

The optional hostname parameter (-h hostname) specifies

the name of the terminal on which the Video Player

should run. If you do not use this parameter, make sure

that you have set the DISPLAY variable. The command

runs on the terminal named in the DISPLAY variable. For

information about setting the DISPLAY variable, see

“Starting Applications” on page 7-6.

If you do not specify videofilename, ncdsendvideo uses

standard input (stdin) for input.

You can use the vp command options listed in Table 11-2

on page 11-12 with the ncdsendvideo command by typing

two additional dashes (--) before the options, then typing

the vp command options. ncdsendvideo sends all options

listed after -- to vp.

-file movie Specifies the name of a movie to play. The directory containing the

movie must be accessible through the file service table (Setup ⇒
Change Setup Parameters ⇒ File Service ⇒ File Service Table). No

default.

-hifi Decodes the audio track using hifi, which degrades playback

performance. By default, the audio is decoded in “low” fidelity.

-install Installs the colormap; the default is to request that the window

manager install the colormap.

-mute Sets the volume to 0 (mute). By default, volume is 128.

Table 11-3 Command-Line Options (Continued)for the video  Command

Option Action, Values, and Default
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Using StarWorks
These instructions for using Starlight Networks’

StarWorks for delivering video data to the NCD terminal

assume that StarWorks has been installed, configured, and

enabled on a host on the same subnet as your terminal. If

this is not the case, see your system administrator or the

StarWorks documentation.

To use StarWorks from the Video Player:

1. Specify the StarWorks volume file using Setup ⇒
Change Setup Parameters ⇒ Video ⇒ StarWorks

volume file.

The StarWorks volume file lists StarWorks volume

names and the associated hardware locations. The

default volume file is /usr/lib/X11/ncd/volumes.sw.

2. Start the Video Player as described in “Using the

Console” on page 11-11 or “Starting the Video Player

from a Host” on page 11-15.

3. From Video Player, select File ⇒ Open StarWorks to

display the New StarWorks Video  dialog box

(Figure 11-3).

4. Select or enter a StarWorks volume name.

The StarWorks volume name is 15 or fewer

characters identifying the StarWorks volume, which

The number of tracks
in the movie

The size of the
movie clip in bytes

The type of volume name: “mov”
for movie clip; “dir” for directory;
or “vol” for volume

Figure 11-3  New StarWorks Video Dialog Box
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is a data object used in the StarWorks user interface

to provide access to movies. For more information,

see your StarWorks documentation.

5. Enter a list filter to qualify the files you want to

display.

6. Select a movie from the list that appears in the dialog

box. You can either double click it or click once and

then click OK.

7. The Video Player starts. To play the video, click the

Play button.

Controlling the Video Player
Use the VCR-like controls below the video display area to

control the Video Player’s display (Figure 11-3).

Pulldown the File menu

❏ Select Open File to display a
dialog box for selecting a new
video.

❏ Select Open StarWorks to
display a dialog box for selecting
a video from the StarWorks
video server.

❏ Select Quit to exit. Drag on slider to look
randomly through the
video clip.

Step forward
frame-by-frame

Pause

Changes between continuous
playing (loop mode) and one-
time-through (non-loop mode).

Fast forward
Fast back

Reports the number
of frames elapsed
from the beginning.

Reports the video time
(time stamp included in
the video file).

Reports whether the
video is paused ( || )
or playing (>).

Click the toggle to display
the Settings hide box (see
Figure 11-4).

Start playing

Figure 11-3 Basic Video Player Controls
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The Settings toggle displays additional configuration and

information items, as in Figure 11-4.

Click to display audio
controls.

Click to turn volume to 0;
click again to enable
volume adjustment.

Adjust volume

Click to display information obtained
from the video clip, including the
dither style, size in pixels, frame rate
in frames per second, bit rate in bits
per second, whether audio is present,
audio encoding frequency, and audio
encoding bit rate.

Figure 11-4 The Video Player’s Settings Hide Box
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NCD’s XRemote software allows you to use NCD terminals

in remote locations. Once logged in, you can run X

applications just as if you were on a local network.

This chapter explains:

❏ How to set up and use XRemote at a remote location

over a serial line, for example, from a branch office.

❏ How to use XRemote at a central workplace over a

direct serial connection or on an Ethernet or Token-

Ring network.

For more information about XRemote, refer to these

sources:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

XRemote and Related Software and Hardware
XRemote can run on terminals connected to a host on a

serial line (either using a modem or a direct connection)

and on terminals connected to an Ethernet or Token-Ring

LAN (Local Area Network). A complete XRemote system

is illustrated in Figure 12-1.
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XRemote software consists of two parts:

❏ The XRemote module in the X server (on a PC card or

downloaded if you are using XRemote with TCP/IP

protocols) is responsible for managing local

processes and handling communications with the

host over a serial connection.

❏ The host-resident helper program (called Xremote) is

provided on the NCDware distribution media. The

helper process allows the terminal to communicate

with other hosts (including other terminals) on the

network.

Printer

X server

Modem

Modem

RS-232 C
cable

Host with XRemote
helper program

Ethernet
(or Token-Ring)

HostPrinter

Figure 12-1  A Local Area Network With XRemote

RS-232 C
cable

Terminal
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Before Running XRemote
Before you can run XRemote, your system administrator

must perform the following tasks and provide the

following information. The tasks are explained in the

NCDware System Administrator’s Guide.

❏ Provide an X server (on a PC card if you are using

XRemote over a serial line)

❏ Verify that you have an XRemote license

❏ If you are using XRemote through a modem:

— Provide a modem with cables and a modem

user’s manual

— Configure the host computer’s modem

— Provide the host computer’s phone number

❏ Make sure the host is prepared for XRemote use

❏ Make sure your font path is set up to provide fonts

for the applications you need to run

❏ If you are using PPP or SLIP:

— Provide you with the address or name of the

host on which you should start XRemote

— Provide you with the command for starting PPP

or SLIP

❏ Configure your terminal’s serial port or provide you

with directions for configuring the terminal

In addition to the tasks listed above, using XRemote is

more convenient if the system administrator does the

following tasks. These tasks are described in the NCDware
System Administrator’s Guide.

❏ Configure your modem and terminal. If you need to

do the configuration yourself, there are directions in

this chapter.

❏ Revise your PATH environment variable to include

the directory for the xinitremote and XRemote
programs.
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❏ Add an XRemote startup file to your home directory

to start applications automatically.

❏ Make sure your font path provides access to all the

necessary fonts.

❏ Tells you how to end your XRemote session easily.

Accessing the Terminal’s Console Window
The Console window provides access to utilities used in

procedures described in this chapter.

Press the Setup key to display the Console. If your NCD

keyboard does not have a Setup key, see Table 5-1 on page

5-2 for equivalent key combinations.

Using XRemote—Serial Connection Using a Modem
This section provides the procedures for configuring,

starting, and ending a serial XRemote session over a

modem.

Your system administrator may set up XRemote to

connect in a different way than is described here. Ask your

system administrator if you need help connecting over

XRemote.

Before you Start XRemote
The following section describes equipment you need and

tasks that you should perform before starting an XRemote

session.

Deciding Which Protocol to Use
You can run XRemote over a modem in two ways:

❏ Using PPP (Point-to-Point Protocol) or SLIP (Serial

Line Interface Protocol) over a serial connection. If

you are using this method, follow the procedures in

“Using XRemote Over a Modem with PPP or SLIP

Protocol” on page 12-7.
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See the NCDware System Administrator’s Guide for a

comparison of the XRemote, PPP, and SLIP protocols.

❏ Using the XRemote proprietary protocol over a serial

connection. If you are using this method, follow the

procedures in “Using XRemote Over a Modem with

the Proprietary XRemote Protocol” on page 12-11.

Ask your system administrator which way to run

XRemote.

Connecting a Modem to the Terminal
To run XRemote from a remote site, you need a modem

and a serial cable.

Suitable Modems
Some modems are better suited for use with XRemote than

others. Ask your system administrator for an appropriate

model. The US Robotics Courier HST Dual Standard

modem is one type that works properly.

Serial Ports
All terminals include at least one serial port. Serial ports

on terminals have a DB-25 (25-pin) or DB-9 (9-pin) female

connector.

The Explora, Explora Pro, Explora 400/450 series, and

Explora 700 terminals have one serial port.

A standard HMX-series terminal has one serial port,

labelled AUXILIARY. If you have an ESP board

(Ethernet/Serial/PC) installed, you have either two or

three serial ports. Attaching a Y cable to the ESP serial port

converts the single port into two ports, for a total of three

serial ports.

Serial Cables
For a modem connection, you need a short serial cable.

This cable is not provided with XRemote, but some

modems include a cable.

Most modem connections require a cable with male

connectors. If your cable’s connector does not fit, adapters

are available.
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To connect the modem:

1. Connect one end of the serial cable to the terminal’s

serial port and the other end to the modem.

2. Connect the modem to the phone line, as directed in

the modem manual.

Configuring the Terminal’s Serial Port
Usually, the default configuration of the terminal's serial

port is correct. If not, follow these directions:

1. Display the Console’s Change Setup Parameters

window (Setup ⇒ Change Setup Parameters) and

open the Serial hide box.

2. In the Serial Interfaces Table  (Figure 12-2),

scroll to display the field you need to change and

click the field. Select the correct value for the field.

If more than one serial port is displayed in the

Serial Interfaces Table , make sure you are

configuring the port being used for XRemote.

— If the modem is faster than 9600 baud, change

the Baud Rate field to the appropriate baud

rate.

— If you are using RTS/CTS flow control on the

modem, set the Handshake field to rts/cts .

— Make sure the Port Use at Boot field is set to

terminal .

3. When you finish configuring the serial port, click

Apply  at the bottom of the Setup Parameters

window.

Figure 12-2  Serial Interfaces Table
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Your changes take effect immediately and are saved

in the terminal’s non-volatile RAM (NVRAM).

4. If the Auto Save File  field just above the Apply
button is selected, your changes are also saved in a

configuration file on the PC card or on the host for

terminals without a PC card.

Saving the changes to NVRAM or a file means that the

serial port retains its configuration even if the

terminal is powered off or rebooted.

Using XRemote Over a Modem with PPP or SLIP Protocol
Dial Up the Host and Start PPP or SLIP

See “Connecting a Modem to the Terminal” on page 12-5

for directions on attaching the modem.

1. Make sure the modem is connected to the terminal

and to the phone line, and that the modem is turned

on.

2. If the terminal is not running, turn it on and allow it

to boot completely.

3. Open the Dialer (Terminals ⇒ New Dialer).

4. If a Dialer Port Chooser appears, that means you

have more than one serial port. In the Chooser,

highlight the number of the serial port that you want

to use, and click OK. The numbers in the Port
Number field correspond to the following physical

ports:

— Port Number 1 is the connector labelled

AUXILIARY on an HMX-series terminal or the

single serial port on other terminals.

— Port 2 is the serial connector on the HMX

terminal’s ESP board (if installed).

— If a Y cable is attached to the ESP board serial

port, the A connector on the Y cable is Port 2 and

the B connector is Port 3.

5. Make sure that Strip Parity in the Dialer’s Options

menu is turned on if the host you are dialing up is
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using 7-bit characters, the most likely situation. The

default value is true (on).

6. Type the modem command to connect to the host. If

you or your system administrator have already

configured your modem, use the following directions

to dial up the host. If the modem is not configured,

first configure the modem as described in

“Configuring a Modem” on page 12-13.

— If you are using a US Robotics modem, type the

command:

ATDTphonenumber <CR>

where phonenumber is the remote host’s phone
number. For example:

ATDT12125551132 <CR>

If you need to dial 9 to get an outside line, insert
a comma after the 9. For example, the command:

ATDT9,12125551132 <CR>

instructs the modem to pause after dialing the 9
until it hears the second dial tone. This prevents
a miscommunication.

After you type the ATDT command, the modem
displays one of the messages listed in Table 12-1.

— If you are using a different modem, follow the

directions in the modem manual to dial the

remote host’s phone number. If the modem is

not configured, see “Configuring a Modem—

Generic Instructions” on page 12-14.

Table 12-1 Modem Messages

Message Status Action

RING
CONNECT 9600/V32/NONE

You are connected. The host

displays its login prompt.

If the login prompt does

not appear, press

Return.

BUSY The line is busy. Try to connect later.
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7. If PPP or SLIP does not start automatically, type the

command defined by your system administrator to

start PPP or SLIP.

8. For SLIP, select SLIP  from the Communications

menu in the Dialer to convert the line to SLIP mode.

For PPP, this step may not be necessary because PPP

packets are autodetected. If the remote host does not

initiate the negotiation, select PPP from the

Communications menu.

9. When PPP starts, the Dialer is iconified and these

messages appear in the messages area of the Console:

                    %NCDTERM-I-MISC Switching to PPP Mode...
                     %PPPD-I-UP, Port n: local = x.x.x.x, remote = x.x.x.x

Jot down the local address. You may need it later.

Log In and Start the XRemote Helper for PPP or SLIP
1. Open the Terminal Host Chooser (Terminals ⇒ New

Terminal or New Telnet). Figure 12-3 shows an

example Chooser.

2. If the host on which you need to run the XRemote

helper is listed in the Chooser, click the hostname

and click OK.

Figure 12-3  NCD Terminal Host Chooser

Host IP
address or
name
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3. If the host is not listed, click in the Service: field

and type the host’s name or IP address and click OK.

4. When the login prompt appears, type your login

name and password.

5. To start the XRemote helper, type the following

command:

% xinitremote -- -inet & <CR>
Log file is /usr/tmp/Xremote1

6. The xinitremote command starts the XRemote helper

as well as any applications specified in a

.xinitremoterc startup file in your home directory.

If you have no startup file, an xterm window appears.

xterm is the basic X Window System terminal

emulator. The window is titled Login.

See the NCDware System Administrator’s Guide for

information about XRemote startup files.

7. If no applications or xterm windows appear, the

XRemote helper has not started. The usual reasons

are:

— If the message Command not found is displayed,

your system administrator has not added

XRemote commands to your search path.

Usually XRemote resides in the directory

/usr/bin/X11/ncd. You may be able start XRemote

by typing the complete pathname:

                         % /usr/bin/X11/ncd/xinitremote -- -inet <CR>

— The terminal’s DISPLAY variable is not set.

Follow the directions in “Setting the Terminal’s

DISPLAY Variable” on page 12-22 and type the

xinitremote command again.

8. When XRemote starts, you use the applications

started automatically and start other applications

and network services as you would using a terminal

on a local network.

9. To end the XRemote session, see the instructions in

“Ending the XRemote Session” on page 12-22.
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Using XRemote Over a Modem with the Proprietary XRemote
Protocol

Dial the Host
See “Connecting a Modem to the Terminal” on page 12-5

for directions on attaching the modem.

1. Make sure the modem is connected to the terminal

and to the phone line, and the modem is turned on.

2. If the terminal is not running, turn it on and allow it

to boot completely.

3. Open the Dialer (Terminals ⇒ New Dialer).

4. If a Dialer Port Chooser appears, you have more than

one serial port. In the chooser, highlight the number

of the serial port that you want to use, and confirm

by clicking OK. The physical serial ports

corresponding to the numbers in the Dialer are:

— Port 1 is the port labelled AUXILIARY on an

HMX-series terminal or the single serial port on

other terminals.

— Port 2 is the serial port on an HMX terminal’s ESP

board (if installed).

— If a Y cable is attached to the ESP board’s serial

port, the A connector on the Y cable is Port 2 and

the B connector is Port 3.

5. Make sure that Strip Parity  in the Dialer Options

menu is turned on if the host you’ve dialed up is

using 7-bit characters, the most likely situation. The

default value is true (on).

6. If you or your system administrator have already

configured your modem, use the following directions

to dial up the host. If the modem is not configured,

before proceeding, configure the modem as

described in “Configuring a Modem” on page 12-13.

— For a US Robotics modem, type the following

command:

ATDTphonenumber <CR>
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where phonenumber is the remote host’s phone
number. For example:

ATDT12125551132 <CR>

If you need to dial 9 to get an outside line, insert
a comma after the 9. For example, the command:

ATDT9,12125551132 <CR>

instructs the modem to pause after dialing the 9
until it hears the second dial tone. This prevents
a miscommunication.

After you enter the ATDT command, the modem
displays one of the messages listed in Table 12-2.

— For any other type of modem, refer to your

modem manual for the command to use to dial

the host.

Log Into the Host and Start the XRemote Helper
1. When the login prompt appears, type your login

name and password.

2. Start the XRemote helper by typing:

$ xinitremote <CR>
Log file is in /usr/tmp/Xremote1

The xinitremote command starts the XRemote helper

and any applications specified in the .xinitremoterc
startup file, which may exist in your home directory.

If you do not have a startup file, an xterm window

titled Login appears. xterm is the basic terminal

emulator.

Table 12-2 Modem Messages

Message Status Action

RING
CONNECT 9600/V32/NONE

You are connected. The host

displays its login prompt.

If the login prompt does

not appear, press

Return.

BUSY The line is busy. Try to connect later.
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If the message Command not found  is displayed,

XRemote has not started. The usual reason is that

your system administrator has not added XRemote

commands to your search path. XRemote usually

resides in the directory /usr/bin/X11/ncd. You may be

able to start XRemote by typing the complete

pathname of the xinitremote command:

% /usr/bin/X11/ncd/xinitremote <CR>

3. When XRemote starts, you use the applications

started automatically and start other applications as

you would using a terminal on a local network.

4. To end the XRemote session, see the instructions in

“Ending the XRemote Session” on page 12-22.

Configuring a Modem
If your system administrator has not already configured

the modem, follow the relevant directions:

❏ If you have a US Robotics modem, follow the

procedure in “Configuring a US Robotics Modem.”

❏ If you have a different modem, follow the procedure

in “Configuring a Modem—Generic Instructions” on

page 12-14.

To ensure that XRemote works correctly, both the remote

and hostside modems must be set properly. Ask your

system administrator to set up the hostside modem.

If you want more suggestions for specific modems, ask

your system administrator to review the XRemote

Technical Note via FTP from NCD.

Configuring a US Robotics Modem
The US Robotics Courier HST Dual Standard modem

meets all XRemote requirements. Use this procedure as an

example for configuring a US Robotics modem for use

with XRemote.
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1. In the Dialer, type the commands listed in Table 12-3.

2. Return to Step 6 on page 12-8 (if you are using

PPP/SLIP) or page 12-11 (if you are using the

proprietary XRemote protocol) and dial the host.

Configuring a Modem—Generic Instructions
1. In the Dialer window, set the following modem

parameters. Use the commands described in your

modem manual.

— Configure the modem to ignore DTR signals.

— Disable any compression algorithms used by the

modem. These algorithms delay XRemote

transmissions and degrade performance.

Consult your modem manual for instructions on

disabling compression and error correction such

as Microcom Networking Protocol (MNP).

Table 12-3 Modem Configuration Settings

Type This
Command

Modem
Display

Result of Your Action

AT&A3<CR> OK Displays error code indicators (HST, LAPM, MNP, SYNC, or

NONE) and data compression type (V42BIS or MNP5).

AT&B1<CR> OK Fixes DTE/DCE data rate at the DTE setting.

AT&H1<CR> OK Sets modem flow control to hardware only. This allows

compatibility with non-XRemote uses of the remote and/or

host-side modems.

AT&M0<CR> OK Sets asynchronous mode to normal, with no error control.

AT&N0<CR>

or
AT&N6<CR>

OK Sets the baud rate to default (normal connection operations) or

9600.

AT&W<CR> OK Saves these settings to the modem’s NVRAM so that you don’t

have to re-enter these commands each time you use XRemote.
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— Disable XON/XOFF flow control for the modem.

If you want to use flow control, enable hardware

flow control using RTS/CTS.

— Be sure that the modem is configured for 8 data

bits, 1 stop bit, and no parity.

2. Type the modem command for saving parameters in

the modem’s NVRAM so that you don’t have to

re-enter the configuration commands each time you

use XRemote.

3. Return to Step 6 on page 12-8 or “Dial the Host” on

page 12-11.

Using XRemote—Direct Serial Connection
This section provides procedures for using XRemote on a

direct serial connection. A serial cable extends directly

from the terminal to a local host computer or to a terminal

server or switch box connected to a host computer.

Your system administrator may set up XRemote to

connect in a different way than is described here. Ask your

system administrator if you need help connecting over

XRemote.

Deciding Which Protocol to Use
You can run XRemote over a direct serial connection in

two ways:

❏ Using PPP or SLIP. If you are using this method,

follow the procedures in “Using XRemote—Direct

Serial Connection with PPP or SLIP Protocol” on

page 12-17.

See the NCDware System Administrator’s Guide for a

comparison of XRemote, PPP, and SLIP protocols.

❏ Using the XRemote proprietary protocol over a serial

connection. If you are using this method, follow the

procedures in “Using XRemote—Direct Serial

Connection with the Proprietary XRemote Protocol”

on page 12-19.
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Ask your system administrator which way to run

XRemote.

Configuring the Serial Port
From the Console, display the Serial Interfaces Table

(Setup ⇒ Change Setup Parameters ⇒ Serial). Make sure

that the serial port you are using is set to match the host’s

handshake method and the baud rate is set as high as

possible.

Figure 12-4 shows the default Serial Interfaces Table. Note

that you must use the horizontal scroll bar to see all of the

table.

If more than one serial port is listed, the terminal has an

ESP interface board installed. Ask your system

administrator which port to use. To make sure you

configure the correct port:

❏ The connector labelled AUXILIARY is the Port 1.

❏ The connector on the ESP board (if installed) is Port 2.

❏ If a Y cable is attached to the ESP board, the A

connector on the Y cable is Port 2 and the B connector

is Port 3.

To change parameters in the Serial Interfaces Table:

1. To change the handshake (flow control) method, click

the Handshake  field and select the correct method.

Figure 12-4  Serial Interfaces Table Default Settings

Scroll to see all
of the table
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2. To change the baud rate, click the Baud Rate  field

and select the correct baud rate.

3. Click Apply  at the bottom of the Setup Parameters

window to apply the changes to the current

configuration and save the changes into the

terminal’s NVRAM.

If Auto Save File is selected, the changes are saved

into your terminal’s configuration file as well.

Using XRemote—Direct Serial Connection with PPP or SLIP
Protocol

Start PPP or SLIP
1. Open the Dialer (Terminals ⇒ New Dialer).

2. If a Dialer Port Chooser appears, you have more than

one serial port. In the chooser, highlight the number

of the serial port you are using for XRemote and

confirm by clicking OK.

3. Make sure that Strip Parity in the Dialer’s Options

menu is turned on if the host you are logging into is

using 7-bit characters, the most likely situation. The

default value is true (on).

4. If PPP or SLIP does not start automatically, type the

command defined by your system administrator to

start PPP or SLIP.

5. For SLIP, select SLIP  from the Communications

menu in the Dialer to convert the line to SLIP mode.

For PPP, this step may not be necessary because PPP

packets are autodetected. If the remote host does not

initiate the negotiation, select PPP from the

Communications menu.

6. When PPP starts, the Dialer is iconified and these

messages appear in the messages area of the Console:

               %NCDTERM-I-MISC Switching to PPP Mode...
               %PPPD-I-UP, Port n: local = x.x.x.x, remote = x.x.x.x

7. Jot down the local address. You may need it later.
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Log In and Start the XRemote Helper for PPP or SLIP
1. Open the Terminal Host Chooser in the Console

(Terminals ⇒ New Terminal or New Telnet).

2. If the host on which you need to run XRemote is

listed in the Terminal Host Chooser, click the

hostname and click OK.

3. If the host is not listed, click in the Service:  field of

the Terminal Host Chooser.

Type the host’s name or IP address and click OK.

4. When the login prompt appears, type your login

name and password.

5. To start the XRemote helper, type the following

command:

% xinitremote -- -inet <CR>
Log file is /usr/tmp/Xremote1

6. The xinitremote command starts the XRemote helper

as well as any applications specified in an XRemote

startup file in your home directory.

If you have no startup file, an xterm window appears.

xterm is the basic X Window System terminal

emulator. The window is titled Login.

See the NCDware System Administrator’s Guide for

information about XRemote startup files.

7. If no applications or xterm window appear, the

XRemote helper has not started. The usual reasons

are:

— If the message Command not found is displayed,

your system administrator has not added

XRemote commands to your search path.

Usually XRemote resides in the directory

/usr/bin/X11/ncd. You may be able start XRemote

by typing the complete pathname:

                          % /usr/bin/X11/ncd/xinitremote -- -inet <CR>

— The terminal’s DISPLAY variable is not set.

Follow the directions in “Setting the Terminal’s
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DISPLAY Variable” on page 12-22 and type the

xinitremote command again.

8. When XRemote starts, you use the applications

started automatically and start other applications as

you would using a terminal on a local network.

9. To end the XRemote session, see the instructions in

“Ending the XRemote Session” on page 12-22.

Using XRemote—Direct Serial Connection with the Proprietary
XRemote Protocol

Log Into the Host
1. Open the Dialer in the Console (Terminals ⇒ New

Dialer).

2. If a Dialer Port Chooser appears, you have more than

one serial port. In the Chooser, highlight the number

of the serial port that you want to use, and confirm

by clicking OK.

3. Confirm that Strip Parity  in the Dialer Options

menu is turned on if the host you’ve dialed up is

using 7-bit characters, the most likely situation. The

default value is true (on).

4. When the login prompt appears, type your login

name and password.

Start XRemote
1. Start the XRemote helper by typing:

$ xinitremote <CR>
Log file is in /usr/tmp/Xremote1

The xinitremote command starts the XRemote helper

and any applications specified in the .xinitremoterc
startup file, which may exist in your home directory.

If you do not have a startup file, an xterm window

titled Login appears. xterm is the basic X Window

System terminal emulator.
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If the command does not start, the usual reasons are:

— If the message Command not found is displayed,

XRemote has not started. The usual reason is

that your system administrator has not added

XRemote commands to your search path.

Usually XRemote resides in the directory

/usr/bin/X11/ncd. You may be able to start

XRemote by typing the complete pathname of

the xinitremote command:

% /usr/bin/X11/ncd/xinitremote <CR>

— The terminal’s DISPLAY variable is not set.

Follow the directions in “Setting the Terminal’s

DISPLAY Variable” on page 12-22 and type the

xinitremote command again.

2. After XRemote starts, you can start other X

applications as you would on a terminal connected to

a local network.

3. To end the XRemote session, see the instructions in

“Ending the XRemote Session” on page 12-22.

Using XRemote on an Ethernet or Token-Ring LAN
Follow the directions in this section to use XRemote over a

local area network (LAN) instead of a serial connection.

You may want to use XRemote on an Ethernet or Token-

Ring LAN to improve performance. If you need to run

applications on a host that is on a different local network

and the connection between the local networks is

relatively slow, you can use XRemote to speed up

communications.

Log Into the Host
Log into the host as follows:

1. Select a TELNET connection in the Console

(Terminals ⇒ New Telnet).

2. Select a host from the Terminal Host Chooser and

click OK.
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If no hosts are listed, type the IP address or hostname

of a host in the Service:  field and click OK.

3. In the terminal emulator window, type your login

name and password.

Start XRemote
1. To start XRemote (in the terminal emulator window)

type:

% xinitremote -- -inet & <CR>
Log file is in /usr/tmp/Xremote1

2. The xinitremote command starts the XRemote helper

and any applications specified in the xinitremoterc
startup file for customizing XRemote.

If you have no startup file, an xterm window titled

Login appears. xterm is the basic X window system

terminal emulator.

3. If no applications or xterm windows start, XRemote

has not started. The usual reasons are:

— If the message Command not found is displayed,

your system administrator has not added

XRemote commands to your search path.

XRemote usually resides in the directory

/usr/bin/X11/ncd. You may be able to start the

helper by typing the complete pathname:

                        % /usr/bin/X11/ncd/xinitremote -- -inet &  <CR>

— The terminal’s DISPLAY variable is not set. Set

the variable as explained in “Setting the

Terminal’s DISPLAY Variable” on page 12-22

and try the xinitremote command again.

4. After XRemote starts, you can start other

applications on the host or use network services as

you normally would on a local network.

5. To end the XRemote session, see the instructions in

“Ending the XRemote Session” on page 12-22.
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Ending the XRemote Session
Follow these steps to end the XRemote session and close

the connection with the host:

1. Close the last application started by the startup

script, if you know which one was started last.

Otherwise, just close all of the applications.

2. If you used the Dialer to connect to a host, close the

connection:

a. Deiconify the Dialer if necessary.

b. If you connected through a modem, type the

modem’s escape sequence to hang up. For most

modems, the command is +++atH .

Some modems require you to send a break signal by
selecting Send Break from the Dialer’s File menu.

Setting the Terminal’s DISPLAY Variable
Follow the directions in this section if you need to set the

DISPLAY variable to run xinitremote. You may need to set

the variable if you are using XRemote on a LAN or through

PPP or SLIP.

The value of the DISPLAY variable is the IP address or

hostname of your terminal, followed by :0. For example,

for a terminal with the hostname ncdpp3, the value of the

variable is ncdpp3:0. If you can’t find the terminal’s

hostname, you can use its IP address; for example

138.43.125.30:0.

If you are using PPP, use the local IP address that you

wrote down when you started PPP.

To set the DISPLAY variable, type a shell command. For

example:

C shell: % setenv DISPLAY display <CR>

Bourne shell: % DISPLAY=display; export DISPLAY <CR>
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Checking XRemote Diagnostics
If you are having problems with XRemote, you can

display diagnostic messages through the Console or look

in the XRemote log file.

Diagnostic Messages in the Console
1. Display the Console.

2. Select the Messages hide box to display all diagnostic

messages.

3. Note any errors reported in the message area, and

report them to your system administrator if you

cannot resolve the problem.

The XRemote Log File
XRemote and the applications run by the startup file direct

their message output to a log file. By default, the output

goes to a log file in the /usr/tmp directory. Sometimes, the

system administrator designates a different directory for

the log files.

Log files are named Xremoten, where n is a number

assigned by XRemote. The first terminal to start an

XRemote session creates a log file called Xremote1, and the

number increases incrementally for other users who start

XRemote.

Right after you type the xinitremote command to start

XRemote, a message is displayed that provides the

location and name of your log file.

You can look in the log file for information if you are

having trouble starting XRemote.
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13 Using OpenWindows on NCD Terminals

This chapter introduces the use of Sun Microsystem’s

OpenWindows, an environment often used on NCD

terminals.

The chapter includes a brief introduction to this GUI and

tips for improving its performance on NCD terminals.

The OpenWindows window manager discussed in this

chapter is an alternative to the NCD Window Manager. If

you want to know more about your particular system’s

GUI configuration, refer to these sources:

❏ The NCDware System Administrator’s Guide
❏ Your system administrator

Overview
OpenWindows is a user environment based on the Sun

OPEN LOOK graphical user interface (olwm). For detailed

information about using OpenWindows, ask your system

administrator for Sun OpenWindows documentation.

NCDware is compatible with OpenWindows Version 2

and OpenWindows Version 3.

Logging In
If your terminal has been configured to allow it, you can

log into and use OpenWindows directly from the XDM

login banner, as described in “Logging In” on page 4-2.
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Configuring your system to use OpenWindows when you

log in from the XDM banner involves customizing several

of the files that control your session.

When you have logged in, the terminal software starts up

with olwm (instead of NCD Window Manager) and

whatever applications and utilities are indicated in your

.xsession file (Figure 13-1).

Common startup applications might include:

❏ The File Manager (Sun Microsystems Computer

Corporation owns File Manager V3), a file and

directory management tool

❏ A command tool, a scrolling window-based shell

environment

❏ The NCDware Console

If your software is not configured to start OpenWindows

immediately when you log in, you can start it yourself

after logging into a host on which the OpenWindows

software has been installed:

1. If the NCD local window manager is running when

you log in, use the Console’s WindowMgr menu to

turn off the local window manager.

2. Open a terminal emulator window.

3. In the window, type:

% olwm &

The characteristic OpenWindows frames appear

around the windows.
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Components of the OpenWindows GUI
This section introduces the components of the

OpenWindows GUI. These components are:

❏ Mouse and pointer

❏ Workspace

❏ Window management

❏ Focus Policy

❏ Additional OpenWindows utilities

❏ Online documentation

Figure 13-1  An OpenWindows Display After Login
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Mouse and Pointer
In the OpenWindows environment, the mouse operates

similarly to its use in NCD Window Manager. In

OpenWindows, however, the buttons are described by

function instead of by logical or physical numbers.

❏ The left button is the SELECT button.

❏ The middle button is the ADJUST button.

❏ The right button is the MENU button.

In the OpenWindows environment, the pointer appears in

several forms, described in Table 13-1.

The OpenWindows cursor appears in a different shape

depending on whether its window is inactive or active:

❏ A small triangle in an active window

❏ A small diamond in an inactive window

Workspace
In the OpenWindows environment, the root window is

called the Workspace.

Table 13-1 Pointers in OpenWindows

Pointer Meaning

Clock System cannot accept input

Basic arrow On the background window

Arrow with small square attached Dragging an item

Arrow with square containing text Dragging a portion of text

Arrow with two small squares Copying an item by dragging
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Window Management
In the OpenWindows environment, applications display

their output in OpenWindows windows (Figure 13-2),

which contain graphical tools for performing window

management functions.

The frame surrounding an OpenWindows window is

called the window border. The window has a header

across the top that contains a title area and a button used

to obtain a Window menu. Beneath the header is an area

called the control area. Depending upon the application in

the window, the control area may contain buttons used to

display additional menus or other control mechanisms.

The area in which input and output appear is called the

window pane.

The Window menu contains options for manipulating

windows, including:

❏ Closing

❏ Moving

❏ Changing size

Window menu button

Header

Control area

Window pane

Window border

sam@octopus

Figure 13-2  An OpenWindows Window

Calendar Manager V3 is
owned by Sun Microsystems
Computer Corporation.
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❏ Changing hierarchical position

❏ Refreshing the display

❏ Quitting the application

Table 13-2 summarizes window manager functions.

Focus Policy
The OpenWindows environment provides the same two

basic input focus methods as NCD Window Manager and

OSF/Motif: click-to-focus and pointer focus. In

OpenWindows, the default click-to-focus policy is called

click SELECT mode. In click SELECT mode, you use the

SELECT mouse button to indicate the active window.

Table 13-2 OpenWindows Window Management Functions

Function Method

Displaying the

Window menu

Put the pointer on the header or border and click the MENU button.

Moving windows 1. Position the pointer on the window border.

2. Press the SELECT button and drag the window to the desired location.

3. When the window is where you want it, release the SELECT button.

Moving a

window to the

back of a stack of

windows

1. Put the pointer on the header of the window you want to lower.

2. Click the MENU button to open the Window menu.

3. Position the pointer over the Back menu item.

4. Release the MENU button.

Changing the size

of a window

1. Position the pointer on one of the window corners.

2. Press the SELECT button and drag the corner until the window is the

size you want it to be.

3. Release the SELECT button.

Closing windows Click on the Window menu’s Close item.

Quitting

applications

Click on the Window menu’s Quit item.
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Pointer focus policy is called move pointer mode in

OpenWindows.

Additional OpenWindows Utilities
OpenWindows DeskSet is a set of applications and utility

programs that may be installed with OpenWindows. They

include:

❏ Shell tools and command tools (command interpreter

windows). Shell tools scroll forward; command tools

scroll forward and backward.

❏ A file directory management tool

❏ A text editor

❏ A clock

❏ A calendar

❏ A printing tool

❏ A mail tool

DeskSet applications are accessed through the Workspace

menu, which appears when you place the pointer on the

Workspace and click the MENU button.

Online Documentation
OpenWindows contains two types of online

documentation—spot help and handbooks.

Spot help popup windows contain brief descriptions of

window mechanisms. To display spot help:

1. Place the pointer on the window area that you want

information about.

2. Press the Help key on your keyboard. (You can

remap a terminal’s function key to act as the Help

key. See “Remapping the Keyboard” on page 13-8.)

Handbooks, including the tutorial-style “Desktop Intro,”

describe how to use the DeskSet applications and the

components of the OpenWindows environment.

❏ To display the “Desktop Intro,” select Workspace ⇒
Menu ⇒ Desktop Intro.
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❏ To display the other handbooks, choose the Help
item from the Workspace menu.

Tips for Running OpenWindows Applications
This section includes tips for getting the best performance

from OpenWindows running on your terminal. They are:

❏ Optimizing the display of fonts

❏ Remapping the keyboard

❏ Shell Tool and command prompts

❏ Screen resolutions

❏ Using the Save Workspace utility

Optimizing Display of Fonts
OpenWindows displays best on your terminal if you set

the 75 dpi fonts in front of the 100 dpi fonts in the font

path. (The default font path has the 100 dpi fonts first.)

To change the font path, use the Change User Preferences

popup window, accessed from the Console’s Setup menu.

(Setup ⇒ Change User Preferences ⇒ Fonts.) For detailed

information about changing fonts, see “Font Options” on

page 6-7.

Remapping the Keyboard
NCD’s N-123 Sun Type-5 compatible keyboards and N-107

Sun Type 4-compatible keyboards have Help, Copy, Paste,

and Cut keys that do not appear on NCD’s other

keyboards. Your system administrator can remap the

function keys of NCD’s other keyboards to include the Sun

special keys. Remapping is accomplished by altering

.xmodmaprc.sun and .xsession files.

The remapped keys are:

❏ F5—Help

❏ F6—Copy

❏ F7—Paste

❏ F8—Cut
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Shell Tool and Command Tool Prompts
If you do not have a SunOS prompt when you invoke a

shell tool or a command tool, ask your system

administrator to make sure that the commands to invoke

the prompts are prefaced with the line /usr/etc/setsid -b.

Screen Resolutions
The Sun Microsystems screen resolution differs from that

of the NCD terminal monitors. Consequently, when you

use OpenWindows on a terminal, icons may appear in the

wrong area of the display or they may not appear at all. If

your icons seem misplaced or are missing, check with

your system administrator to see if the necessary filter is in

your .xsession file.

Using Save Workspace
The Save Workspace utility, accessed from the Workspace

menu’s Utilities submenu, saves the current display

configuration so that the layout of your applications

remains the same the next time you log in.

When you use the Save Workspace utility on a terminal,

the utility does not save local applications.
Using OpenWindows on NCD Terminals 13-9



Tips for Running OpenWindows Applications

Usin
g OpenWindows on NCD Terminals 13-10



A The X Window System and NCD
Terminals

Your NCD terminal and the X Window System (X) offer a

simple way to use a variety of computers and application

programs over a network.

This appendix describes the network structure that makes

many computers accessible from your NCD terminal.

Closer Look at X Software and Hardware
This section describes in more detail the X system software

and hardware involved in an X computing environment.

The major benefits of X are summarized in Table A-1.

Table A-1  Benefits and Characteristics of X

Benefit Description

Distributed

processing

The network’s processing power is distributed throughout the network as

needed. You can access any computer on the network using the terminal.

Network

transparency

The network is transparent. Regardless of where on the network an application

resides, it appears to be running on your desktop.

Operating

system

independence

The operating system is independent of the X software. You can display

applications from computers with different operating systems at the same time

on your terminal.

Host

transparency

The type of computer host you are connected to is not apparent from your

terminal. Regardless of the computer host, the X software provides a consistent

way to connect to it, start and stop applications, and manipulate windows.

Windows Each application directs its output to a separate window on your display

screen. The window manager software gives each of the windows a frame that

you can manipulate with a mouse or keyboard to direct the application’s

actions and change the appearance or location of the window.
A-1



X Software Components
The X computing environment achieves the characteristics

listed in Table A-1 using three components:

❏ X server software that controls the physical display and

input devices (typically the mouse and the keyboard)

❏ X applications that request that the X server perform

operations on windows

❏ Communication channels implemented in software and

hardware that are used by the applications and X server

to exchange data and instructions

Figure A-1 illustrates the relationships among the three

components of the X system.

Because applications, X servers, and communications

software are separate, they can exist on separate processors.

This makes it possible for an NCD terminal—a display

monitor and a processor dedicated to running the X server—

to provide access to an unlimited array of hosts and

applications over a network.

Servers
An X server is one kind of server. A server refers to a program

that provides services over the network. Some of the NCDware

servers and the services they provide are:

❏ X server—connects terminals to hosts or additional

services in a local area network and controls the physical

Figure A-1  X System Components

X Server
Software

Communication
Channel 2

Application1
Software

Application2
Software

Application3
Software

Communication
Channel 1

Communication
Channel 3
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display and input devices (for example, a keyboard) on

the user’s desktop.

❏ Font server—provides convenient application access to

fonts, including scalable fonts.

The X server was developed at the Massachusetts Institute of

Technology (MIT) in 1984. The most recent version, X11, was

released in 1987. X11 is industry-standard windowing

software.

X server software performs actions such as creating and

removing windows and placing text and graphics in them for

application programs that request them. Basic X server

functions include:

❏ Allowing applications access to the display

❏ Interpreting network messages

❏ Passing user input to the appropriate applications

❏ Performing two-dimensional and three-dimensional

drawing (text and graphics)

❏ Maintaining complex data structures such as windows,

cursors, and fonts

Tip
Some NCD keyboards do not have a
Setup key. See Table 5-1 on page 5-2
for equivalent key combinations.

Many of the services provided by the X server are organized

in the Console that appears when you press the Setup key.

For example, when you want to connect to a host through a

terminal emulator window, you open the Terminals menu in

the Console and select New Terminal . The Terminal Host

Chooser appears on your screen displaying a list of the

available hosts to connect to. If you want a Telnet session and

you select an appropriate host, the X server requests a login

connection to the selected Telnet host.

The X server provides other services without any explicit

action on your part. For example, when an application needs

to display a font, the X server requests the font from the Font

Server.
A-3



Applications (Clients)
X applications request the X server to perform actions on the

X display. Applications can run on a remote machine across a

network, or they can run as local applications on the terminal

processors. A small part of the application program is

dedicated to communication with the X server.

In addition to the X server software, most implementations of

the X computing environment include programs to provide

various utilities to the X system. Some examples are:

❏ Display managers, which manage login processing

❏ Terminal emulators, which allow you to run programs

that do not have windowing capabilities

Window Managers
A window manager is a special application that controls the

appearance and operation of the frame that surrounds the

application windows. By using the mouse or keyboard to

manipulate the control devices available on the frame (such as

scroll bars and toggle and selection buttons), the user controls

the interaction and layout of the windows on the display.

Window managers often provide a menu for starting new

applications.

Although the window manager dictates the appearance and

utility of the frame surrounding the window, the application

controls what appears inside the frame of the window through

its requests to the X server.

Several different window managers may be available, but

only one window manager can run on a display at a time.

NCDware includes a local NCD Window Manager that runs on

the NCD terminal with the X server, and an optional local

Motif Window Manager is available. A local window manager

is beneficial because its response is quicker than a host-based

window manager.
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Other common host-based window managers are listed in

Table A-2.

For more information about using window managers, see

Chapter 9, Using the Local NCD Window Manager, and

Chapter 13, Using OpenWindows on NCD Terminals.

Communication Channels
When the X server and applications converse across the

network, they rely upon communication channels, the third

component of the X system software.

Channels for communicating across computer networks are

composed of software and hardware. The software and

hardware are designed according to protocols (standard

rules) for passing messages between different sorts of

machines. Many layers of software and hardware protocols

are used for a communications job, each one handling specific

tasks involved in the communication process.

When using terminals, the most commonly used protocols for

governing the routing of requests around the network are

Transmission Control Protocol/Internet Protocol (TCP/IP)

and DECnet. The most commonly used protocol for the

physical transport of the requests is the Ethernet 802.3 LAN,

which can support a variety of physical cable types. TCP/IP

can also be used over the Token-Ring 802.5 LAN.

Table A-2  Common Window Managers

Window Manager Description

mwm Included with the Open Software Foundation/Motif (OSF/Motif) X

software.

olwm Manages windows for OpenWindows using Sun Microsystem’s OPEN

LOOK graphical user interface.

twm Distributed by MIT with the standard X distribution.
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Common X Utilities
This section introduces some of the common utility programs

that are part of the MIT X11 distribution.

The applications described in this section are commonly

available to users working in the UNIX environment.

For additional information about standard X utilities, see the

X guides listed in the bibliography at the end of this manual.

Online Help
The host-based xman program is a simple facility for access to

system documentation, often called man pages (abbreviation

for manual) in a UNIX environment. NCDware includes man

pages for NCD utilities.

Screen Dump Utilities
xwd is a host-based utility for copying the contents of the

display screen into a file.

xwud is a utility for displaying the contents of a window dump

file on the display.

xpr is a utility for formatting and printing a file that was

created with xwd.

Convenience Utilities
Some standard host-based X utilities that provide a

convenient work environment include:

❏ xclock—An analog or digital clock

❏ xcalc—A calculator

❏ xbiff—A utility that displays a mailbox to announce the

arrival of new electronic mail
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VT102 (xterm ) Terminal Emulator
The standard host-based X11 utility called xterm is a terminal

emulator available from MIT. It allows you to run application

programs that are not X-compatible from a window on your

terminal.

This utility is called Command Tool/Shell Tool in the

OpenWindows environment.

The application program functions as a VT102 terminal, while

providing additional features, such as a scroll bar and a copy/

paste mechanism. Detailed information on xterm is included

in the standard X references cited in the bibliography at the

end of this manual.

Copy and Paste Between X Applications
Many X application programs permit copying and pasting

text between windows and between applications. The exact

usage varies from application to application, but most work as

follows:

1. Press and drag the left mouse button to highlight text.

This action is based on the position of the pointer, which

follows the mouse’s movement, not the position of the

cursor.

2. Click the right mouse button to extend the highlighted

portion to another pointer location.

3. Click the middle mouse button to paste a copy of the

highlighted text at the position of the cursor, not the

pointer.
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B Using Alternate Input Devices

The mouse is the standard input device for manipulating

windows and making screen selections. You may use

alternative input devices with your terminal instead of or in

addition to a mouse.

This appendix describes how to use a touch screen monitor or

a light pen as an input device.

Using a Touch Screen Monitor
Tip
Your system administrator can specify
that the touchscreen application
software start immediately when you
boot the terminal. For more
information, see the NCDware
System Administrator’s Guide.

A touch screen monitor allows you to use a finger (or the soft

eraser on a pencil) instead of or in addition to a mouse to move

around the display screen and make selections.

If your application software includes touch screen features,

use the directions in this section to configure the software

(unless your system administrator has configured it for you)

and to switch between touch screen and mouse usage.

If you have to configure the terminal yourself, ask your

system administrator to put your changes into the terminal’s

remote configuration file so they are permanent. Otherwise,

your changes are cleared from memory if the terminal is

rebooted or powered off.

Configuring Terminal for Touch Screen Use
See “NCD Window Manager
Windows” on page 9-6 for information
about starting one of NCD’s window
managers.

After the touch screen hardware is installed and the terminal

is booted, start a window manager if one is not running.

To operate a touch screen monitor, you must configure the

serial port, input device, and touch screen characteristics as

described in the following sections.
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Configuring the Serial Port
To configure the serial port, set the following values in the

Console’s Change Setup Parameters window (Setup ⇒
Change Setup Parameters):

1. In the Serial hide box, set the values listed in Table B-1 for

the serial port in the Serial Interfaces Table .

2. Select Apply  to put the changes into effect.

Configuring the Input Device
Select the Input Devices hide box from the Console’s Change

Setup Parameters window (Setup ⇒ Change Setup

Parameters). Set Input Devices  to Touchscreen .

Configuring Touch Screen Characteristics

Tip
To configure the touch screen
software permanently, ask your
system administrator to place the
settings in a configuration file on the
host or in the terminal’s NVRAM.

This section describes how to calibrate the monitor’s active

display surface, set touch sensitivity, and activate touch input

for the current configuration (until you reboot).

Calibrating the Monitor’s Active Display Surface
If the cursor is not directly beneath your finger as you touch

the screen, your display needs to be re-calibrated.

To calibrate the display surface, set the following in the

Console’s Change Setup Parameters window (Setup ⇒
Change Setup Parameters):

1. In the Input Devices  hide box, select Calibrate
Touchscreen .

A large black square containing a tiny white box appears

near the lower left corner of the active display surface.

Table B-1  Serial Interfaces Table Setting for Touch Screen

Field Value Field Value

Port Use at Boot input-device Stop Bits 1

Current Port Use input-device Parity none

Baud Rate 9600 Handshake none

Data Bits 8 Hangup none
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2. The Touch Here  message and arrow prompt you to

press your finger on the white box.

After you touch the white box, it disappears and another

appears near the upper right corner. You are prompted

again to touch the white box.

After you touch the second box, calibration is complete.

3. Select Apply in the Change Setup Parameters window to

put the changes into effect.

Changing Touch Screen Sensitivity
To change the press and release sensitivity of the monitor,

make the following changes in the Console’s Change User

Preferences window (Setup ⇒ Change User Preferences):

1. In the Pointing Devices  hide box, the two sliders

labeled Button Press Threshold and Button Release
Threshold  set the finger pressure levels that trigger

finger button actions and finger presses.

— If you have to press too hard on the monitor, reduce

Button Press Threshold .

— If the monitor is too sensitive, increase Button Press
Threshold .

2. Button Press Threshold  should always be greater than
Button Release Threshold .

If Button Release Threshold  is not lower than Button
Press Threshold , touch screen behavior becomes

erratic. For example, menus do not remain open for

selecting an item.

This requirement is not enforced automatically.

If you change Button Press Threshold , verify that

Button Release Threshold  is lower.

3. Select Apply  in the Change User Preferences window to

put the changes into effect.
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Switching Between Touch Screen and Mouse
To switch between using a touch screen and a mouse, select

the pointing device in the Console’s Change Setup Parameters

window (Setup ⇒ Change User Preferences):

1. In the Pointing Devices hide box, Current Pointing
Device  controls the pointing device in use:

— If you are using the mouse and want to use touch

screen only, select Input Extension Device Only .

— If you are using touch screen, and want to use the

mouse only, select Mouse.

— If you want to use touch screen and the mouse

interchangeably, select Mouse And Extension
Device .

2. Select Apply  in the Change User Preferences window to

put the changes into effect.

Tips on Using Touch Screen Monitors
If you think of the touch screen as a one-button mouse, it

follows that you can use touch screen for any X application or

window manager function that normally relies on a single

mouse button, such as the terminal’s Setup menus.

The touch screen is easier to use on applications designed for

its use, that contain relatively large areas for receiving button

(finger) events. Applications not written for the touch screen

might be more difficult to use because the input areas might

be too small to use accurately with a finger.

When you use the touch screen monitor, lightly touch or roll

your finger across the screen. The cursor follows (tracks) your

finger around the display area. When you remove your finger,

the cursor stops.

If you increase the pressure on your finger, the touch screen

interprets that action the same as the click of a mouse button.

When you remove your finger from the screen, the touch

screen interprets that action as if you had released your finger

from the mouse button.
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Using a Light Pen
Using a light pen with your terminal allows you to perform

the typical operations of a mouse—such as pointing, clicking,

dragging, and positioning—without having to coordinate the

movement of a mouse with the cursor on the screen. A light

pen provides direct control as you move around the display

screen and make selections.

The Explora, Explora Pro, and Explora 400/450 series of

terminals support light pens. The FTG Data Systems PXL-795

light pen is the only light pen that the NCD terminals support.

You can use a light pen in place of a mouse or you can use it

in conjunction with a mouse.

Pressing the light pen tip against the display provides the

same function as clicking the left mouse button. Pressing the

light pen tip against the display while holding down the Caps

Lock key provides the same function as clicking the right

mouse button.

Limitations
Light pen blue flooding does not work at 16- and 24-bit color

depths. For more information about color depth, see the

NCDware System Administrator’s Guide.

Connecting a Light Pen to a Terminal
Follow the instructions provided by FTG Data Systems to

connect your light pen to your terminal.

If you are connecting an FTG Data Systems PXL-795 light pen

to your terminal, do not connect the light pen port cable to the

keyboard and keyboard port as instructed in the FTG Data

Systems Installation and User’s Guide. You must connect the

light pen port cable to your mouse and the mouse port on

your terminal.
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Configuring Terminals for Light Pen Use
See “NCD Window Manager
Windows” on page 9-6 for information
about starting one of NCD’s window
managers.

After the light pen hardware is installed and the terminal is

booted, start a window manager if one is not running.

To operate a light pen, you must configure the input device

and calibrate the light pen as described in the following

sections.

Configuring the Input Device
Select the Input Devices hide box from the Console’s Change

Setup Parameters window (Setup ⇒ Change Setup

Parameters). Set Input Devices  to Light Pen .

Calibrating the Light Pen
This section describes how to calibrate the light pen’s active

display surface.

You can activate the light pen calibration process directly

using a combination of keystrokes, or you can activate the

calibration process from the Console’s Change Setup

Parameters window. At any time during the calibration

process you can abort the calibration by pressing the Esc key.

Directly Activating the Calibration Process
To directly activate the light pen calibration process, do the

following:

1. From any display, press the Caps Lock and Right Alt

keys simultaneously.

A small white target appears in the lower-left corner of

the display screen.

2. Select the lower-left target.

To select a target, press the light pen tip against the

display. Keep the light pen perpendicular to the display

as you make your selection. You might have to press the

light pen tip against the target more than once for the

selection to be accepted. After the selection is accepted, a

target appears in the upper-right corner of the display.

3. Select the upper-right target.
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After the selection is accepted, a target appears in the

center of the display.

4. Select the center target.

The center target provides a check of the minimum and

maximum locations specified when you selected the

lower-left and upper-right corners. If the calibration is

accepted, the original display appears and the calibration

is automatically set in NVRAM.

If the calibration fails, the target appears in the lower-left

corner of the display screen. Repeat steps 2 through 4.

 Activating the Calibration Process through the Console
To activate the light pen calibration process through the

Console’s Change Setup Parameters window (Setup ⇒
Change Setup Parameters), do the following:

1. In the Input Devices hide box, select Calibrate Light
Pen.

A small white target appears in the lower-left corner of

the display screen.

2. Select the lower-left target.

To select a target, press the light pen tip against the

display. Keep the light pen perpendicular to the display

as you make your selection. You might have to press the

light pen tip against the target more than once for the

selection to be accepted. After the selection is accepted, a

target appears in the upper-right corner of the display.

3. Select the upper-right target.

After the selection is accepted, a target appears in the

center of the display.

4. Select the center target.

The center target provides a check of the minimum and

maximum locations specified when you selected the

lower-left and upper-right corners. If the calibration is

accepted, the Change Setup Parameters window is

displayed and the calibration is automatically set in

NVRAM.
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If the calibration fails, the target appears in the lower-left

corner of the display screen. Repeat steps 2 through 4.

Enabling the Light Pen Blue Flood Feature
A light pen must detect light in order to determine its position

on a display. As a result, you cannot use your light pen in

areas of the display that are very dim or completely black

unless you enable the light pen’s blue flood feature.

When you enable the blue flood feature, the light pen

momentarily brightens dark display areas when you press it

to the display. Once the light pen’s selection is detected, the

display returns to its normal colors.

The light pen blue flood feature is enabled by default.

However, if you need to disable the feature, set the following

in the Console’s Change Setup Parameters window (Setup ⇒
Change Setup Parameters):

1. In the Input Devices hide box, select Light Pen Blue
Flood .

2. Select Apply in the Setup window to put the changes into

effect.

Note Light pen blue flood does not work at 16- and

24-bit color depth.
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C Using a Floppy Drive

This appendix explains how to use a floppy drive on an NCD

terminal.

If you are using a floppy disk for storing a local file system, see

the information in Chapter 11, Using NCD Utilities, as well.

Starting ncdfloppy
ncdfloppy, a utility that runs on UNIX hosts, allows you to use

a floppy drive connected to an NCD terminal to access

DOS-compatible 740K or 1.44M floppy disks.

To start an ncdfloppy session, type:

% ncdfloppy <CR>
>

By default, ncdfloppy looks for a floppy drive connected

directly to your terminal (on a parallel port). If you want to

use a floppy drive connected to another user’s terminal, see

your system administrator.

At the ncdfloppy prompt (>), you can type any ncdfloppy
command (including help or ?, which displays a list of

available commands). Table C-1 lists all of the ncdfloppy
commands and options.

Table C-1 ncdfloppy  Commands and Options

Command Description

cat filename(s)

type filename(s)

Displays the named files on the screen.

cd  [ directory ]

chdir  [ directory ]

If you specify a directory, this command moves

you to that directory on the floppy disk file

system; if you don’t specify a directory, it displays

the current floppy disk directory.
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del filename
delete filename

Deletes a file from the floppy disk.

dir [-w ] [ filename ... ]
ls [-w ] [ filename ... ]

Displays a DOS-like directory listing of the floppy

disk files. If you omit the filename, it displays a

listing of the current floppy disk directory.

The -w  option displays only the filename, and

omits the size and creation dates.

exit
quit

Terminates the ncdfloppy session.

format  [ -f 720  ] [ -l label ] [-q ] Creates a new DOS file system on the floppy disk.

By default, it creates a file system for a 1.44M

floppy; use the -f 720  option to format a 720K

floppy disk.

The -l option specifies the volume label.

The -q option performs a quicker method of

formatting, but should be used only if the disk has

already been completely formatted, and only if

you are sure the disk is in perfect condition

(containing no bad sectors).

get  [-n ] [-m] flop-file local-file
get  [-n ] [-m] flop-file ... local-dir

Copies files from the floppy disk onto the local

UNIX file system.

The -n  option suppresses warning messages

about overwriting existing files.

The -m option preserves the original file’s

modification time.

help
?

Displays a list of ncdfloppy commands.

md  [-v ] directory ...
mkdir  [-v ] directory ...

Creates floppy disk directories.

The -v option results in the display of messages if

you must modify the directory name to fit DOS

directory-naming requirements.

Table C-1 ncdfloppy  Commands and Options (Continued)

Command Description
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ncdfloppy  Command Line Syntax
The complete syntax of the ncdfloppy utility is:

ncdfloppy  [ -h servername ] [ -p port ] [ command ]

where:

put  [-n ] [-m] [-v ] [-x ] local-file flop-file
put  [-n ] [-m] [-v ] [-x ] local-file ... flopdir

Copies files from the local UNIX file system to the

floppy disk.

The -n  option suppresses warning messages

about overwriting existing files.

The -m option preserves the original file’s

modification time.

The -v  option displays a message if you must

modify the destination filename to fit DOS file-

naming conventions.

The -x  option suppresses filename expansion of

wildcard characters.

pwd Displays the current floppy disk directory.

rd directory
rm directory
rmdir directory

Deletes one or more empty floppy disk

directories.

ren  [-v ] file1 file2
rename  [-v ] file1 file2

Renames a file.

The -v  option displays a message if the

destination file must be modified to meet DOS

requirements.

Table C-1 ncdfloppy  Commands and Options (Continued)

Command Description

-h servername Specifies a floppy drive connected to a

different terminal. (servername is the IP

address or hostname of the other

terminal)

-p port Specifies the TCP port for the parallel
daemon, which is 5964, by default.
Normally, you use the default port and
don’t need to use this option.
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For example, the following command copies the file mary-3-94
from the floppy disk into the current directory of the local

UNIX file system, then exits:

% ncdfloppy get mary-3-94 <CR>
%

ncdfloppy  Naming Conventions
When you specify filenames and directories with ncdfloppy
commands, keep the following guidelines in mind to avoid

conflicts between DOS- and UNIX-style file system

conventions:

❏ You can use either a UNIX-style slash (/) or a DOS-style

backslash (\) as a separator in pathnames.

❏ ncdfloppy recognizes the asterisk (* ), question mark (?),

and open and close square brackets ([ ] ) in filenames,

and interprets them as wildcard characters.

❏ DOS limits label names to eleven characters—ncdfloppy
truncates label names that exceed that length.

❏ DOS limits filenames and directory names to an eight-

character filename separated from a three-character

extension by a period (for example, letter21.doc)—

ncdfloppy truncates any names that exceed those lengths.

So, if your UNIX filename is ltr-first.draft, ncdfloppy
truncates the name to ltr-firs.dra when it copies the file to

the floppy disk.

❏ DOS does not permit more than one period (the separator

between the filename and its extension) in filenames or

directory names—ncdfloppy converts extra periods to the

character “x”. So, if your UNIX filename is ltr.1.draft,
ncdfloppy changes the name to ltr.1xd when it copies the

file to the floppy disk.

command Executes the specified command
without displaying the ncdfloppy
command interpreter prompt and exits.
(Table C-1 lists the ncdfloppy
commands.)
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Glossary

This glossary includes simple definitions of the X Window System

and NCDware terms used in this manual.

acceleration

parameter

Parameter used to control the proportion of

display screen represented by the mouse’s

motion across the mouse pad.

access control Process of restricting host or user access to

terminal facilities or data.

active window Window to which user input is focused. The

active window is distinguished from other

windows by different frame color or

shading.

application Program for a specific purpose, such as

accounting or word processing.

Applications and other programs written

especially for X are also called clients.

architecture Design and structure of the software and/or

hardware components comprising a system.

background Solid color or tile pattern that usually

underlies the characters or graphics in a

window or menu.

background process Detached process, initiated by a command

line ending with an ampersand (&). You

don’t have to wait for such a command to

complete before running other commands

from the same terminal emulator window.
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Glossary
backing store Off-screen image saved when the window

or a portion of a window is obscured.

batch processing Mode of computer operation in which

program instructions are executed one after

the other without user intervention.

bitmap Sequence of bytes representing a grid of

pixels; used to form pointers, icons, and

background window patterns.

boot In NCD terminals, the process of testing the

terminal’s memory and loading the terminal

software.

Boot Monitor Firmware in the terminal responsible for

initiating the loading and executing of the

terminal software and testing the terminal

memory.

click-to-focus Focus policy under which directing input to

a window (making it the active window) is

accomplished by clicking in the window.

Click-to-focus is the default under most

window managers, including ncdwm. See

also focus and explicit focus.

client X Window System application program.

Most clients run on a host computer, but

NCDware includes local clients that run on

the terminal’s processor.

configuration A compatible assembly of computer

hardware and software.

configure To select and install compatible hardware

and software components for a computer

system. Configuring the computer network

is a major part of a system administrator’s

responsibility.
Glossary-2
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Console Window used to access NCD User Services.

Provides a hide box for displaying

diagnostic messages and a menu bar for

accessing other local clients.

CTERM Command Terminal Protocol; a DECnet

communication protocol.

CTerm client Client used to provide VT320 terminal

emulation using the CTERM protocol.

DCE Data Communications Equipment. A device

that provides the functions required to

establish, maintain, and terminate a data-

transmission connection; for example, a

modem.

deiconify To change an icon back into the window

from which it was iconified.

Dialer local client Local client that provides a VT320 terminal

emulator window for connecting to a host

through the serial port. Includes options for

starting and stopping PPP, SLIP, or XRemote

through a Communications menu.

display Video screen upon which output and input

may appear.

DISPLAY Environment variable that tells applications

which display to connect to. For NCD

terminals, the DISPLAY variable consists of

the terminal hostname followed by :0.

display manager Application used to start and manage X

sessions. See also X Display Manager.

downloading Process of transferring files from a host

computer to the terminal’s memory.

dpi Dots per inch. A measure of screen

resolution.
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DTE Data Terminal Equipment. A device that

acts as a data source, data sink, or both.

ENERGY STAR US Environmental Protection Energy

program that promotes the use of energy-

efficient equipment. To meet ENERGY STAR

requirements, computer equipment must

enter a low-power state when inactive.

ESP board Ethernet/Serial/PC board. An HMX

terminal network interface board that

incorporates two serial communication

channels, an Ethernet interface, and a socket

for a PC card.

Ethernet Popular network protocol and a physical

channel for transmitting data over coaxial

cable, twisted-pair cable, or fiber-optic cable.

explicit focus Focus method supported by the NCD

Window Manager. Under explicit focus, a

window becomes active when you click on

it. It is different from click-to-focus only in

that a newly opened window is not

automatically the active window. See also

focus.

File Manager Application used with Sun Microsystem’s

OpenWindows to provide graphical file

system utilities.

focus To direct keyboard input to a specific

window. The window to which focus is

directed is called the active window or the

focus window. See also click-to-focus, pointer
focus, and explicit focus.

focus policy The method used by a window manager to

select the active window. See also click-to-
focus, pointer focus, and explicit focus.
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font Distinct set of character glyphs, such as

10-point Roman bold.

font file File that contains the definition of a font.

font path Specification of the font directories from

which to download fonts to an NCD

terminal.

font server Optional software module that can scale

outline fonts and relieve the X server of all

tasks related to downloading fonts.

gateway Computer that routes traffic from one

network to another.

glyph Pictorial representation of a single character

in a specific font. It is represented internally

by a bitmap.

graphical user

interface (GUI)

Software that facilitates the interaction

between the computer and the user.

helper program In XRemote, a host-resident program used

to facilitate communication between

applications and the X server.

host Individual device on a network, such as an

NCD terminal or another type of computer.

Hypertext link Connection between one piece of

information and another.

HyperText Markup

Language (HTML)

Language used to write Web documents.

ICA (Independent

Computing

Architecture)

Protocol used for connecting to Microsoft

Windows NT servers.

icon Small symbol that represents a window.
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icon box Feature of some window managers that

allows users to group their icons to save

space on the screen.

iconify To change a window into a small graphical

representation. Processing may occur in an

iconified window, but you cannot direct

input to it.

input device Device used to direct data and instructions

to a processor. The keyboard and a mouse

are the standard input devices used with the

terminal.

interface board Removable printed circuit board in an HMX

terminal base. Contains Boot Monitor

PROMs and network connectors. May

contain a socket for a PC card. See also

Network Interface Module, ESP board, TRP
board, PEP board.

Internet Collection of networks and gateways that

use the TCP/IP protocol family and function

as a single cooperative network, connecting

many businesses, universities, and

government facilities.

Internet Protocol Protocol used to route files in an Internet

environment.

LAN See Local Area Network.

LAT See Local Area Transport.

LAT client Client used for VT320 terminal emulation

using the LAT protocol.
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LED Light-emitting diode. LEDs are built into

NCD keyboards and some NCD monitors

and bases. The LEDs on NCD keyboards are

configurable and used for functions such as

displaying network activity and the state of

the Caps Lock key.

local area network

(LAN)

Network of computers that are physically

close, usually in the same building or group

of buildings, connected by high-speed

communication software and hardware

such as Ethernet or Token-Ring.

Local Area Transport

(LAT)

Digital Equipment Corp. communication

protocol used in local area networks. LAT is

used by NCDware for connecting to non-X

applications.

local application Application that runs on the NCD terminal

instead of on a host.

Local File Manager NCD utility for managing the local file

system on a PC card or a floppy disk.

local server Compressed X server that can be booted

from a PC card.

local window

manager

NCD Window Manager or Motif Window

Manager; a local application that provides

window management tools for an NCD

terminal. (Host-based versions are also

available.)

logging in Process of providing a username and

password to a host computer to verify that

you are authorized to use the computer.

logging off Terminating a session on a host computer.
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login User identification word used by a

computer system to authenticate users. See

also password.

login banner Banner displayed on the screen to provide a

means of entering the username and

password for logging in.

Login Chooser In NCDware, a popup window that provides

a list of accessible hosts and allows selection

of a host.

login host When using an NCD terminal, the login host

is the host that runs the login process used

to begin the session.

LPR/LPD Line Printer Remote/Line Printing Daemon.

Protocols used for printing in mixed, multi-

platform environments.

magic cookie Secret password used under XDM to control

access to a server and protect a user’s

display from unauthorized access.

menu List of items that can be selected by clicking

a mouse button.

MetaFrame Software from Citrix Systems that allows a

terminal to connect to Microsoft Windows

NT 4.0, Terminal Server Edition.

modem Device that performs modulation and

demodulation, converting digital signals to

analog form (and vice versa) for

transmission over telephone circuits.

modifier keys Keys such as Control, Alt, and Shift that

modify the actions of other keys. X also

supports a set of logical modifier key

functions (such as the meta key) that can be

mapped to physical keys.
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Motif Window

Manager

NCD’s local window manager with the same

functionality as the host-based OSF/Motif

1.2.2 window manager; see also OSF/Motif;
mwm; ncdrunwm; and NCD Window

Manager

mouse Hand-held input device used with terminals

to direct the movement of the screen pointer.

mwm local client Local window manager with the same

functionality as the host-based OSF/Motif

1.2.2 window manager; see also ncdrunwm
and ncdwm.

NCD terminal Display monitor, keyboard, base containing

processors, and a mouse. The NCD terminal

processors are dedicated to running the X

server. Also called a terminal.

NCD User Services NCD’s set of utilities for accessing hosts and

applications, customizing the X

environment, and examining network and

terminal statistics.

NCD Window

Manager

NCD’s local window manager program. See

also local window manager and Motif
Window Manager.

ncdfloppy NCD utility that allows you to use a floppy

drive connected to an NCD terminal.

NCDnet Software option that allows an NCD

terminal to participate fully in a DECnet

network as a DECnet phase IV end node. It is

the same software as DECnet, but licensed

through NCD.
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ncdrunwm Companion program to the NCD Window

Manager. ncdrunwm runs on the host, sends

a description file to the window manager

running inside the terminal, starts

applications, and connects to other hosts.

ncdsendvideo NCD utility for starting the Video Player on

a terminal from a host system and sending

video data to it. See also video.

NCDware NCD’s software for terminals.

network Collection of computing devices connected

by communication hardware and software.

Network File System

(NFS)

Protocol developed by Sun Microsystems

that allows a set of computers to access each

other’s file systems as if they were local;

used on NCD units to support font files, the

color definition file, and remote

configuration files, and other file service

tasks.

Network Interface

Module (NIM board)

Removable printed circuit board in an HMX

terminal’s base. Contains Boot Monitor

PROMs and network connectors. See also

TRP interface board, ESP interface board, PEP
board.

NFS See Network File System.

NVRAM Non-volatile random-access memory used

to store parameter settings in NCD terminals

when the power is off.

OPEN LOOK Graphical user interface specification

developed by Sun Microsystems and

registered by UNIX Systems Laboratories,

Inc.
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OpenWindows Sun Microsystem’s X-based user

environment.

OSF/Motif Open Software Foundation’s graphical user

interface; used by the local NCD Window

Manager.

output device Device used to receive the output from a

processor. The display screen is the output

device used by terminal users. Another

frequently used output device is a printer.

parallel port Connector for parallel-line communications.

parameter Definable characteristic of an item, device,

or system.

password User-defined word used to authenticate

computer system users.

PC card Integrated circuit defined by the Personal

Computer Memory Card International

Association (PCMCIA). The card provides

local memory for storing a terminal’s X

server, fonts, configuration files, or audio

features.

PEP board Parallel/Ethernet/PC board. An HMX

terminal interface board that incorporates a

parallel communication channel, an

Ethernet interface, and a socket for a PC

card.

pixel Smallest element of the display grid of a

graphics display device. The name comes

from an abbreviation of the words picture
element.

Point-to-Point

Protocol

See PPP.
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pointer Device used by the user to communicate

with the server. Pointer also refers to the

symbol that represents the device’s location

on the screen (for example, an X or an arrow

shape).

pointer focus Focus method supported by the NCD

Window Manager. Under pointer focus, a

window becomes active when you place the

pointer on it. See also focus.

popup window Window that appears on the screen in

response to selecting an item from a menu. It

is used to enter information that an

application needs to operate. In most

applications, items that invoke popup

windows are indicated by ellipses (. . .). Also

called a dialog box.

power management Parameters in the User Preferences window

for setting up ENERGY STAR-compliant

equipment.

PPP Point-to-Point Protocol. An Internet protocol

for transmitting datagrams over serial links.

See also SLIP.

programmable

read-only memory

(PROM)

Memory chips used to store the booting

software in NCD terminals.

PROM See programmable read-only memory.

protocol Formal description of message formats and

the rules for transferring data over a

network.

published

application

Microsoft Windows application that has

been configured for sharing over a network

by multiple users.
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reboot See boot.

remote configuration Method of configuring an NCD terminal by

downloading a file containing operational

parameters from a host computer.

root menu Root menus are menus that are accessed by

placing the pointer on the root window and

clicking on a mouse button. The system

administrator can configure the root menu.

root window Window that fills the screen during an X

session; all windows opened by applications

appear on top of the root window.

router Device responsible for deciding which path

network traffic should follow. In the

Internet, an IP gateway is a router.

RS-232 C Industry standard serial protocol for

communications connections.

rsh/remsh UNIX utilities for starting applications from

a remote computer. Can be used on NCD

terminals for starting local applications from

a host computer.

Serial client Local application that provides a VT320

terminal emulator window for connecting to

a host through the serial port.

serial communication Type of data transmission in which data and

instructions are sent one after the other over

the same wire.

serial port Port located on all NCD terminals. For

attaching a modem, printer, or other serial

device.

server An X server. (See X server.) Also a device on

a network providing a service, such as a

boot server or a print server.
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session See X session.

Session Manager DECwindows application used to control

DECwindows sessions.

Setup key Key or combination of keys used to display

the Console. See also Setup key combination.

Setup key

combination

On keyboards that do not have a Setup key,

a combination of keys may be used instead

to invoke the Console.

shell Also called a command interpreter. The user

types commands at a prompt, and the

commands are accepted and passed to the

operating system for execution. On an NCD

terminal, a shell is often accessed through an

xterm terminal emulator.

SIE Simple Imaging Extension. An extension to

the X protocol that enhances the display

capabilities of NCD terminals. Offers image

compression, pan, zoom, and rotation.

SLIP Serial Line Internet Protocol. A defacto

standard protocol for transmitting IP

datagrams over serial links. See also PPP.

SunOS Sun Microsystem’s implementation of the

UNIX operating system.

system administrator Individual responsible for managing

computers and the network.

TCP/IP Networking protocol family commonly

used for communication over local area

networks.

TELNET Internet standard protocol for remote

terminal connection services.
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TELNET client Local application that provides VT320

terminal emulation for connecting to a host

using TELNET.

terminal emulator Application that mimics the function of a

terminal so that you can use non-X

applications. xterm, the standard terminal

emulator, emulates a VT102 terminal. NCD’s

local-client terminal emulators (TELNET,

LAT, CTerm, and Serial) emulate VT320

terminals.

terminal server Device that connects terminals to services or

hosts in a local area network.

threshold parameter Parameter used to specify at which point the

acceleration parameter should come into

effect in controlling mouse motion. You can

change the threshold parameter using the

Console’s Setup menu’s Change User

Preferences submenu.

Token-Ring Network protocol in which a token (a

continuously repeating frame) is passed

sequentially from station to station. Only the

station that has the token can communicate

on the network.

touch screen Hardware that allows you to use a finger

instead of a mouse to navigate around the

display screen and make selections.

TRP board Token-Ring/PC. An interface board that

incorporates a Token-Ring connector and a

socket for a PC card.

UNIX Portable, multi-user time-sharing operating

system developed in the early 1970s.

Uniform Resource

Locator (URL)

Unique address for each Web document or

site.
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vi UNIX visual text editor.

video NCD utility for displaying the Video Player

application window from an NCD terminals

and sending video data to it. See also

ncdsendvideo.

Video Player Window for displaying and controlling

video applications.

vp Video Player’s graphical user interface.

VT102, VT220 Widely used terminal emulation standards.

VT320 Terminal emulation standard used in the

NCD Terminal Emulator.

Web See World Wide Web.

WinCenter Pro NCD’s software enabling Windows NT

servers to be shared by multiple users

simultaneously, running applications on

NCD terminals, PCs, or workstations.

window A region on the display created by a

application. Windows can be manipulated

by a window manager.

window manager Host-based or local application that allows

you to manipulate windows on a display.

Windows Access Console utility for connecting to Microsoft

Windows NT servers.

WinFrame Multi-user Windows NT from Citrix

Systems.

World Wide Web Global network of interconnected

documents or files.

X See X Window System.
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X 11 Release 5 (X11R6) Current release of the X Window System,

implemented by NCD in NCDware.

X Consortium Guiding organization for the development

of standards for the X Window System. It

was made up of more than 90 corporations

and universities, including NCD. In 1997, the

X Consortium transferred responsibility for

the X Window System to The Open Group.

X Display Manager

(XDM)

Protocol that provides automatic X protocol

connection to a specified host when an NCD

terminal is reset.

X server Software that provides display services for

applications and handles keyboard and

pointer input. This is the part of the X

Window System that runs in NCD terminals.

X session All the processing that goes on from the

time you log in to use the X Window System

until you log out.

X Window System Network-based graphical window system

developed at MIT to allow workstation users

to use applications running on more than

one host.

XDM See X Display Manager.

xinitremote NCD utility for starting XRemote.

XRemote NCD’s software for running X over a serial

line.

XRemote/Serial XRemote operating mode involving use of

NCD’s proprietary, non-networked protocol

for serial connectivity.

XRemote/TCP XRemote operating mode involving use of

TCP/IP transport protocols run over PPP,

SLIP, and Ethernet or Token-Ring.
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xterm Standard X Window System terminal

emulator; gives you a window in which to

type commands or run a program. See also

terminal emulator.
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Entries with a Console menu or submenu name in parentheses refer to local applications

accessed from the Console; for example, Change User Preferences (Console).

Entries followed by the words Terminal Emulator in parentheses refer to items in NCD

Terminal Emulator menus; for example, Auto Linefeed (Terminal Emulator).

Entries followed by the words Window menu in parentheses refer to items in root menus;

for example, Restore (Window menu).

Entries followed by a number in parentheses refer to applications; for example, ncdwm(1).
Numerics
3270 terminal emulator 7-2
80/132 Font Switching (Terminal

Emulator) 7-12

A
Abort Parallel Port 1, 2 (Console) 5-3
Abort Ringing Bell (Console) 5-3
Abort Serial Line 1, 2, 3 (Console) 5-3
Abort Waiting Fonts (Console) 5-3
Acceleration Ratio (User Preferences) 6-13
Activate Alpha Buffer for RGBA Visuals

(User Preferences) 6-11
active window 9-8
Allow 80/132 Switching (Terminal

Emulator) 7-12
Allow Alpha Test (User Preferences) 6-10
Allow Blending (User Preferences) 6-10
Allow Depth Test (User Preferences) 6-10
Allow Dithering (User Preferences) 6-10
Allow Exposures After Screen Saver (User

Preferences) 6-16

Allow Logical Operations (User
Preferences) 6-11

Allow Polygon Stipple (User
Preferences) 6-11

Allow Scissor Test (User Preferences) 6-10
Allow Stencil Test (User Preferences) 6-10
applets

printing 11-3
running 11-2

Application Cursor Mode (Terminal
Emulator) 7-11

Application Keypad Mode (Terminal
Emulator) 7-11

applications
copy and paste between

applications A-7
defined 2-5, A-4
Motif-style 3-8 to 3-13
not compliant with the current X

standard 6-6
online help for A-6
OpenWindows 13-6
published 8-1, 8-6
Index-1
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applications (continued)
some common X applications A-6 to

A-7
starting automatically 2-5 to 2-6
starting through the local terminal

emulator 7-6
statistics, displaying 5-10, 5-12
types of applications 2-5 to 2-6
Windows NT 8-1, 8-7
see also Terminal Emulator (local

terminal emulator); terminal
emulators, host-based; window
managers

audio, setting maximum gain 6-5
Auto Linefeed (Terminal Emulator) 7-11
Auto Wraparound (Terminal

Emulator) 7-11
Automatic Lock Screen After (User

Preferences) 6-6
Automatic Logout After (User

Preferences) 4-8, 6-6
Automatic Logout Cancel Delay (User

Preferences) 4-9, 6-6
Autorepeat Begin After (User

Preferences) 6-8
Autorepeat Rate (User Preferences) 6-9

B
backing store 6-17
Be Compatible with Old DECwindows

Images (User Preferences) 6-6
Be Compatible with Old DECwindows

Keyboards (User Preferences) 6-6
Be Compatible with Old DECwindows

Vendor String (User Preferences) 6-6
Bell Base Volume (User Preferences) 6-5
Bell Duration (User Preferences) 6-5
Bell Pitch (User Preferences) 6-5
bell, setting attributes 6-5
Blank Screen (Console) 5-4
blanking screen, see screen (display)
Blink Cursor (Terminal Emulator) 7-12

blinking cursors, turning off 7-12
boot host, how to determine 5-8
Boot Monitor version, how to display 5-8
booting

appearance of screen while
booting 4-2

boot host, how to determine 5-8
defined 2-2
how to boot a terminal 2-2
rebooting 4-9

Button Arrangement (User
Preferences) 6-13

Button Press Threshold (User
Preferences) B-3

Button Press Threshold and Button
Release Threshold (User
Preferences) 6-13

Button Release Threshold (User
Preferences) B-3

C
cache size, for Windows NT

connections 8-6
Calibrate Touchscreen (Setup

Parameters) B-2
Can’t Open display (UNIX message) 7-6
Change Quick Setup (Console) 5-5
Change Screen Saver After (User

Preferences) 6-16
Change Setup Parameters (Console) 5-5
Change User Preferences (Console)

audio option 6-5
automatic logout 4-8
bell attributes 6-5
buttons and fields, how to use 3-10 to

3-14
compatibility options 6-5
console and utilities options 6-6 to 6-7
displaying 6-1
font options 6-7 to 6-8
graphics options 6-17 to 6-18
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Change User Preferences (continued)
keyboard options 6-8 to 6-9
loading user preferences at login 6-3
pointer options 6-12 to 6-13
power management options 6-13 to

6-15
saving changes in a file 6-3
screen background options 6-15
screen saver options 6-16
SIE options 6-18

chooser, see Login Chooser; Terminal Host
Chooser; Windows Chooser

Clear Messages (Console) 5-3
Clear Screen with Blanks (Terminal

Emulator) 7-12
click-to-focus 3-6, 9-8
clients, see applications
Close (Console) 5-3
Close (Window Menu) 9-11
Close Connection (Terminal

Emulator) 7-10
color

in Windows NT connections 8-7
screen background 6-15

Command not found  (UNIX

message) 12-18
Command Tool/Shell Tool A-7
communication channels A-5
Communications menu (Dialer) 7-14
compare command (Local File

Manager) 11-7
compatibility options (User

Preferences) 6-5
CompCore Multimedia decoder, see video,

decoder options
Console

customized key sequences for
displaying 6-6

defined 1-3 to 1-4, 2-2
displaying 2-13, 2-14, 3-4, 5-1
hiding 5-2
illustration of 1-3

Console (continued)
logging in 4-2
menu bar 3-9
menu items, summary of 5-2 to 5-5
Messages hide box 5-6
time stamps, adding to messages 6-7
Utilities menu 11-1

Console Key Sequence (User
Preferences) 6-6

copy and paste between applications A-7
CTerm terminal emulator 7-3
Current Pointing Device (User

Preferences) 6-12
Current Pointing Devices (Setup

Parameters) B-4
Curses Emulation (Terminal

Emulator) 7-12
cwd command (Local File Manager) 11-7

D
DECnet (NCDnet) node name and address

of terminal, how to determine 5-8
DECwindows

image compatibility 6-6
modifier keys 6-6
vendor string 6-6

Delay When Blanking Screen (User
Preferences) 6-7

DeskSet applications
(OpenWindows) 13-7

dgl error (protocol): remote
machine not DGL capable  (server
error message) 6-10

diagnostic messages, see messages
Dialer

Communications menu 7-14
with XRemote 12-7, 12-17, 12-19, 12-22

Display PostScript, freeing memory used
by applications 5-4
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DISPLAY variable
running xinitremote 12-22
starting applications through a

terminal emulator 7-6
domain name of terminal, how to

determine 5-8
domain, Windows NT 8-7

E
Enable 24 bit RGBA double buffered Visual

(User Preferences) 6-12
Enable 24 bit RGBA single buffered Visual

(User Preferences) 6-12
Enable 8-bit color-index double buffered

Visual (User Preferences) 6-11
Enable 8-bit color-index single buffered

visual (User Preferences) 6-11
Enable 8-bit RGBA double buffered Visual

(User Preferences) 6-11
Enable 8-bit RGBA single buffered Visual

(User Preferences) 6-12
Enable Bell (User Preferences) 6-5
Enable Benchmark Optimizations (User

Preferences) 6-17
Enable Graphics Optimizations (User

Preferences) 6-17
Enable Keyboard Autorepeat (User

Preferences) 6-8
Enable Screen Saver (User

Preferences) 6-16
Enable VESA Monitor Power Management

(User Preferences) 6-14
ENERGY STAR Computers program 6-14
Environment Variables (Change User

Preferences) 6-7
error messages, see messages
ESP (Ethernet/Serial/PCMCIA) board 1-5
Ethernet address of terminal 5-8
Ethernet/Serial/PCMCIA (ESP) board 1-5
Exit (Terminal Emulator) 7-10
explicit focus 9-8

F
Fast Perspective Rendering (User

Preferences) 6-11
floppy drive C-1 to C-4
focus policy 3-6, 9-8, 13-6
font

diagnostic messages 6-8
font directories, adding 6-7
in OpenWindows environment 13-8
User Preferences options 6-7 to 6-8

Font Path Entry (User Preferences) 6-7
font server

adding to the font path 6-7
defined 1-5

Free DPS Memory (Console) 5-4

G
Grab Keyboard Input (Terminal

Emulator) 7-12
graphics

SIE options 6-18
User Preferences options 6-17 to 6-18

GUIs
OpenWindows 13-1
OSF/Motif 9-1

H
Hard Reset (Terminal Emulator) 7-10
hardware address of terminal 5-8
hide boxes, in application windows 3-13
hide buttons 3-10 to 3-13

I
ICA, connecting to a Windows NT

server 8-1
icons

icon box 9-11, 9-14 to 9-15
iconifying and deiconifying 3-7 to 3-8,

9-7, 9-11
in OpenWindows environment 13-9
minimizing and maximizing 3-7 to3-8,

9-7, 9-11
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info command (Local File Manager) 11-8
initial program, Windows NT 8-7
input devices, see keyboards; mouse;

trackball; touch screen
Input Extension Device Only (Setup

Parameters) B-4
Internet terminology 10-3
IP (Internet Protocol)

domain name of terminal, how to
determine 5-8

hostname of terminal, how to
determine 5-8

ISO Latin 1 Font (Terminal Emulator) 7-12

J
Java applets 11-2 to 11-4
Java environment variables 6-7
Java Print Dialog 11-2
Jump Scroll (Terminal Emulator) 7-11

K
keyboards

autorepeat attributes, setting 6-8 to 6-9
DECwindows modifier key

compatibility 6-6
in OpenWindows environment 13-8
input keys 3-4
keyclick volume 6-9
Keymap Editor 1-4, 3-4, 7-14
LEDs 6-9
legends, accessing 3-4
recognized by X server at boot 3-3
Setup key 3-4, 6-6
type, how to determine 5-8
types offered by NCD 3-3

Keyclick Volume (User Preferences) 6-9
Keymap Editor 3-4, 7-14
Keymap Editor, defined 1-4

L
LAT (Local Area Transport) terminal

emulator 7-4, 7-5
Led1, Led2, Led3 (User Preferences) 6-9
light pen

blue flood feature B-8
calibrating B-6, B-7
configuring B-6
connecting to a terminal B-5
using B-5

list command (Local File Manager) 11-8
Local File Manager 11-5 to 11-8
local file system 11-5 to 11-8
Local Flow Control (Terminal

Emulator) 7-11
Lock Screen (Console)

automatic 4-6
locking the screen 2-13 to 2-14, 4-5 to

4-7
unlocking the screen 2-14, 4-6, 4-7

Log Output To File (Terminal
Emulator) 7-12

logging in
defined 2-3
login banner 2-3, 4-4
Login Chooser (Console) 2-3, 4-2 to 4-4
login host, how to determine name

of 5-8
Login New X Session (Console) 5-3
OpenWindows 13-1 to 13-2
through a local terminal emulator

window 7-2 to 7-6
Windows NT hosts 8-1
XDM startup file 4-5
XRemote 12-9, 12-12, 12-18, 12-19,

12-20
logging out 4-7 to 4-9
login banner

displayed by XDM 4-4
illustrated 2-3
login procedure 4-4
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login banner (continued)
see also logging in

Login Chooser (Console)
defined 2-3
login host, selecting 2-3
using 4-2 to 4-4
see also logging in

Login New X Session (Console) 5-3
Logout (Console) 4-8, 5-3
logout, automatic 4-8
Lower (Window menu) 9-11

M
Margin Bell (Terminal Emulator) 7-12
Maximize (Window menu) 9-11
Maximum Gain (User Preferences) 6-5
memory

installed, how to determine
amount 5-8

unused memory, how to determine
amount 5-9

Menu Bar (Terminal Emulator) 7-11
menu bars, Motif-style 3-8 to 3-9
menu button, Motif-style 3-9
menus

Console menus, see Console
DECwindows, see DECwindows
NCD Terminal Emulator menus, see

Terminal Emulator (local
terminal emulator)

root menu, see NCD window
managers; OpenWindows

tear-off 9-4
messages

font messages 6-8
from the X server 5-6
Messages hide box (Console) 5-6
time stamps, adding to Console

messages 6-7
XRemote 12-23

Messages hide box (Console) 5-6
Minimize (Window menu) 9-11

model, terminal (how to determine) 5-8
modem

connecting to terminal 12-5 to 12-6
hanging up 12-22
US Robotics modem 12-8, 12-13

monitors
calibrating for touch screen B-2 to B-3
in OpenWindows environment 13-9
power management 6-14 to 6-15
screen resolution

how to determine 5-8
setting 6-17

type, how to determine 5-8
Motif

Motif-style window management
tools 3-8 to 3-13

using OSF/Motif host-based window
manager (mwm) instead of local
window manager
(DECwindows) 9-18

Motif Window Manager (Console) 5-4, 9-3
mouse

buttons
left-handed 3-2, 6-13
mapping 3-2
numbering of 3-2
right-handed 3-2

OpenWindows 13-4
setting characteristics of 6-12 to 6-13
using 3-1 to 3-2
see also pointer

Move (Window menu) 9-11
MPEG, see video
mwm (1)

local
license requirement 9-1
using 9-2 to 9-17

using host-based mwm instead of an
NCD window manager
(DECwindows) 9-18

see also NCD window managers
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N
NCD Mosaic Browser

customizing display 10-6
display preferences 10-6
document elements 10-5
document window 10-4
environment variables, specifying 6-7
history list 10-9
hotlist 10-9
limitations 10-2
opening a Web document 10-8
preferences window 10-5
printing a Web document 10-12
saving a Web document 10-11
searching a Web document 10-11
starting 10-4
supported file formats 10-1
system preferences 10-7

NCD software, defined 1-3 to 1-5
NCD User Services, defined 1-3 to 1-5
NCD Window Manager (Console) 5-4, 9-3
NCD window managers

active window 9-5
customizing 9-17
differences between ncdwm and

mwm 9-2
icon box 9-11, 9-14 to 9-15
icons 9-7, 9-11
input, directing 9-8
Motif Window Manager

(Console) 9-3
mwm, local

license requirement 9-1
using 9-2 to 9-17

NCD Window Manager (Console) 5-4,
9-3

ncdrunwm 9-3
overview 2-8 to 2-13, 9-1 to 9-2
pointer appearance 9-9
root menu 9-4 to 9-5
starting 9-3

starting clients 9-4 to 9-5
stopping 9-4, 13-2
tear-off menus 9-4
windows

closing 9-17
deiconifying 9-16
frame 9-6 to 9-7
iconifying 9-7, 9-11, 9-14 to 9-16
icons 9-17
lowering 9-11, 9-13
manipulating 9-10 to 9-17
maximizing 9-6, 9-7
menu button 9-6
menus, displaying 9-7
moving 9-12
raising 9-13
size, changing 9-7, 9-14
title bar 9-6

ncdfloppy C-1 to C-4
ncdrunterm utility 7-7
ncdrunwm (1) 9-3
ncdsendvideo (1) 11-15
NCDware

defined 1-3 to 1-5
version, displaying 5-8

ncdwm (1), see NCD window managers
network addresses, how to determine 5-8
Network Interface Module (NIM)

board 1-6
network statistics, displaying 5-11
network type, for Windows NT

connections 8-6
New 3179G (Console) 5-4
New 3270 (Console) 5-4
New CTerm (Console) 5-4
New Dialer (Console) 5-4, 7-3, 12-7
New LAT (Console) 5-4, 7-4
New Serial (Console) 7-4
New Telnet (Console) 5-4, 7-3
New Terminal (Console) 5-4, 7-4
NFS (Network File Service), use with

video 11-10
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O
olwm (1) 13-2 to 13-4
OpenGL support 6-10 to 6-12
OpenWindows

active window 13-6
Copy key 13-8
Cut key 13-8
DeskSet applications 13-7
fonts 13-8
Help key 13-7, 13-8
icon problems 13-9
keys, remapping 13-8
logging in 13-1 to 13-2
mouse button functions 13-4
olwm 13-2 to 13-4
online documentation 13-7
Paste key 13-8
pointer 13-4
Save Workspace utility 13-9
starting 13-2
SunOS prompt 13-9
window focus 13-6
window frame 13-5
Window menu 13-5
windows, manipulating 13-6
Workspace (root) menu 13-7
Workspace (root) window 13-4

option buttons, Motif-style 3-10 to 3-11
OSF/Motif environment

Motif-style window management
tools 3-8 to 3-13

using host-based window manager
(mwm) instead of the NCD

window manager
(DECwindows) 9-18

see also NCD window managers

P
Pack Icons (icon box menu) 9-11
parallel port

cancelling parallel connection,
Console command for 5-3

defined 1-6
using for floppy drive C-1

Parallel/Ethernet/PCMCIA (PEP)
board 1-5

pasting text, terminal emulator
window 7-8

PEP (Parallel/Ethernet/PCMCIA)
board 1-5

Permit Old X Bugs (User Preferences) 6-6
pointer

and window focus 3-7, 9-8, 13-6
defined 3-1 to 3-2
in NCD window managers 9-9
OpenWindows 13-4
setting characteristics of 6-12 to 6-13
touch screen B-3 to B-4

popup window 3-9
power management (monitor) 6-14 to 6-15
Powerdown After (User Preferences) 6-15
powering up a terminal, see booting
PPP (Point-to-Point Protocol)

Dialer menu 7-14
with XRemote 12-7 to 12-9, 12-15, 12-17

Print Log Buffer (Terminal Emulator) 7-10
Print Screen (Terminal Emulator) 7-10
Print Selection (Terminal Emulator) 7-10
printing

from Java 11-3 to 11-4
from NCD Mosaic Browser 10-12
from NCD Terminal Emulator 7-8

published applications 8-6
pulldown menu 3-9
pwd command (Local File Manager) 11-7
Index-8
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R
radio buttons 3-10 to 3-11
Reboot (Console) 4-9, 5-3
rebooting the terminal 4-9
reclaim command (Local File

Manager) 11-7
Redraw (Terminal Emulator) 7-10
Refresh Screen (Console) 5-4
Rescan Font Path (Console) 5-4
Rescan Messages (Console) 5-3
Restore (Window menu) 9-11
Reverse Video (Terminal Emulator) 7-11
Reverse Wraparound (Terminal

Emulator) 7-11
rgb.txt file 6-15
Ring Bell (User Preferences) 6-5
root menu 4-8, 9-4 to 9-5

defined 2-6
submenus 2-6
Workspace menu

(OpenWindows) 13-7
root window 3-5, 13-4

S
Save Screen After (User Preferences) 6-16
Save Workspace utility,

OpenWindows 13-9
screen (display)

backgrounds 6-15
screen locking 2-13 to 2-14, 4-5 to 4-7
screen resolution

how to determine 5-8
in OpenWindows

environment 13-9
screen saver options 6-16

Screen Background Type (User
Preferences) 6-15

Screen Resolution (Console) 6-17
Screen Saver Style (User Preferences) 6-16
scroll bars

in Motif-style windows 3-12 to 3-13

selecting text
Show Version (Console) window 5-7
terminal emulator window 7-8

Send Break (Terminal Emulator) 7-10
Serial Interfaces Table (Setup

Parameters) 12-6 to 12-7, B-2
serial port

cables 12-5
cancelling serial connection, Console

command for 5-3
configuring for XRemote 12-6 to 12-7
connectors 12-5
defined 1-6
numbering (terminals with more than

one serial port) 12-16
using for terminal emulation 7-4

server
see also X server
Windows NT 8-1

Setup key
customizing 6-6
equivalent key combinations 3-4

Setup menus (Console), see Change User
Preferences (Console); Change Setup
Parameters (Console)

Setup Printer (Terminal Emulator) 7-10
Show Console Message Time Stamps

(User Preferences) 6-7
Show Extended Font Diagnostics (User

Preferences) 6-8
Show Memory (Console) 5-5, 5-9
Show Statistics (Console) 5-5, 5-11
Show Version (Console) 5-5, 5-7 to 5-8
Show Wireless (Console) 5-5, 5-11
Show X Connections (Console) 5-5, 5-10
SIE (Simple Imaging Protocol), User

Preferences options 6-18
SIE Contrast Threshold (User

Preferences) 6-18
SIE Sampling Method (User

Preferences) 6-18
Size (Window menu) 9-11
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slider bars, in application windows 3-12 to
3-13

SLIP (Serial Line Internet Protocol)
Dialer menu 7-14
with XRemote 12-4, 12-7 to 12-9, 12-17

Soft Reset (Terminal Emulator) 7-10
Standby After (User Preferences) 6-14
Start Debugging Log (Terminal

Emulator) 7-10
Start Java Applet (Console) 5-5, 11-2
Start Local Command (Console) 5-5
Start NCD Mosaic Browser (Console) 5-5
starting

terminals, see booting
startup file

XDM (X Display Manager) 4-5
XRemote 12-10

Starworks (video data server software)
purpose 11-10
usage 11-16

Statistics (Console)
Show Memory 5-9
Show Statistics 5-11
Show Version 5-7 to 5-8
Show X Connections 5-10

statistics, displaying 5-11
Strip Parity (Terminal Emulator) 7-12
subnet mask, displaying 5-8
Sun Microsystems user environment, see

OpenWindows
Suspend After (User Preferences) 6-14

T
TCP/IP, see IP (Internet Protocol)
Terminal Emulator (local terminal

emulator)
applications, starting from terminal

emulator 7-6
closing the session 7-10
cut-and-paste mechanism 7-8
Dialer 7-4, 12-17, 12-22
DISPLAY variable, setting 7-6

Terminal Emulator (continued)
File menu 7-10
font size, changing 7-13
Keymap Editor, defined 1-4
logging in through a terminal

emulator window 7-6
menus

Communications menu
(Dialer) 7-14

Keys menu 7-14
Options menu 7-11 to 7-12
toggle buttons 7-9

ncdrunterm utility 7-7
printer, selecting 7-8
scroll bar 7-8
selecting a host 7-4 to 7-6
serial connection 7-4
starting 7-2 to 7-6
Terminal Host Chooser 7-3 to 7-6,

12-18, 12-20
using LAT 7-4, 7-5

terminal emulators, host-based
Command Tool/Shell Tool A-7
defined 2-5
VT102 emulator A-7
xterm 2-5, A-7

Terminal Host Chooser (Console)
selecting a host 7-4, 12-18, 12-20
starting 7-2 to 7-3
see also Terminal Emulator (local

terminal emulator)
terminal model, how to determine 5-8
terminals

attributes, displaying 5-7 to 5-8
booting 2-2
communication protocols 1-6
DECnet (NCDnet) node name and

address of terminal, how to
determine 5-8

defined 1-2
Ethernet address, how to

determine 5-8
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terminals (continued)
HMX terminals

interface boards 1-5 to 1-6
network connectors 1-5 to 1-6

LAN connectors 1-5
model, how to determine 5-8
network connectors 1-5 to 1-6
parallel ports 1-6
remote use of 12-1
serial ports 1-6, 12-5

Test Network (Console) 5-4
text fields, in Motif-style application

windows 3-12 to 3-13
Threshold Distance (User

Preferences) 6-12
toggle buttons 3-10 to 3-11
Token-Ring

address of terminal, how to
determine 5-8

TRP (Token-Ring/PCMCIA) board 1-5
touch screen monitor support 6-12 to 6-13,

B-2 to B-4
turning on a terminal, see booting

U
Use Backing Store (User Preferences) 6-17
user preference settings, see Change User

Preferences (Console)
username, for Windows NT

connections 8-7
/usr/tmp/XRemote files 12-23
Utilities menu (Console) 11-1

V
verify command (Local File Manager) 11-8
version (NCDware and Boot Monitor),

how to determine 5-8
video 11-9 to 11-18

data server 11-10, 11-16
file transfer protocols 11-10
ncdsendvideo (1) 11-15
starting and stopping 11-17

video (continued)
terminals and host systems

supported 11-9
video (1) 11-13
Video Player 11-11, 11-17
volume controls 11-18
vp (1) 11-11 to 11-13

video (1) 11-11, 11-13 to 11-15
Video Player, see video, Video Player
Visible Status Line (Terminal

Emulator) 7-12
Visual Bell (Terminal Emulator) 7-11
VMS, see DECwindows; DECnet
vp (1) 11-11 to 11-13

W
Web document

opening 10-8
printing 10-12
saving 10-11
searching 10-11

WinCenter, connecting to a WinCenter
host 8-1

window managers
defined A-4 to A-5
introduction 3-5 to 3-8
OpenWindows 13-2 to 13-4
see also NCD window managers;

OpenWindows; DECwindows;
OSF/Motif environment

WindowMgr (Console) 9-3, 13-2
windows

active window 3-6 to 3-7
closing

NCD window manager 9-7, 9-17
OpenWindows 13-6

deiconifying 9-16
focus

NCD window manager 9-8
OpenWindows 13-6
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windows (continued)
frame

NCD window manager 9-6 to 9-7
OpenWindows 13-5

icons 3-7 to 3-8, 9-7, 9-11
icon box 9-11, 9-14 to 9-15
iconifying 9-7, 9-11, 9-14 to 9-16

lowering 9-13
NCD window manager 9-11
OpenWindows 13-6

menus, displaying 9-7
Motif-style 3-8 to 3-13
moving

NCD window manager 9-7, 9-11,
9-12

OpenWindows 13-6
popup window 3-9
raising

NCD window manager 9-7, 9-11,
9-13

OpenWindows 13-6
restoring 9-11
root window 3-5
size, changing

NCD window manager 9-7, 9-11,
9-14

OpenWindows 13-6
Windows NT 8-7

window managers
introduction 3-5 to 3-8
OpenWindows 13-2 to 13-4
see also NCD window managers;

OpenWindows; DECwindows;
OSF/Motif window manager

Windows Access
chooser 8-2
properties dialog box 8-3
using 8-1 to 8-7
Utilities menu (Console) 5-5, 8-1

Windows NT

connecting to 8-1 to 8-7
logon dialog box 8-2

wireless network statistics,
displaying 5-11

working directory, Windows NT 8-7

X
X, see X Window System
X server

defined A-2 to A-3
XRemote module 12-2

X session
ending 4-8
starting 2-2

X Window System
characteristics of A-1
communication channels A-5
components of A-2
X server A-2 to A-3

xbiff (1) A-6
xcalc (1) A-6
xclock (1) A-6
XDM (X Display Manager)

in DECwindows environment 4-4
in OpenWindows environment 13-1
startup file 4-5
use of assumed 4-1
see also login banner; Login Chooser

(Console); logging in
xinitremote (1) 12-10, 12-18
.xinitremoterc file 12-10
xman (1) A-6
xpr (1) A-6
XRemote

Command not found  message 12-21
DISPLAY variable 12-22
ending the XRemote session 12-22
error messages and log files 12-23
helper program 12-2, 12-10
license requirement 12-3
log file 12-23
modem, configuring 12-13 to 12-15
on a LAN 12-20 to 12-21
protocol, choosing 12-4
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XRemote (continued)
startup file 12-10
system administration tasks 12-3 to

12-4
/usr/tmp/Xremote files 12-23
with direct serial connection 12-15 to

12-20
using PPP or SLIP protocol 12-17 to

12-19
using XRemote proprietary

protocol 12-19 to 12-20
with modem 12-4 to 12-15

configuring the serial port 12-6 to
12-7

using PPP or SLIP protocol 12-7 to
12-10

using XRemote proprietary
protocol 12-11 to 12-13

X server module 12-2
xinitremote command 12-10, 12-18
.xinitremoterc file 12-10
Xremote (1) 12-2
xterm window 12-10

XRemote (1) 12-2
xterm (1) terminal emulator 2-5, 12-10, A-7
xwd (1) A-6
xwud (1) A-6
 Index-13
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